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INSTRUCTIONS

Please be sure to read this instruction manual carefully,  
and fully understand its contents prior to the operation  
or maintenance for proper use of the instrument. 



NOTICE 
• This instrument generates, uses, and can radiate the energy of radio frequency and, if not installed and used in accordance 

with the instruction manual, may cause harmful interference to the environment, especially radio communications. 

• The following actions must be avoided without prior written permission from JEOL Ltd. or its subsidiary company 
responsible for the subject (hereinafter referred to as "JEOL"): modifying the instrument; attaching products other than those 
supplied by JEOL; repairing the instrument, components and parts that have failed, such as replacing pipes in the cooling 
water system, without consulting your JEOL service office; and adjusting the specified parts that only field service 
technicians employed or authorized by JEOL are allowed to adjust, such as bolts or regulators which need to be tightened 
with appropriate torque. Doing any of the above might result in instrument failure and/or a serious accident. If any such 
modification, attachment, replacement or adjustment is made, all the stipulated warranties and preventative maintenances 
and/or services contracted by JEOL or its affiliated company or authorized representative will be void. 

• Replacement parts for maintenance of the instrument functionality and performance are retained and available for seven 
years from the date of installation. Thereafter, some of those parts may be available for a certain period of time, and in this 
case, an extra service charge may be applied for servicing with those parts. Please contact your JEOL service office for 
details before the period of retention has passed. 

• In order to ensure safety in the use of this instrument, the customer is advised to attend to daily maintenance and inspection. 
In addition, JEOL strongly recommends that the customer have the instrument thoroughly checked up by field service 
technicians employed or authorized by JEOL, on the occasion of replacement of expendable parts, or at the proper time and 
interval for preventative maintenance of the instrument. Please note that JEOL will not be held responsible for any 
instrument failure and/or serious accident occurred with the instrument inappropriately controlled or managed for the 
maintenance. 

• After installation or delivery of the instrument, if the instrument is required for the relocation whether it is within the facility, 
transportation, resale whether it is involved with the relocation, or disposition, please be sure to contact your JEOL service 
office. If the instrument is disassembled, moved or transported without the supervision of the personnel authorized by JEOL, 
JEOL will not be held responsible for any loss, damage, accident or problem with the instrument. Operating the improperly 
installed instrument might cause accidents such as water leakage, fire, and electric shock. 

• The information described in this manual, and the specifications and contents of the software described in this manual are 
subject to change without prior notice due to the ongoing improvements made in the instrument. 

• Every effort has been made to ensure that the contents of this instruction manual provide all necessary information on the 
basic operation of the instrument and are correct. However, if you find any missing information or errors on the information 
described in this manual, please advise it to your JEOL service office. 

• In no event shall JEOL be liable for any direct, indirect, special, incidental or consequential damages, or any other damages 
of any kind, including but not limited to loss of use, loss of profits, or loss of data arising out of or in any way connected with 
the use of the information contained in this manual or the software described in this manual. Some countries do not allow 
the exclusion or limitation of incidental or consequential damages, so the above may not apply to you. 

• This manual and the software described in this manual are copyrighted, all rights reserved by JEOL and/or third-party 
licensors. Except as stated herein, none of the materials may be copied, reproduced, distributed, republished, displayed, 
posted or transmitted in any form or by any means, including, but not limited to, electronic, mechanical, photocopying, 
recording, or otherwise, without the prior written permission of JEOL or the respective copyright owner. 

• When this manual or the software described in this manual is furnished under a license agreement, it may only be used or 
copied in accordance with the terms of such license agreement. 

© Copyright 2009 JEOL Ltd. 

• In some cases, this instrument, the software, and the instruction manual are controlled under the “Foreign Exchange and 
Foreign Trade Control Law” of Japan in compliance with international security export control. If you intend to export any of 
these items, please consult JEOL. Procedures are required to obtain the export license from Japan’s government. 

TRADEMARK 
• Windows is a trademark of Microsoft Corporation. 
• All other company and product names are trademarks or registered trademarks of their respective companies. 

SELLING 
JEOL Ltd.  1-2, Musashino 3-chome, Akishima, Tokyo 196-8558 Japan 

Telephone: 81-42-543-1111  Facsimile: 81-42-546-3353 

MANIFUCTURE 
JEOL technics Ltd. 6-38 Musashino 2-chome, Akishima-Shi, Tokyo, 196-0021 Japan 

 
Note: For servicing and inquiries, please contact your JEOL service office. 

 



 

Please be sure to read carefully the following Software License Agreement before using the software supplied 
by JEOL Ltd. If you do not agree to the terms and conditions of the Agreement, please do not use the software 
and contact JEOL Ltd. 
 

Software License Agreement 
 
This Software License Agreement is made and entered into by and between you, the end-user customer, and 
JEOL Ltd. (hereinafter referred to as JEOL) in witness of agreement between both parties upon licensing of 
the right to use the software (which is hereinafter referred to as the Licensed Software) owned by JEOL. 
 
Article 1. (Right to Use Licensed Software) 

“Right to Use the Licensed Software” means your right to use the Licensed Software in the country where 
the JEOL product you purchased is installed (hereinafter referred to as Country of Installation). 

 
Article 2. (Grant of License) 

1. JEOL grants you the non-exclusive and non-assignable right to use the Licensed Software in the 
Country of Installation. 

2. You may install and use the Licensed Software on a single computer limiting the purpose to carrying out 
of your job. 

3. You may not cause any third party to use the Licensed Software by establishing a sublicense or other 
means, and shall not disclose the Licensed Software to any third party.  

4. You may not take the Licensed Software out of the Country of Installation under any circumstances. 
 
Article 3. (Prohibition of Assignment and Other Acts) 

1.You may not assign, rent or lease the right to use the Licensed Software, disclose the content of the right, 
or transfer possession of the Licensed Software to any third party.  

2. You may not modify, translate, carry out reverse engineering, decompile, and disassemble the Licensed 
Software in whole or in part. 

 
Article 4. (Prohibition of Reproduction) 

You may not reproduce the whole or any part of the Licensed Software. 
 
Article 5. (Rights to Licensed Software) 

All rights related to the Licensed Software including copyrights belong to JEOL. 
 
Article 6. (Warranty) 

1. JEOL does not guarantee proper performance of the Licensed Software if it is modified or translated.   
2. JEOL does not warrant that the Licensed Software is free from defects or fit and useful for your 

particular purpose. 
 
Article 7. (Exemption from Liability) 

JEOL shall not be liable for any damages or losses incurred by you or any third party or for any claim of a 
third party against you arising out of or in relation to the use of the Licensed Software. 

 
Article 8. (Confidentiality) 

You shall keep confidential the content of the Licensed Software supplied hereunder by JEOL and the 
terms and conditions of this Agreement, and shall not divulge or disclose them to any third party without 
the prior written consent of JEOL. 

 
Article 9. (Term of Validity) 

1. This Agreement shall become effective as of the day you accept the terms hereof and so remain unless it 
is terminated pursuant to the next Article. 

2. Notwithstanding the item above, the provisions set forth in the Article 8 (Confidentiality) shall remain 
effective even after the termination hereof. 

 
Article 10. (Termination) 

In any of the following event, JEOL may forthwith terminate this Agreement by so notifying you without 
any prior notification and may claim the damages incurred: 
(1) Any breach on your part of any of the provisions hereof, 
(2) Occurrence of seizure or provisional seizure or provisional injunction on your property; auctioning of 

your property; bankruptcy, corporate liquidation, and filing for corporate reorganization on your part; 
or proceedings taken against you for collection of tax delinquency. 

 
Article 11. (Steps to Be Taken after Termination) 

Upon the termination of this Agreement pursuant to the Item 1 of Article 9 and Article 10, you shall 
destroy the Licensed Software and notify JEOL of such destruction. 

 
Article 12. (Discussion in Good Faith) 

Matters not stipulated herein shall be discussed in good faith and settled between you and JEOL. 





 

 

Safety Precautions 

Although this instrument is protected with safety device which prevents the occurrence of accident that could result in an injury, harm, and damage to 
the users or instrument itself, the safety feature may not work properly if you use the instrument for the purpose of use not intended or in an improper 
usage. For the proper use of the instrument, please be sure to read all of the instructions, descriptions, notices, and precautions contained in this 
manual carefully to understand them fully prior to the operation or maintenance. This section, “Safety Precautions,” contains important information 
related to safety for using of the instrument. 
 
The safety indications and their meanings are as follows: 
 

！WARNING：  A potentially hazardous situation which, if not avoided, could result in death 

or serious injury. 

！CAUTION：  A potentially hazardous situation which, if not avoided, may result in minor 

injury  or material injury. 
 

Labels bearing the following symbols are attached to dangerous locations on the instrument. Do not touch any of these locations with your 
hands or anything else. 
 

 

感電注意 高温注意 挟まれ注意 分解注意  

Examples of symbols 
 

 • Use the instrument properly within the scope of the purpose and usage described in its brochures and 
manuals. 

 • Never open/remove protective parts (exterior panels) and parts that can't be opened/removed without 
use of tool (including key), or disconnect/ connect the cables/connectors that are not described in this 
manual. 

 • Never attempt to do any works of disassembling/assembling the instrument other than those described 
in this manual. 

 • Never make modifications that include installing substitute parts and disabling safety devices or other 
safety features. 

 • Never disconnect the grounding wire or move it from the prescribed position. Failure to follow this 
instruction could result in electric shock. 

 • To avoid falling, do not climb onto the operation table and console during daily operation or during 
maintenance or inspection. 

 • When you dispose of the instrument or liquid or other waste, follow all applicable laws and regulations, 
and dispose of it in a proper manner without polluting the environment. 

 • Be sure to read the “Safety Precautions” section of the manuals for the accessories attached to or built 
into the instrument. 

 • If anything is unclear, please contact your JEOL service office. 

 

Beware of 
Electric shock 

Beware of high 
temperature 

Don’t 
disassemble 

Beware of 
Getting of caught 



 

! WARNING 
General warnings 

• Do not unlock or remove any covered parts, modify or remove component parts, or dismantle these parts in 
any way other than their intended use, due to a risk of thermal, electrical or emissive hazards taking place. 

• Never removing the grounding wire or connect it to any other location than that specified, due to a risk of 
electric shock. 

• Never remove the rear panel for maintenance such as replacement of fuses or any other electric parts; 
otherwise you may get an electric shock. Be sure to ask JEOL service personal for such work. 

• When moving the instrument is required, various hazards are expected. Confirm the specifications and 
installation requirements for the instrument, check the state of the new installation site and contact tour 
local service center 

• When performing maintenance, checks, or routine operations, never stand on the operation table, a stool or 
instrument frame.The instrument might fall over and cause damage. 

• Do not remove the rear panel and replace electric parts (for example, fuse). These might cause electrical 
shock and harm you. Service staffs are the only ones who can remove the rear panel and replace electrical 
parts. No one else should do these. 

• There are potential hazards, concerning the high voltage and magnetic field, which may take place while a 
service engineer is disassembling or replacing the instrument for maintenance. Keep well away from the 
instrument on such occasions. 

 
Warning for oil diffusion pump 

Be sure not to touch the boiler or cover of the oil diffusion pump immediately after its heater has broken, because 
these parts are very hot and you may receive a burn. Please, contact JEOL service office. 

 

Warning for the filament 

• The wehnelt is very hot immediately after the filament burnt out.  Do not touch the wehnelt.  Allow it to 
cool down sufficiently (about one hour), then replace the filament with the removal tool. 

• Never remove the top of the EOS cover while supplying a high voltage (HT ON).  

 

 



 

 

! CAUTION 

 

General cautions 

• If anything abnormal occurs with the instrument, immediately stop operation. Then, contact your local 
service center. 

• When installing the specimen holder or inserting the objective lens aperture, take care not to get your 
fingers caught in the space between the specimen exchange chamber and the specimen exchange rod, 
and the space between the selecting knobs. And, since the EOS and IOS column is placed on the frame 
via the anti-vibration mount, the EOS and IOS column will sway a little even when you operate the knobs. 
Take care not to get your fingers caught in any space that results from this sway. 

• An instrument that has been installed properly will usually not vibrate or give off annoying noises. Should 
this occur, stop the instrument immediately and contact your local service center. 

• A person who wears a medical appliance such as a pacemaker may be affected by magnetic fields and 
must therefor keep well away from the instrument. 

• Do not keep watching the CRT screen or continue keyboard operation for a long time. If you do so, disorder 
due to fatigue may result.  Establish a health control standard or VDT work and make it a rule to conduct 
health check-up periodically. 

• Only use a circuit breaker (over current and ground fault interrupters) in cases of emergencies. Do not 
touch the breaker unless you need to.  
If the breaker trips, it indicates a malfunction in the system and you must contact the JEOL service center 
immediately. 
 
 

  

Column cabinet – Rear view 

 
 

MAIN BLAKER



 

 

Cautions concerning oil rotary pump 

• Be sure not to disconnect the rubber hose from the oil rotary pump during operation.  If you do so, the oil 
in the oil diffusion pump will flow back to the electron optical column, causing serious damage to the 
instrument. 

• Do not let the oil level of the oil rotary pump fall below the lower limit.  If the pump operates with only a 
small quantity of oil, trouble may occur. 

• Do not continue to run the oil rotary pump if the oil level has reached the lower limit. If you do, you might 
damage the pump. 

• Replace the rotary pump oil with new oil once a year. 
• Consult your JEOL service office for instructions for replacing the oil or the oil mist trap. 
• When vacuum pump oil is replaced or vacuum pump is repaired, process the oil in the proper way. 
• The instrument may not be started when the oil temperature of the oil rotary pump is low. The room 

temperature must be kept to 15℃ or more when you start the instrument. 
 

Cautions concerning cooling water 

The water leak sensor is not attached to this device.  
The passage system might cause corrosion and damage and the water leak by the water quality and a pressure 
increase etc. in cooling water. 
Please install the water leak sensor (option) in preparation for an emergency water leak. When the water leak is 
generated by installing this water leak sensor, a large amount of water leak can be prevented.  
Please use the cooling water circulation device (option) when the water quality and the pressure of tap water are 
improper.  (In the device that has Turbo Molecular Pump of the option, cooling water is not used.) 

 

 

Cautions on the specimen stage movement （When using the motor drive stage） 

Before moving the specimen stage, be sure to correctly select the specimen holder and input the specimen 
height.  If you do not perform the setting of these parameters, the stage might move beyond the movement 
limitations, which can break the objective lens, the backscattered electron detector, or other components.  
When you install the specimen holder on the specimen stage, be sure to perform the selection of the specimen 
holder and inputting of the specimen height. 

 



 

 

 

Warning for the filament 

Never remove the top of the EOS cover while supplying a high voltage (HT ON). 

 

 

 

Disassembly and cleaning 

Do not disassemble or reassemble the EOS column. Such work requires great experience and skills. Contact 
your JEOL service office for assistance whenever such works are required. 
 

Follow the precautions described below in order to carry out the cleaning 

• Wear thin and lint-free gloves to handle any parts inside the column in order to prevent 
contamination by perspiration, etc., which could cause charging of electron beam due to oxidization 
of the parts. 

• Complete the cleaning or cleaning of the parts inside the column as quickly as possible. Leaving 
the parts in the atmosphere oxidizes their surfaces. 

• Use as a cleaning agent a nonflammable highly volatile highly efficient solvent that is free room 
impurities and is not harmful to the human body to clean the parts inside the column. Be sure to 
use the solvent in a location free from combustible material and sources of ignition and with open 
windows or proper ventilation, regardless of the quantity. When you use the cleaning agent, be sure 
to wear protective gloves that are resistant to the solvent. 

• Keep the O-rings and the O-ring contact surfaces free room scratches, dust, lint, etc. Even a slight 
scratch, fine dust or lint may cause the poor vacuum. Also, be sure to use the specified vacuum 
grease. 

 
 

 



 

 

 

Cautions concerning Personal Computer (PC) 

 

Hardware 

• Never modify the hardware settings and also never install additional boards.  If you do, the PC or the SEM 
may not work normally.   

• Never connect devices other than the recommended ones.  If you do, the PC or the SEM may not work 
normally.   

• Make sure not to locate a CRT monitor in the vicinity of the electron optical column.  If you do, the 
fluctuation of stray magnetic fields may disturb SEM images. 

 

 

Software 

• Never install application software other than the recommended software. If you do, the PC or SEM may not 
work normally.   

• Never delete application software or files, which have been installed. If you do, the control software may not 
work normally.   

• When an error message appears while operating the control software, close Windows, switch off the PC 
and reset the OPERATION switch of the SEM, and then switch on the PC again.   

• When the control software has not finished normally, the present data vanishes. 

• When the other application is operated while the control software is being executed, the SEM may not work 
normally.  



 

 

 

 

OS 

• Never upgrade the OS or driver software.  If you do, the PC or SEM may not work normally.   

• Never change the settings of the Screen Resolution while the control software is being executed.  If you 
do, the control software may not work normally.  

• Never change the settings of the Dual monitor while the control software is being executed.  If you do, 
the control software may not work normally. 

• Never change the settings of Color quality and Font Size in the window that appears when you click the 
set button of the property display screen.  If you do, the control software may not work normally.   

• If the setting of Screen Resolution is changed, the settings of the Color and Refresh Frequency may vary 
automatically.   

• If the setting of the Refresh frequency in the property display screen is changed, the image may be 
disturbed.   

• Do not activate the screen saver.  If the screen saver becomes active when the control software is being 
executed, the image may not be displayed and the PC may hang up.   

• Do not set System Standby effectively. The personal computer may be hung-up when this setting 
operates while executing the control software. 

• Do not set System hibernates effectively while the control software is being executed. The Windows 
screen may be distracted when this function operates while the control software is being executed.  
Moreover, it enters the state that the image is not displayed when the personal computer is restored from 
hibernate, and the reactivation of the personal computer is needed. 

• Never change the "User" of the Windows while the control software is being executed. If you do, the 
Windows screen may be distracted. When changing the "User" of the Widows, execute it after the control 
software is exited. 

• Never execute the "log off" of the user while the control software is being executed. If you do, the Windows 
screen may be distracted. When executing the "log off" of user, execute it after the control software is 
exited. 

• Never validate the Windows Firewall and Automatic Updates functions. If you do, the SEM may not work 
normally. Set these functions in "Invalidity". 

 



 

 

 

• Windows／display／Mouse is normally set as follows; 
(  When the new user account is created, confirm the settings as follows;) 

Screen resolution： 1280×1024 pixels 
Color quality： Highest (32-bit) 
Font size： Normal 
Refresh frequency： 60 Hz 
System Standby： Invalidity 
System hibernates： Invalidity 
 

Windows Firewall： Invalidity 
Automatic Updates： Invalidity  

 
 
 
 



 

 

EDS unit 
 

Please note the following point when the device that uses the customer is JSM-6510A or JSM-6510LA model. 

 

 

! WARNING 
 

• A high bias voltage for the EDS detector is applied to the “HV OUT” connector on the DBVM board of the 
SSM sub-system, so do not carelessly touch this connector. 
If you touch this connector, you may receive an electric shock. 

• A high bias voltage is supplied to the preamplifier of the EDS detector, so do not remove the case. 
If you remove the case and touch the circuit inside, you may receive an electric shock. 

 

! CAUTION 
 

• Never touch any of the switches, trimmers, connectors or cables at the rear of the SSM sub-system. 
If you inadvertently set or connect the SSM sub-system in an incorrect condition, a malfunction or a 
breakdown may occur. 

• The window of each of the standard, Minicup, and Helicon EDS detectors is made of beryllium (Be), so 
Never touch the window.  Also, do not heat the window or cause a chemical reaction to take place by 
exposing the window to a chemical reagent.  Beryllium powder or vapor is harmful to the human body. 
If beryllium gets onto your clothing or skin, wash it off completely with soapy water, or the like. For the 
method of disposing of beryllium, consult with JEOL’s serviceman. 

• Be very careful of the following points when supplying liquid nitrogen to the Dewar vessel of the EDS 
detector. 

It is very dangerous to allow liquid nitrogen to penetrate your clothes or gloves, so avoid it as carefully as 
possible. If liquid nitrogen gets on your skin or clothes, it may cause frostbite. 

Do not use liquid nitrogen in an unventilated room. Be sure to ventilate the room to prevent suffocation by 
nitrogen gas resulting from the evaporation of liquid nitrogen. 

Take care that liquid nitrogen does not overflow from the EDS detector Dewar vessel. If liquid nitrogen gets 
onto a nearby unit such as the preamplifier, a breakdown may occur. 

If water has collected at the bottom of the inside of the EDS detector Dewar vessel, or if water droplets 
adhere to the outer cylinder, wipe the water away with a cloth, or the like, before adding liquid nitrogen. 
If you fill the Dewar vessel with liquid nitrogen without wiping away the water, the performance of the 
detector may fall, or the detector may break down. 

Do not use a refrigerant other than liquid nitrogen in the EDS detector Dewar vessel. 



 

 

 

• Before supplying liquid nitrogen to a Minicup type EDS detector, be sure to evacuate the detector according to the 
instruction manual for the detector. If you supply liquid nitrogen using an incorrect method, the detector may be 
damaged. 

• Ensure that the Dewar vessel of each of the standard and Super-Nine EDS detectors always contains liquid 
nitrogen. If the Dewar vessel runs out of liquid nitrogen, the detector may break down or its performance may be 
impaired. 

• Be sure to keep the Dewar vessel of an EDS detector capped. If the Dewar vessel are not capped, ice will form on 
the filler hole, and also the consumption of liquid nitrogen will increase. 

• The window of the EDS detector is extremely thin, and is likely to be damaged if touched by an object. If the 
detector window becomes damaged, liquid nitrogen will spurt out from the EDS detector Dewar vessel. Be very 
careful, therefore, not to damage the window. 

• Be very careful of the following points when using a Helicon type EDS detector, in which liquid nitrogen is 
unnecessary. 
Before starting the detector, be sure to confirm that cooling water is flowing inside the refrigerator compressor, and 
should be fed continuously during operation. If you do not feed water, the safety unit will operate, and the 
refrigerator compressor will automatically stop. Once the compressor stops, it will take time to restart, even if you 
feed water again. 
The refrigerator is connected to the EDS detector by a high-pressure gas pipe, so take care not to touch or 
damage this pipe. If the pipe is damaged, the high-pressure gas, helium, will leak.  Although it is not harmful 
to health, it will be necessary to replenish the gas before you can reuse the spectrometer. 
It is necessary to carry out periodic maintenance on the refrigerator used for cooling the EDS detector. If you fail to 
carry out periodic maintenance, the performance of the detector may deteriorate or a breakdown may occur. 

• Regardless of the type of EDS detector, if a remote shutdown occurs, the following message will appear: “The 
detector cannot be used now.  Refer to the instruction manual.” 

• When the operating distance of the specimen stage is shorter than the specified analysis one, or when the EDS 
detector is not in use, put the EDS detector as far from the stage as possible.  
If you reduce the operating distance of the specimen stage while leaving the EDS detector inserted, you may damage the EDS 
detector. 

• The preamplifier of the EDS detector contains a precision electronic circuit, so do not remove the case.  Also, do 
not apply a large impact to the detector. 
Failure to observe the above precautions may result in a malfunction or a breakdown. 

• If you wish to turn the power switch of the analyzer OFF then ON again, wait for at least 5 seconds after turning it 
OFF before turning it ON again. 
Turning the analyzer ON and OFF repeatedly may damage it. 

• Before installing or removing a connector, board, and so on, turn OFF the power switch. 
If you carry out such work with the power switch left ON, a breakdown may occur. 

• Never connect devices and also never install software to the PC. If you do, PC or the EDS (or SEM) may not work 
normally. Please, contact JEOL service office, if necessary. 
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General, specifications and composition 

 

 

Specifications and composition guaranteed when no modification or addition is made, and subject to change without notice. 

Refer to the EDS instruction manual for the specifications and composition of EDS unit. 
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1.1 General 
 

This equipment features a new graphical user interface (GUI) with an improved operation, by using thanks to the 
newly enhanced display function of “Dual screen live image” and “Operation Navigator”. 
 
 

• Observation, functional operation and maintenance work are easily performed by following the 
guide. 

• In addition to the conventional display modes (Dual live image, Split live image, Flexible window 
display, Zoom screen display), Dual screen live image (640x480) is realized and depending on the 
purpose to observe among multiple users, selection of optimum, display mode from them becomes 
possible. 

• Image of the sample even with unknown observation conditions can be easily obtained by only 
selecting sample category. 

• Resolution of 3.0nm is guaranteed, and at low accelerating voltages it realizes 8 nm at 3.0kV and 
15 nm at 1kV, which are extremely high for microscopes of this class. 

• Thanks to the observation at minimum magnification ×5 and Stage Navigation system (option), 
to find the image field becomes easier. 

• The chamber design is optimized to equip with EDS, WDS, EBSP and related options. 

• The analysis position of the energy-dispersive spectrometer (EDS) has a WD of 10mm and a 
take-off angle of 35 ° for X-ray signals, which makes possible efficient analysis and 
low-magnification mapping analysis under the same conditions as high-resolution SEI observation. 

• The EDS, an energy-dispersive X-ray analyzer is provided with a high-performance PTTD (Position 
and Time Tagged Data) function, whose digital electronics makes rapid high-precision analysis 
possible. 

• Smile Shot enables you to obtain an image by merely selecting the type of specimen. 

• By saving moving images, you can record the observation history and the dynamic behavior of the 
specimen. 

• You can observe a nonconductive specimen as it is, in the low-vacuum mode. 

• The extremely small cabinet for microscopes of this class permits you to install the instrument in a 
small space. 

 

  

JSM-6510, JSM-6510LV  JSM-6510A、JSM-6510LA 
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1.2 Specifications 

1.2.1 Performance 

1.2.1.a Resolution 

High-vacuum mode (HV mode) 
3.0nm Acc V 30kV, WD 8mm, SEI 
8.0nm Acc V 3kV, WD 6mm, SEI 
15.0nm Acc V 1kV, WD 6mm, SEI 

Low-vacuum mode (LV-mode) 
4.0nm Acc V 30kV, WD 5mm, BEI 

 
 

1.2.1.b Image mode 

High-vacuum mode (HV mode) 
 SEI（E.T detector） 
 BEI（E.T detector） 
 BEI （ Composition image, Topographic and stereoscopic images by 

semiconductor detector） 
  
Low-vacuum mode (LV-mode) 
 BEI （ Composition image, Topographic and stereoscopic images by 

semiconductor detector） 
 Low-vacuum SEI（optional） 

 
 

1.2.1.c Magnification 

 ×5 to 300,000（149 steps） 
 （×5 to ×8：WD46mm or longer and Acc.V 10kV or less） 

 
 

1.2.1.d Probe current 

 1pA to 1μA 
 
 
 

1.2.1.e Vacuum pressure in the specimen chamber 

Adjustable pressure 10 to 270Pa 
 

SEI：Secondary electron image 
BEI：Backscattered electron image 

Acc.V：Accelerating voltage 
WD：Working distance 
E.T：Everhart-Thornley 
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1.2.2 Electron optical system（EOS） 

 
Except the automatic gun control, applicable to both LV and HV modes. 

 
 

1.2.2.a Electron gun 

Accelerating voltage 0.5 to 30kV（53 steps） 
0.5 to 3kV：100V steps 
3 to 30kV：1kV steps 

Filament Precentered tungsten hairpin filament 
Bias voltage Seamless automatic bias（linked to Acc.V） 
Alignment Electromagnetic 2-stage deflection 
Automatic gun control Filament-heating current setting and alignment 
 （possible only at HV mode） 
Beam blanking Preventing the specimen damage from the irradiation of the electron beam 

 
 

1.2.2.b Lens system 

Condenser lens（CL） Electromagnetic 2-stage zoom condenser lens system 
Objective lens（OL） Conical mini-lens 
Lens reset Provided for CL and OL (for hysteresis elimination) 
Focusing Automatic or manual focusing possible 
Automatic focus tracer Linked to WD 
Dynamic focusing Linked to Acc.V. and magnification 
Wobbler Provided for objective-lens aperture alignment, Linked to magnification 
Objective-lens aperture Optionally selectable from the following two types： 
 MAP3：3-step selectable with click-stops, fine X-Y adjustment possible 
 MAP1：Single aperture, fine X-Y adjustment possible 

 
St igmator (ast igmatism 
correction) Electromagnetic 8-pole X-Y adjustment 

Stigma Preset Setting the preset data into the Stigma data 
 
Scanning coil Electromagnetic 2-stage deflection 

Image fine shift Electromagnetic 
 Approximately ±50 µm in X and Y directions（at Acc.V. 30kV, WD：10mm） 
Automatic magnif icat ion  
correction Linked to Acc.V. and WD 
Preset magnification Five different magnifications can be set 
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1.2.3 Specimen stage 

1.2.3.a LGS 

Type Eucentric stage 
Specimen movement 5 axes（X,Y,Z,R,T）, manual movement  
Specimen movement ranges X movement： 80mm 

Y movement： 40mm 
Z movement： Eucentric movement range for WD of 5 to 48mm 

   Focusing range for WD of 5 to 48mm 
Tilt (T)： －10 to ＋90゜ 

   （Tilt range might differ depending on the specimen  
  holder size） 
 Rotation(R)： 360°endless 
Specimen holders  For 32mm diameter×10mm thick 

（with an adapter for mounting four 10 mm diameter specimens） 
Maximum specimen size Possible to mount a 150mm diameter specimen 

Possible to observe the entire 125mm diameter region（using R axis） 
Specimen exchange Stage draw type（Specimen holder slides in/out） 
 （Optional for air-lock type） 

 
 
 

1.2.3.b GS 

Type Eucentric stage 
Specimen movement 5 axes（X,Y,Z,R,T）, manual movement 
Specimen movement ranges X movement： 20mm 

Y movement： 10mm 
Z movement： Eucentric movement range for WD of 5 to 48mm 

   Focusing range for WD of 5 to 48mm 
Tilt (T)： －10 to ＋90゜ 

   （Tilt range might differ depending on the specimen  
  holder size） 
 Rotation (R)： 360°endless 
Specimen holders  For 32mm diameter×10mm thick 

（with an adapter for mounting four 10 mm diameter specimens） 
Maximum specimen size Possible to mount a 32mm diameter specimen 

Possible to observe the entire 32mm diameter（using R axis） 
Specimen exchange Specimen exchange Stage draw type（Specimen holder slides in/out） 
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1.2.4 Specimen chamber（Attachment port） 

Energy Dispersive Spectrometer (EDS) port    1 
Electron Backscattered Diffraction (EBSD) port    1 
Wavelength dispersive spectrometer (WDS)／Specimen Cooling Unit (SCU)／ 
Specimen Holder image for IC (SHIC) port    1 
Backscattered Electron image Detector (BEIW) port    1 
Low Vacuum Secondary Electron detector (LVSE) port（installed on the side of the LGS）＊ 1 
Specimen chamber scope (SCS)／Airlock chamber (ALC) port（installed on the front of LGS）＊ 1 
Specimen absorption current terminal (ACT) port（installed on the side of the GS and LGS stage） 1 
Probe current detector（PCD）port （installed on the column）    1 
 
＊ LGS requires these options  
 

 

1.2.5 Detector 

High-vacuum mode (HV mode) 
Secondary electron detector E.T (Everhart-Thornley) detector (consisting of collector, scintillator, light guide 

and photomultiplier tube) 
 
Low-vacuum mode (LV mode) 

Backscattered-electron detector Semiconductor (P-N junction) detector（can also be used in the HV mode） 
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1.2.6 Display system 

1.2.6.a Display 

 Liquid crystal display（19-inch type） 1 set 
 

1.2.6.b Scan system 

Scanning mode Full frame scan (640×480 pixels) 
Scan speed 
 

 Horizontal (ms) Vertical(s) Pixels 

0.284 0.075 
1.137 0.258 SCAN1 

（Selectable） 
2.048 0.512 

320×240 

0.284 0.150 
1.137 0.576 

SCAN2 
（Selectable） 

2.048 1.024 
640×480 

20(16.67) 10(8.33) 640×480 
20(16.67) 20(16.67) 

SCAN3 
（Selectable） 

40(33.33) 40(33.33) 
1280×960 

80(66.67) 80(66.67) 
160(133.3) 160(133.3) 1280×960 SCAN4 

（Selectable） 
80(66.67) 160(133.3) 2560×1920 

Power frequency 50Hz, Values in parentheses: 60 Hz 
 
 
 

1.2.6.c Frame memory 

Capacity 2560×1920×8 bits 1 
Number of pixels 640×480、1280×960、2560×1920 

 
 
 

1.2.6.d Saved image processing 

Look-up table Linear, Contrast increase/decrease, γ-correction, Multiple-level coding,  
 Partial enhancement, Inverse video 
Pseudo color image 16 colors 
Multiple display Display of 2 or 4 images in one frame 
Digital zoom Display of an arbitrary area at 2× or 4× 
Dual magnification Display of an enlarged image of the left side in the right side 
Full screen display  Display of a saved images on the entire monitor screen 
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1.2.6.e Live image processing 

Image display function 
Averaging Accumulation of 1 to 255 images 
Dual live display You can display two live images of the same image field with different signals  
 simultaneously by vertically or horizontally dividing the main screen into two. 
Split live display By dividing an image field using a vertical or horizontal partition line, you can  
 display two live images of both sections with different signals 
Flexible window display You can display any rectangular area in an image field with different signals.  
 You can display the live image for both original image and the rectangular areas. 
Zoom screen display Display of a live 640×480 pixel image on the entire monitor screen 
Dual screen live image Display of a two live screen images at each 640×480 pixels 
Signal addition Display of the image with two signals mixed for one image 

 
Measurement functions 

Two points measurement (such as line, free) Measurement of the distance between any two points 
Circle measurement(such as diameter) Measurement of the circumference and distance between the two  
 centers. 
Line-width measurement (parallel X/Y, diagonal) Measurement of the distance between two parallel horizontal or  
 vertical line segments.  If you surround a region with horizontal 
 and vertical lines, the length of the diagonal is also measured. 
Angle measurement (angle) Measurement of the angle between two line segments that  
 extend from a center point 
Area measurement (polygon, circle) Measurement of the polygon and the area surrounded by the 
 circle 
Counting (count) Measurement of the numbers of the click on the image 
 

Text display 
Display position Displayed on the image 
Text Alphanumeric characters and symbols  
Character kind Any PC fonts can be selected 
Background You can select black or an image for the background 
Text-entry device Keyboard 

 
 

1.2.6.f Data display 

Display position Horizontal at the bottom of the screen 
Contents 

High-vacuum mode Image mode, Acc.V、WD、Spotsize、Magnification、Scale bar with micron value, 
User name、Lavel、Film number（4 digits）、Date、Time（the actual time which 
you are saving recorded） 

 
Low-vacuum mode The specimen-chamber pressure (in Pa unit) appears in the section where the 

image kind is shown in the H-Vac mode. 
Background You can select black or an image for the background 
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1.2.6.g File saving 

Format BMP、TIFF or JPEG  
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1.2.7 Operating system 

 
This item applies for both high and low vacuum modes except for the automatic gun control. 

 
 

1.2.7.a Basic System 

Computer IBM PC／AT compatible computer 
Operating System (OS) Windows ® Vista ＊ 
 ＊ Windows ® Vista is a trademark of Microsoft Corp 

 
 
 

1.2.7.b Operation 

Operation method Graphical user interface, mouse and operation keyboard（Operation keyboard is 
available as an option） 

 
 
 

1.2.7.c Operating guide 

The guide is composed from the individual job and such procedure as the 
observation, functional operation and maintenance etc., is displayed. If you follow 
the observation procedure and operate SEM, you can easily get the image. 

 
 
 

1.2.7.d Recipe function 

 Various conditions of the electron beam illumination system, stage position and 
vacuum system mode can be set in a recipe file. 

 Custom recipes which can be recorded for individual users, and standard recipes 
which can be used in common, are provided. 

 Number of custom recipes is limited only by hard-disk space 
 
 

1.2.7.e Automatic functions 

Automatic gun control Temperature setting of the filament heat and the alignment setting are 
  automatically adjusted. 
Automatic focusing (AF) Adjusts the focus automatically.  
Automatic astigmatism correction (AS) Corrects the astigmatism automatically  
Automatic contrast/brightness (ACB) Adjusts the contrast and brightness automatically.  
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1.2.7.f Image observation support functions 

Click centering Double-clicking centers any image position inside image-display area（A similar 
operation is possible in Snapshot） 

Click center zoom Centers and zooms until the image is magnified up to about three times (15 
steps) on the spot the user clicks (A similar operation is possible in Snapshot) 

Drag Dragging the mouse moves the point under the mouse cursor to any desired  
 position. 
Frame shift Moves an image by a specified rate (MS must be used) 
Snap shot Pastes two image screens (frozen images) at the side of the image-display area, 

and carries out stage position control on images. 
Moving image save You can save moving images in the AVI format. The maximum recording time 

depends on the capacity of the hard disk of the PC.  (Guideline: 280 MB is 
required for saving a 60 s image.) 

Mag/Tilt correction Magnification is corrected when the specimen is tilted. 
 
 
 
 

1.2.7.g User’s settings 

Mouse control selection Can restrict mouse cursor to up/down or right/left movement 
Changing of stage-movement  
direction  Switching of stage-movement direction when operating stage on image-display 

area 
Icon user setting Can select or set the icons on the Graphic User Interface 
Eco mode Can set the energy-saving mode 

 
 
 
 

1.2.8 Operation table 

Choose an operation table from the following options, or provide the similar 
commercial table at the customer’s site. 
 
MP-48020TBL：900（W）×900（D）×750（H）mm 
EM-02540FTBL：750（W）×900（D）×750（H）mm 
These tables can store the PC and a small EDS (only JED). 

 



1. General, specifications and composition 
 

_______________________________________________________________________________________________  
 

1-11

 

1.2.9 Evacuation system 

Control Fully automatic 
Ultimate pressure (in gun chamber) HV mode 0.1mPa order 
 LV mode 1mPa order （when the pressure in the specimen chamber is about  
 27 Pa） 
Required time for evacuation HV mode  About 2 min 
 LV mode  About 1 min 30 s 
Oil rotary pump 100L/min 2 
Oil diffusion pump 4 type 420L/s（with water baffle） 1 
Orifice Removable type (always mounted) 
Control valve Fine metering valve type 
Specimen chamber pressure gauge  Pirani gauge 

 
 
 

1.2.10 Safety devices 

Devices to protect against failures of power supply, water supply, vacuum 
(pressure increase), and ground fault, are provided. 
 
A mechanism for adjusting the flow rate of cooling-water is built in. 
An optional water leakage sensor can be built in. 

 
 
 

1.2.11 Eco mode 

If you do not operate the PC or other devices for a certain time, the device enters 
the energy-saving mode (you can set the time until the Eco mode turns on).  
You can turn the energy-saving mode on or off on the Graphic User Interface. 

 
 
 

1.2.12 Others 

BNC output BNC-R connector (one for video printer connector) 4 
Service receptacles 100VAC、8A     1 
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1.3 Specifications of an options 
 

The options of the normal constitution are different by the instrument (Bu, LV, A or LA). 
 
For specifications of Personal computer and LCD, refer to the maker’s instruction manual. 
Refer to the EDS instruction manual for the specifications and composition of EDS unit. 

 
 
 
 
 

1.3.1 EDS INTEGRATION SOFTWARE(EDSI) 

 

General 
This software is used for a scanning electron microscope (SEM) equipped with an energy dispersive 
X-ray spectrometer (EDS) to control some functions of the SEM from the EDS side. 

 
 
Specifications 

Communication protocol TCP/IP, original protocol 
Control method Conversation type control by commands from the EDS side 
Controlled functions Accelerating voltage (AccV)、Working distance (WD)、Magnification 

(MAG)、High tension (HT:ON/OFF)、Objective lens current (OL-Coarse， 
OL-Fine)、Condenser lens current (CL)、Reset (OL,CL)、Probe current 
detector (PCD: ON/OFF)、Stage control、Automatic focus (AFD)、
Automatic contrast/brightness (ACB)、Automatic stigmator (ASD) 

 
 
Configuration 

CD-ROM for installation  1 set 
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1.3.2 EXTERNAL SCAN INTERFACE (ESIF) 

 

General 
This interface is installed in the operation console of the Scanning Electron Microscope (SEM) to scan 
the electron beam by the control signal sent from an external instrument such as an energy dispersive 
X−ray spectrometer (EDS). 

 
 
Specifications 

Input signal Internal/external switching signal､Horizontal/vertical scanning signal 
 3 input channels provided on the connector panel 
Output signal Secondary electron image signal or backscattered electron image signal in slow 

scan 
 3 output channels provided on the connector panel 

 
 
Configuration 

Interface unit（including a connector panel）  1 set 
 
 
 
 

1.3.3 VACUUM STATE INTERFACE (VSIF) 

 
General 

This interface is used for communication between an SEM basic unit and an energy dispersive X−ray 
spectrometer (EDS) or a wavelength dispersive X−ray spectrometer (WDS).  The SEM basic unit 
sends the HT−READY signal to the EDS or WDS, and the EDS or WDS sends the VENT−LOCK signal 
to the SEM basic unit. 

 
 
Specifications 

Output signal HT−READY signal (SEM to EDS or WDS) 
2 output channels provided 

Input signal VENT−LOCK signal (EDS or WDS to SEM) 
 2 input channels provided 

  
 
Configuration 

Vacuum state interface unit   1 set 
Short connector    2 
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1.3.4 EXTERNAL CONTROL SOFTWARE (EXCS) 

 
General 

This MP-46020 External Control Software is used for controlling a scanning electron microscope (SEM) 
from an external energy dispersive X-ray analyzer consisting of an EDS and WebSEM Client PC.  It is 
to be installed in the SEM-side PC.  
The software makes possible EDS specimen analysis and SEM remote control through LAN or the 
public communication network. 

 
 
Specifications 

Basic functions 
 Communication between the SEM-side (server) PC and client-side PC 
 Communication protocol: TCP/IP 

 
 
Configuration 

Installation disk   1 set 
 
 
 
 

1.3.5 SIGNAL SWITCHING UNIT（SSU） 

 
General 

This unit selects signals from various detectors (signal sources) and outputs them to the signal 
processing display system. 

 
 
Specifications 

Input channels 7CH 
(Analog signal input channels：3CH、Input impedance 75Ω) 

 (PMT signal input channels：4CH、Input impedance：1.8 kΩ) 
Output channel 1CH 
 (Output impedance：1.8 kΩ) 

 
 
Configuration 

Signal switching unit  1 set 
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1.3.6 TABLE（TBL） 

 
General 

TBL is a table with an original design that can accommodate two 19 inch LCD monitors with an 
abundance of space for the monitor footing.  The table can hold the DPP unit of a JEOL Energy 
Dispersive X-ray Analyzer, the Mini Cup Evacuation Controller 2 and a personal computer. 

 
Specifications 

Dimensions 900 mm(W)×900 mm(D)×750 mm(H) 
Color of top of table Same color as the column rack 

 
Configuration 

Table    1 set  
 
 
 
 

1.3.7 BACKSCATTERED ELECTRON DETECTOR（BEIW） 

 
General 

This detector is placed under the bottom plane of the lower-pole of the objective lens of the EOS, and 
detects electrons that are backscattered from the specimen surface. The detector consists of a split 
semiconductor detector and a semiconductor detector that is used to produce shadows in images. The 
signals that are detected separately by the detectors are processed to produce three types of images: 
solid image (Shadow), composition image (Compo) and topographic image (Topo). All operations can be 
carried out on the monitor screen of the computer. 

 
 

Specifications 
Photodiode Silicon P-N junction semiconductors 
Types of images Solid image (Shadow), Composition image (Compo), Topographic image 

(Topo) 
Amplifiers Preamplifier, operational amplifier 
Video outputs Shadow, Compo, Topo 
Bandwidth Approximately 500 kHz 
Working distance 5 to 48 mm 
Automatic functions: Automatic focusing, Automatic contrast/brightness adjustment, Automatic 

stigmator 
 
 

Configuration 
Backscattered electron detector unit（includes detectors and parts for mounting them） 1 set 
Amplifier（includes a circuit board, flange, cable）    1 set 
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1.3.8 OPERATION KEYBOARD（OKB） 

 
General 

Scanning electron microscopes are basically operated using a mouse.  This Operation Keyboard is 
provided to enable an operator who is not familiar with mouse operation to operate the microscope, 
carrying out tasks such as focusing in a high-magnification range and astigmatism correction with ease.   

 
Specifications 

Scanning mode selection（acquire） Button switch (PHOTO) 
Contrast adjustment  Rotary knob 
Brightness adjustment  Rotary knob 
Astigmatism correction  Rotary knob 
Magnification selection  Rotary knob 
Focusing Rotary knob 

with COARSE/FINE selection button（Button switch） 
Automatic functions  Button switches（ACB，AUTO FOCUS，AUTO STIG） 

 
Configuration 

Operation keyboard (with USB cable)  1 set 
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1.4 Installation requirements 

1.4.1 Power 

 Single phase AC 100 V ±10%, 50/60 Hz,  
3.0 kVA (Voltage drop should be 3% or less at 3.0 kVA.) 

 
 

1.4.2 Grounding terminal 

 100Ωor less 1 
 
 

1.4.3 Cooling water 

Faucet l4 mm outside diameter or  
 JIS  B0203 Rc 1/4 (ISO 7/1 Rc1/4)  1 
Drain At least 25 mm inside diameter or 
 JIS  B0203 Rc 1/4 (ISO 7/1 Rc1/4)  1 
Flow rate 2L／min 
Pressure 0.05 to 0.2MPa (gauge) 
Temperature 15 to 25℃ 

 
 

1.4.4 Installation room 

Temperature 15 to 25℃ 
Humidity 60% or less 
Stray magnetic fields 0.3μT（p-p）or less, for 50/60 Hz sine wave (WD 15 mm, Acc.V. 30 kV) 
Space required for instrument 2,000 mm（W）×2,500mm（D）×1,800mm（H）or more 
Door width 850 mm or more 

Dimensions and masses 
  Width（mm） Depth（mm） Height（mm） Mass（kg） 

EOS column unit 750 1000 1445 About 325 
Table（MP-48020TBL） 900 900 750 About 40 
EDS unit － － － About 25 
Oil rotary pump（one） 460 175 255 A bout 23 
Vibration isolator 270 200 200 About 10 
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1.4.5 Cautions on installation requirements 

 
Installing JSM-6510 series in the following place may disturb the image  

 
• On soft ground (reclaimed ground, lakeshore, riverside, seashore, etc.) 

• Less than 50 m from a highway 

• Less than 100 m from the railway 

• Within 15 m of elevators 

• Within 10 m of electric motors (10kW or more)) 

• Within 10 m of large transformers (10kVA or more)  

• Within 3 m of interior wiring (100A or more)  

• Within 20 m of factory high-voltage transmission lines. 

• Within 30 m of the transformer room 

• Within 150 m of high-voltage transmission lines of electric power company 

• Within 1 km of transmitting antennas 

• Within 2 m of computers such as personal computers 

• Where a high-power transceiver or wireless phone is used in the vicinity 

• Where noise is at an unusually high level 

 
 
＊ Upon receipt of order, a JEOL engineer will visit your site to measure floor vibration and stray magnetic 

field in your installation room.   
＊ If the above requirements are not met, additional measures are necessary.  Contact your JEOL service 

office. 
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1.4.6 Layout example 

 
Example;  JSM-6510LA 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• This above figure shows a typical installation layout. Be sure to maintain service areas at the left and right 
sides and to the rear of the microscope even if only a small installation area is available. 

• Install the microscope well apart from facilities producing vibrations or electromagnetic waves such as 
roads, busy passages, railroads, elevators, air conditioners and their air outlets, and power transmission 
lines. 

• This microscope does not require any darkroom facilities such as blackout curtain. 
• This device does not include a water-leakage sensor. Bad quality or pressure increase of the cooling water 

might corrode or erode the water circulation system and cause water leakage. Install the optional 
water-leakage sensor preparing for the worst. By installing this water-leakage sensor, you can prevent the 
instrument from leaking a large amount of water when water leakage occurs. Moreover, if the water quality 
or pressure is inappropriate, use the optional cooling water circulation unit. 

 

Distribution switchboard Water faucet／drain 

Unit ：mm 

EOS column unit

Entrance 

850 or more 

 

Monitor 

Mouse 

Table 

Keyboard 

Oil rotary pump 

Oil rotary pump 

2000 

2500 1000 

750 750 

900 

EDS 
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1.5 Composition 

 

JSM-6510 

• Basic unit·································································································  1 set 
Including the Software, Tool box (including the accessory, tools),  
Parts for installation and transportation (including the power cable, water hose) 
Oil rotary pump（1 set）, Instruction manual 

• Specimen stage ························································································  1 set 

• Movable aperture ······················································································  1 set 

• Personal computer unit（Including the mouse, keyboard, etc.） ·························  1 set 

• Liquid crystal display ··················································································  1 set 

 
 
 

JSM-6510LV 

• Basic unit·································································································  1 set 
Including the Software, Tool box (including the accessory, tools),  
Parts for installation and transportation (including the power cable, water hose) 
Oil rotary pump（2 set）, Instruction manual Specimen stage····························  1 set 

• Specimen stage ························································································  1 set 

• Movable aperture ······················································································  1 set 

• Personal computer unit（Including the mouse, keyboard, etc.） ·························  1 set 

• Liquid crystal display ··················································································  1 set 

• Backscattered electron detector····································································  1 set 
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JSM-6510A 

• Basic unit ································································································  1 set 
Including the Software, Tool box (including the accessory, tools),  
Parts for installation and transportation (including the power cable, water hose) 
Oil rotary pump（1 set）, Instruction manual 

• Specimen stage························································································  1 set 

• Movable aperture ······················································································  1 set 

• Personal computer unit（Including the mouse, keyboard, etc.） ························   1 set 

• Liquid crystal display··················································································  2 set 

• EDS integration software ············································································  1 set 

• External control software ············································································  1 set 

• External scan interface ···············································································  1 set 

• Vacuum state interface···············································································  1 set 

 
 
 

JSM-6510LA 

• Basic unit ································································································  1 set 
Including the Software, Tool box (including the accessory, tools),  
Parts for installation and transportation (including the power cable, water hose) 
Oil rotary pump（2 set）, Instruction manual 

• Specimen stage························································································  1 set 

• Movable aperture ······················································································  1 set 

• Personal computer unit（Including the mouse, keyboard, etc.） ························   1 set 

• Liquid crystal display··················································································  2 set 

• EDS integration software ············································································  1 set 

• External control software ············································································  1 set 

• External scan interface ···············································································  1 set 

• Vacuum state interface···············································································  1 set 

• Backscattered electron detector ···································································  1 set 
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1.6 Instrument warranty 
 

This instrument is guaranteed for one year from the date of installation.  We undertake to repair it free of 
change in the event that it breaks down within this period, except in cases where the breakdown is the result of a 
force majeure or careless handling. 
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Name and explanation of each part 
 
 
 
 
 

Refer to the EDS instruction manual for the name and explanation of EDS unit.（When the instrument is A／LA model） 
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2.1 Exterior of instrument 
 
 

 

JSM-6510、JSM-6510LV 

 
 

 

JSM-6510A、JSM-6510LA 

 
 

EOS column unit 

Liquid cyristal display (LCD) 

Keyboard 

Personal computer 

Table (option) 

EDS unit

Mouse 

Column cover_upper

Column cover_Lower
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2.2 EOS column unit 
 
 

  
 

Top of the EOS cover was removed 
 
 

 
 

Wehnelt Electron gun 

Movable aperture 

Main control panel 

Specimen stage 

Specimen chamber 
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2.2.1 Movable aperture 

 
！CAYTION  

When selecting the aperture of the movable aperture, be careful not to get your 

fingers caught in the grip. 

 
 

• By rotating the aperture selection knob clockwise through the 0 →1 →2 →3  positions, you 
can select an aperture that corresponds to the scale. 

• If you wish to switch the aperture in the sequence 3 →2 →1 →0 , pull the aperture selection 
knob forward, rotate it counterclockwise until it stops, then turn it one step at a time. 

• X and Y direction fine adjustment knobs used for adjusting the movable aperture. 
 

 
 
 
 
 

Scale Aperture 

（μmdia.） 

Purpose of use 

3 100 Use when a large current is necessary such as using WDS. 
2 30 Used for normal observation, EDS analysis, and etc. 
1 20 Used for high resolution observation 
0 None Use for maintenance work 

 

Aperture selection knob 

Y-direction fine adjustment knob 

X-direction fine adjustment knob 
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2.2.2 Specimen chamber 

 

 

 
 
 

 
 

Interior of the specimen chamber（Front view） 

 
 

Backscattered electron detector 
 
Orifice／Sleeve 

Specimen stage 

Specimen chamber 

Specimen holder
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2.2.3 Specimen stage 

 

 

 
 Name Explanation 

1 X axis knob The stage moves to this side and the interior  
The image moves left and right. 

2 R axis knob The stage rotates 
3 Y axis knob The stage moves left and right 

The image moves up and down 
4 T axis knob The stage inclines 
5 Z axis knob The stage moves up and down 

 
 

 
 

1 

2 

3 

4

5
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2.2.3.a Stage movement range 

 
！CAUTION 

• Be sure to move the stage within the movement range. 

When it exceeds a range, the stage or holder touches the bottom of objective lens, and it is likely to 
be damaged. 

• The following movement range does not taken sample size into 

consideration. 

The following movement range is based on a sample is not protruded above the holder 
surface. If a sample protrudes above the holder surface, the following movement range does not 
secure. 

 
10mm diameter specimen holder （X and Y axes movable range） 

○： Movable with whole range (X=0 to 80mm and Y= 0 to 40mm) 
×： Movable regardless of position of X and Y axes 

Z (mm) 

T (°) 
8 10 15 20 30 40 48 

0 ○ ○ ○ ○ ○ ○ ○ 
10 ○ ○ ○ ○ ○ ○ ○ 
20 ○ ○ ○ ○ ○ ○ ○ 

30 X=0 to 80 

Y=0 to 23 
○ ○ ○ ○ ○ ○ 

40 X=7 to 80 

Y=0 to 21 

X=7 to 80 

Y=0 to 23 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=0 to 40 

50 X=7 to 80 

Y=0 to 20 

X=7 to 80 

Y=0 to 21 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=0 to 40 

60 X=7 to 80 

Y=0 to 19 

X=7 to 80 

Y=0 to 21 

X=7 to 80 

Y=0 to 27 

X=7 to 80 

Y=0 to 30 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=0 to 40 

70 × × 
X=8 to 80 

Y=0 to 10 

X=8 to 80 

Y=0 to 25 

X=8 to 80 

Y=0 to 40 

X=8 to 80 

Y=0 to 40 

X=8 to 80 

Y=0 to 40 

80 × × × 
X=8 to 80 

Y=0 to 3 

X=8 to 80 

Y=0 to 15 

X=8 to 80 

Y=0 to 40 

X=8 to 80 

Y=0 to 40 

90 × × × × 
X=8 to 80 

Y=0 to 7 

X=8 to 80 

Y=0 to 17 

X=8 to 80 

Y=0 to 35 

When the stage is set in accordance with the table, the distance between the bottom of OL (objective lens) and the 
specimen holder surface is coming to be kept to 3 to 5mm. 

 

※ The stage movement range described to this manul is range of the movement of LGS. 
 When you install stages (GS, MS) other than LGS, refer to the movement range of a stage described in each 

instruction manual. 
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32mm dimater specimen holder （X and Y axes movable range） 

○： Movable with whole range (X=0 to 80mm and Y= 0 to 40mm) 
×： Not movable regardless of position of X and Y axes 

Z (mm) 

T (°) 
8 10 15 20 30 40 48 

0 ○ ○ ○ ○ ○ ○ ○ 
10 ○ ○ ○ ○ ○ ○ ○ 
20 ○ ○ ○ ○ ○ ○ ○ 

30 X=0 to 80 

Y=0 to 6 
○ ○ ○ ○ ○ ○ 

40 X=7 to 80 

Y=0 to 6 

X=7 to 80 

Y=0 to 7 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=10 to 40 

50 X=7 to 80 

Y=0 to 4 

X=7 to 80 

Y=0 to 6 

X=7 to 80 

Y=0 to 13 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=10 to 40 

60 X=7 to 80 

Y=0 to 6 

X=7 to 80 

Y=0 to 8 

X=7 to 80 

Y=0 to 14 

X=7 to 80 

Y=0 to 17 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=0 to 40 

X=7 to 80 

Y=10 to 40 

70 × × 
X=8 to 80 

Y=0 to 10 

X=8 to 80 

Y=0 to 18 

X=8 to 80 

Y=0 to 26 

X=8 to 80 

Y=0 to 40 

X=8 to 80 

Y=10 to 40 

80 × × × 
X=8 to 80 

Y=0 to 3 

X=8 to 80 

Y=0 to 15 

X=8 to 80 

Y=5 to 40 

X=7 to 80 

Y=10 to 40 

90 × × × × 
X=8 to 80 

Y=0 to 7 

X=8 to 80 

Y=0 to 17 

X=7 to 80 

Y=10 to 40 

When the stage is set in accordance with the table, the distance between the bottom of OL (objective lens) and the 
specimen holder surface is coming to be kept to 3 to 5mm. 

 
 

Limit range of Tilt 

 
Holder size 

Z (mm) 
10mmφ 32mmφ 76mmφ 

8 0° to 20° 0° to 20° 0°to 20° 

10 －2° to 30° －2° to 30° 0° to 20° 

15 －10° to 35° －10° to 35° －2° to 35° 

20 －10° to 35° －10° to 35° －10° to 35° 

 
When the specimen holder except the above followings is used, see to the instruction manual of an optional specimen 
holder to move the stage. 
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2.2.3.b Moving an image on the screen 

 
If you change the WD using the Z axis knob, the visual field on the image rotates, and the shift direction 
differs slightly. 
 

A Y-direction is moved in the WD 10mm neighborhood through the X direction to top and bottom 
right and left. 
It is taken in becoming shorter WD (8mm direction) than WD10mm, and view turns…to the 
counterclockwise direction a little. 
It is taken in becoming longer WD (48mm direction) than WD10mm, and view turns…to the 
clockwise direction a little. 

 
 
 

 

 
 

   
 
 WD5mm direction WD10mm neighborhood  WD48mm direction 

 

5mm dirction 

Z axis knob 

X 

Y 
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2.2.4 Main control panel 

 

  
 

 
 
 

 Name Explanation Remarks 

1 MAIN POWER key 
switch 

Key switch used to set the status of the main power supply 
to OFF (○) or ON (I) 

 

2 VACUUM MODE LV Switch used for changing over the active data display HV or 
LV. 
When this switch is ON (switch lamp is lit), the Vac. mode is 
set to LV.  When this switch is OFF, the Vac. mode is set 
to HV. 

It is effective with 6510LV／
LA.  

3 SPECIMEN CHAMBER 
VENT 

Switch used for the specimen chamber and the electron 
optical column to atmosphere. 
When this switch is pressed for vent, the switch lamp 
flashes.  When the specimen chamber and electron 
optical column becomes atmosphere pressure, the VENT 
switch lamp lights. 

 

4 SPECIMEN CHAMBER 
EVAC 

Switch used for evacuating the specimen chamber and the 
electron optical column. 
When this switch is pressed for evac, the switch lamp 
flashes.  When the evacuation is completed, the switch 
lamp lights. 

 

5 AIRLOCK CHAMBER 
ALC 
 

Switch used for evacuating the airlock chamber 
It is effective when opening the GUI 

It is effective with airlock 
chamber is attached 

 
 

1 

2 3 4 5 
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2.2.5 Rear panel 

 
 

  
 
 
 
 

Name Explanation Remarks 

AC100V 8A Service outlet  
MAIN BLAKER The blaker shut down the power suuply when an 

overcurrent flows in the system.  
 
CAUTION ! 

Only use the circuit braker in cases of emergencies If the 
Braker trips, it indicates a malfunction in the system and 
you must contact the JEOL service center immediately. 
 
 

Use the braker in case of 
emergencies. 

VIDEO CH1 Connect to CH1 on the Video Capture Card of the PC. 
 

For displaying the Upper-side of the 
Sub screen of the SEM-GUI 

 CH2 Connect to CH2 on the Video Capture Card of the PC. 
 

For displaying the Lower-side of the 
Sub screen of the SEM-GUI 

 CH3 Connect to CH3 on the Video Capture Card of the PC. 
 

For displaying the SEM-GUI Main 
screen 

   

 
Rear side of the PC 

 

 

RS232C   
ETHERNET Connect to the LAN Card of the PC.  

 

AC 100V 8A 

VIDEO

RS232C

ETHERNET

MAIN BLAKER

CH1 CH2 CH3 



2.  Name and explanation of each part 

____________________________________________________________________  2-11

2.3 OPERATION KEYBOARD（OKB） 
 

 

 
 

 Name Explanation 

X and Y knobs Correct the astigmatism of the image using the X and Y knobs. 
The X knob corrects astigmatism X, and the Y knob corrects astigmatism Y 

1 STIGMA 

AUTO switch When this switch is ON (green), Auto stigma starts and stigmator corrected of 
astigmatism image appears for a several second later. 

2 MAGNIFICATION  MAGNIFICATION knob The magnification changes. 
Turning this knob counterclockwise lowers the magnification, while turning it 
clockwise raises the magnification. 

COARSE switch,  
FOCUS knob 

Adjusting the image focus  
When the COARSE switch is ON, you can carry out rough focusing using the 
FOCUS knob. 
When the COARSE switch is OFF, you can carry out fine focusing using the 
FOCUS knob. 
Tuning the FOCUS knob counterclockwise results in under-focusing, and 
turning it clockwise results in over-focusing.  

3 FOCUS 

AUTO switch When this switch is ON (green), Auto focus starts and focused image appears 
for a several second later.  

ACB  When this switch is ON (green), ACB (auto contrast and brightness) starts and 
optimum image of contrast and brightness appears for a several second later. 

4 

PHOTO  When this switch is ON (green), perform the acquisition action of the image is 
performed.  
It is possible to save automatically when Auto Save has been checked with 
Setup –Scan and AutoSave".  

If you press the PHOTO switch, click  (on the GUI) 
during saving the image, it is canceled. 

CONTRAST knob Adjusting the image contrast 
Turning this knob counterclockwise reduces the contrast, and turning it 
clockwise increases the contrast. 

5 IMAGE 

BRIGHTNESS knob Adjusting the image brightness 
Turning this knob counterclockwise makes the image dark, and turning it 
clockwise makes the image bright. 

 
 

1

2

3

4

5
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Explanation of GUI 
 
 
 

 
 
 

3.1 Main window････････････････････････････････ 3-1 

3.2 Menu bar ･･････････････････････････････････ 3-2 
3.2.1 File··················································································· 3-2 
3.2.2 Edit ·················································································· 3-3 
3.2.3 Screen ·············································································· 3-4 
3.2.4 Tools ················································································ 3-5 
3.2.5 Image ··············································································· 3-7 
3.2.6 Analysis ············································································ 3-8 
3.2.7 Help ················································································· 3-9 

3.3 Icon area ･････････････････････････････････ 3-10 
3.3.1 Fixation icons ····································································3-10 
3.3.2 Custmaize icon list······························································3-11 

3.4 Image area ････････････････････････････････ 3-14 
3.4.1 Selection of the screen ························································3-14 

3.4.1.a Standard Live Image ······························································· 3-14 
3.4.1.b Dual Screen Live Image ··························································· 3-15 
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3.1 Main window 
 

 

 

No. Items Explanation 

1 Title bar Click the  button, the GUI size can minimized. 

Click the  button, the exit message appears and the GUI can be closed. 

＊  Gray-out display always, it is not possible to use it. 
2 Menu bar The pull down menu of the various functions are arranged. 

3 Icon area HT ON／OFF、Scan mode changing buttons and etc. are arranged. 

4 Image adjustment button Manual adjusting buttons and magnification changing buttons are arranged. 
Adjust the image contrast and brightness, focus manually, and switches the magnification. 

5 Image area Left screen：A live image or freeze image of 640×480 pixels is displayed 
Right screen：A live image (freeze image) of 640×480 pixels, four-freeze image of 320×240 
pixels are displayed. And, various indications are possible depending on the other display mode. 

6 Operation navigation area The operation navigation and operation panel appears depending on the menu selection button. 

7 Vacuum control panel Vacuum sytem is controlled on this panel.  

8 Operation navigation  A navigation and menu of the various operations are displayed by opening the operation menu 
tab. 

9 Operation menu tab User Login, Sample Setting, Recipe, Stage (If motorized stage is installed), Image list, Setup, 
Maintenance 

 

1 
2

3 

4 

5 

6 

7 

8

9

5
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3.2 Menu bar 

3.2.1 File 

 

 
 
 

Open Image File 
Image opening window opens. 

 
Save Image File 

Image saving window opens. 
 

Report 
Starts the DTP program software. (For details, refer to the Chapter 4_4.21.1) 

 
SMile View （An optional Smile View is necessary.） 

Smile View is the software for displaying the index image of image data on the personal computer for 
easy layout and printing. (For details, refer to the Chapter 4_4.21.2) 

 
Smile Station （An optional Smile Station is necessary.） 

The program has a wide-area navigation function which can move the stage (an optional motorized  
stage is necessary) so that the position specified on the navigation image comes to the observation 
center. 

 
Movie 

The recording/playing of a live image is possible. 
 

Add Recipe File 
Open the Add Recipe File window. (For details, refer to the 3.5.4.b) 
An observation condition can be saved to the Recipe file. 

 
Exit JEOL Scanning Electron Microscope  

The end procedure of the instrument is displayed. 
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3.2.2 Edit 

 

 
 

Image Clip  
You can copy an image to the Windows clipboard. Then you can paste the image into an application such 
as Word.  
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3.2.3 Screen 

 

 
 

Standard Live Image 
The image area is changes to standard (Left：one、Right：4-division) 

 
Dual Screen Live Image 

The image area is changes to dual screen (Left：one、Right：one). 
 

Full Screen Live Image 
Displays the enlarged live image at the full size of the monitor. The image area is changed to enlarged 
image at the full size 

 
Dual Live Image 

A same field of a live image can be shown with two different signals. 
 
LR The image area is changed to DualLive-Left/Right 
UD The image area is changed to DualLive-Up/Down 

 
 

Split Live Image 
Splits one field of view, a live image can be displayed with two different signals. It is possible to change 
the division range. 

 
LR The image area is changed to SplitLive-Left/Right 
UD The image area is changed to SplitLive-Up/Down 

 
 

Flexible Window Image 
An arbitrary rectangle area is placed within the main screen, and the rectangle area can be displayed by 
another signal. It is possible to change the position and a size of the rectangle area. 

 
Signal Mix Image 

The image which mixed two kinds of signals is displayed on the main screen. 
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3.2.4 Tools 

 

 
 

Beam Blank 
Activates the Beam Blank. 
When the Beam Blank is activated, the specimen is not irradiated by the electron beam, and specimen 
damage is prevented. 

 When a Freeze image is displayed, the Beam Blank is activated automatically to prevent specimen 
damage. The Beam Blank automatically cancels when a live image is displayed. 

 
OL Wobbler 

To adjust the OL (objective lens) aperture, the OL current is changed periodically. If the electron beam 
deviates from the optical axis, the image oscillates in any direction with high amplitude. 

 
Lens Reset 

Activates Lens Reset to remove the hysteresis of the lens to ensure optimum operation condition of the 
SEM.  (It is not necessary by the usual observation) 

 
Stigma Reset 

Sets the stored astigmatism condition (the factory installed optimum condition). Use it in case that the 
image drifts diagonally even if the focus is properly adjusted.   

 
Tilt Correction 

Opens the Tilt Correction menu. (For details, refer to the Chapter 4_4.12) 
This menu is used to correct focus (Dynamic focus) and the magnification (Mag correction) when the 
specimen is tilted. 

 
Auto Focus Tracer 

Automatically focusing the image when the Z-axis of the stage (only when the motorized stage is 
installed) is moved 
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Scaler 
Opens the scaler menu.  
A “distance between the two points”, “angle”, etc. can be measured. The measured data is pasted on the 
image. 

 
 

Neutralizer 
It is effective in reducing halation (the image be veiled in haze of white) of the image. 

 
 

Scan Rotation (An optional Scan Rotation is necessary) 
Opens the Scan Rotation menu. (For details, refer to the Chapter 4_4.13) 
Rotates the image by rotating the scan direction.  

 
 

Stereo Pair 
Opens the Stereo Pair menu. (For details, refer to the Chapter 4_4.14) 
You can save two images in the same field of view at a different angle. For creating and analyzing 
three-dimension images, please refer to the user manual of THREE-DIMENSION IMAGE SOFTWARE 

 
 

Probe Current Detector （An optional Probe Current Detector is necessary） 
This detector (PCD) is used to measure the irradiation electron beam current. 

 
 
 

Chamber Scope （An optional Chamber Scope is necessary） 
Activates the chamber scope (color CCD camera) and enables you to observe inside the specimen 
chamber. 
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3.2.5 Image 

 

 
 
 

Look-up Table／PseudoColor 
The brightness of the freeze image on the main screen can be corrected by the grey level data. 

 
 

Quad Screen 
The main screen is divided to four and it can synthesize four image files. 

 
 

Dual Screen 
The main screen is divided to two and it can synthesize two image files. 

 
 

Digital Zoom 
It is possible to display by expanding a part of the frozen image. 

 
 

Dual Magnification 
It is possible to display it on the right-side screen by expanding a part of the frozen image. 
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3.2.6 Analysis 

 
（Standard built-in：JSM-6510A, JSM-6510LA） 

 
 

Acquisition Condition 
Displays the Acquisition Condition menu. 

 
 

Periodic Table 
Displays the Periodi Table. 

 
 

Send Image to Analysis Station 
A live image or a freeze image is sent to the Analysis Sation (software for analyzing). 

 
 

X-ray Mapping 
Performs all the elements mappling in the whole area of the image display area. 

 
 

Sequential Analysis 
Perform sequentially the spectrum acquisition of the point reserved with Spot analysis or Area 

analysis. 
 
 

Clear Analysis History 
Erases the cross-marker, line or rectangle area, which show an analysis position 

 
 



3. Explanation of GUI 

____________________________________________________________________  3-9

3.2.7 Help 

 

 
 
Contents 

Opens the PC-SEM Help window. 
 

About 
Opens the SEM program version information window. 
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3.3 Icon area 

3.3.1 Fixation icons 

 
Items Icon Explanation 

 

Observation is being prepareted（except HT Ready）It is not possible to accept 

 

Image observation is possible （HT Ready） 

When you left-click  at this icon, the HT is turned ON and image can 

be observed. 

HT 

 

Image is being observed（HT ON） 

When you left-click  at this icon, the HT is turned OFF. 

＊ Scan1 

 

This button is suitable to adjust the image quality. 

＊ Scan 2 

 

This button is suitable to search for field of view. 
 

＊ Scan 3 

 

This button is suitable to check the image quality and to observe the detail. 

＊ Scan 4 

 

This button is suitable to observe and acquire the precise image. 
 

＊ Photo 

 

This button is suitable to acquire the checked image and to save the image 
automatically.  
＊ The image quality cannot be adjusted. 

Freeze 

 

An observation image becomes the freeze image. 

ACB 

 

Click this button to carry out the automatic contrast/brightness adjustment. 

AF 

 

Click this button to carry out the automatic focusing 

AS 

 

Click this button to carry out the automatic astigmatism correction 

 
 
 
 
 

＊ If you click one of any scan icons while pressing the right mouse button , a pop-up menu is displayed and 

you can change the scan speed.（except ） 



3. Explanation of GUI 

____________________________________________________________________  3-11

3.3.2 Custmaize icon list 

 
 
 

Command Icon Explanation 

Save Movie 

 

Opens the Movie record menu. 

OL Wobbler 

 

To adjust the OL (Objective Lens) aperture, the OL current is changed 
periodically. If the electron beam deviates from the optical axis, the image 
oscillates in any deirection with high amplitude. 

Beam Blank 

 

Activates the Beam Blank. 
When the Beam Blank is activated, thespecimen is not irradiated by the electron 
beam, and specimen damage is prevented. When Freeze image is displayed, the 
Beam Blank is activated automatically toprevent specimen damage. 

Stigma Reset 

 

Sets the stored astigmatism condition (the factory installed optimum condition). 
Use it in case that the image drifts diagonally even if the focus is adjusted 
properly 

Lens Reset 

 

Activates Lens Reset to remove thehysteresis of the lens to ensure optimum 
operation condition of the SEM. 
It is not necessary by the usual observation 

Image Shift Reset 

 

Brings the image to the center of the electrical Shift. 

Neutralizer 

 

Neutral is effective in reducing the effect of detector saturation (the image veiled 
in white). It can only be used for “SEI” signals. Neutral cannot be activated in 
case of “REF” signal mode or Low Vacuum mode “LV” 

Open Image File 

 

Opens the Open window (adhere to Windows). 

Save Image File 

 

Opens the Save window (adhere toWindows). 

Add Recipe file 

 

Opens the Add Recipe File window 

Standard live image 

 

Click this button to change to the standard screen. （Left：one、Right：4-division） 

Dual screen live 
image 

 

Click this button to change to the dual screen. （Left：one、Right：one） 

Full Screen Live 
Image 

 

Displays the enlarged live image at the full size of the monitor. 

Stereo pair 

 

Open the Stereo Pair menu  

Tilt correction 

 

Opens the Tilt Correction menu. 

Send the current 
image to EDS 

 

Sends a live image or a Freeze image to the Analysis Station. 

X-ray Mapping 
 

Performs the All Elements Mapping in the whole area of the displayed image. 

Sequential Analysis 
 

Opens the Sequential Analysis dialog. 
This is used when Spot Analysis and Area Analysis is sequentially 
carried out. 

 



3.  Explanation of GUI 

 ____________________________________________________________________ 3-12

 
Command Icon Explanation 

Dual Live Image 
(Right/Left) 

 

Displays the Dual Live image (Right / Left).. 

Dual Live Image 
(Top/Bottom) 

 

Displays the Dual Live image (Top / Bottom). 

Split Live Image 
(Right/Left) 

 

Displays the Split Live image (Right /Left). 

Split Live Image 
(Top/Bottom) 

 

Displays the Split Live image (Top /Bottom). 

Flexible Window 
Image 

 

Displays the Flexible Window image 

Signal Mix Image 
 

Opens the Mix Image window. 

Scaler 
 

Opens the Scaler menu. 

Look-up 
Table/Pseudo Color 

 

Opens the Look-up Table window. 

Dual Screen 
 

Opens the Dual Screen menu. 

Quad Screen 
 

Opens the Quad Screen menu. 

Digital Zoom 
 

Open the Digital Zoom menu. 

Dual Magnification 
 

Opens the Dual Magnification menu. 

Report 

 

Starts the DTP program software, and opens the DTP window. 

 
Report 
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Attachments 
 

Items Icons Explanation 

Probe Current Detector 

 

PCD is used to measure the irradiation electron beam current. 
PCD is useful for X-ray analysis (EDS / WDS), where it is essential to regulate the 
beam current to reproduce a specific condition. 

Chamber Scope 

 

Activates the Chamber Scope. 

Scan Rotation 

 

Opens the Scan Rotation menu. 

SMV 

 

Starts the Smile View program. 

SMS 

 

Starts the SMile Station program. 

Frame Shift 

 

The image can be moved by a specified fraction of the field (10 to 100, 200 
percents). 
If 50% is specified as the frame moving range, the field of view will move half way, 
and if 100% is specified, it will fully move to the adjacent field. 
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3.4 Image area 

3.4.1 Selection of the screen 

3.4.1.a Standard Live Image 

Click the Std. Icon , or select menu bar Screen ⇒ Standard Live Image. 

 

 
 
 

Items Explanation 

Main screen Display size：640×480 dots（one image） 
The observation image（Live or Freeze image）is displayed 

Sub screen Display size：320×240 dots（four images） 
The motor drive stage can control with the image file and/or snap shot image. 
＊ Displays only frozen image 

 
 

Main screen

Sub screen 
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3.4.1.b Dual Screen Live Image 

 

Click the Dual icon , or select menu bar Screen ⇒ Dual Screen Live Image. 

 
 
 

 
 
 
 

Items Explanation 

Screen1 Display size：640×480 dots（one image） 
The observation image（Live or Freeze image）and/or image file is displayed 

Screen 2 Display size：640×480 dots（one image） 
The observation image（Live or Freeze image）and/or image file is displayed 

Screen selection frame The active screen is displayed with the blue frame.  
The operation of the image adjustment (contrast, brightness, etc.) can be performed 
only on the active screen. 
By clicking the screen having no frame, the clicked screen becomes active. 

Freeze Icon Screen 1 and Screen 2 become Freeze at the same time by clicking the Freeze icon.  
When the Freeze is released, both screens are simultaneously released. 
When the Screen 2 is Freeze beforehand, only Screen1 becomes Freeze. 

Freeze button By clicking the Freeze button, a live image or a Freezel image is displayed alternately 
in the Screen 2 only. 
The Freeze button can be used when you select the Screen 2 

 
 

In case of “Dual screen Live Image”, you cannot use a “Scan1”, “Wobbler”, “Edit” and “Image”.   

Freeze icon
Freeze button 

SEI BEI

Signal name 

Screen 1 Screen 2 

Screen selection frame
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3.4.1.c Dual Live Image 

 

Click the split live icon  (left/right)／  (top/bottom) or select Menu bar Screen ⇒ 

Dual Live Image ⇒ LR／UD 
 

  
 
 
 

Items Explanation 

Screen1 Display size：320×480 pixels（Horizontal division） 
Display size：640×240 pixels（Vertical division） 
The observation image（Live or Freeze image）and/or image file is displayed 

Screen2 Display size：320×480 pixels（Horizontal division） 
Display size：640×240 pixels（Vertical division） 
The observation image（Live or Freeze image）and/or image file is displayed 

Screen selection frame The active screen is displayed with the blue frame.  
The operation of the image adjustment (contrast, brightness, etc.) can be performed only 
on the active screen. 
By clicking the screen having no frame, the clicked screen becomes active. 

 
 

Screen 1
Screen 1 

Screen 2 

Screen 2
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3.4.1.d Split Live Image 

 

Click the split live icon  (left/right)／  (top/bottom), or select Menu bar Screen ⇒ 

Split Live Image ⇒ LR／UD. 
 

  

 
 
 

Items Explanation 

Display method When you change the screen to Split Live Image from the Standard Live Image； 
Screen1：The present signal on the main screen (Standard Live Image) is displayed 
Screen2：Display a previous signal. 
＊Default：SEI-SEI 

Screen selection frame The active screen is displayed with the blue frame.  
The operation of the image adjustment (contrast, brightness, etc.) can be performed only 
on the active screen. 
By clicking the screen having no frame, the clicked screen becomes active. 

Horizontal division By dragging the blue frame, you can change the frame rate. 
Vertical division By dragging the blue frame, you can change the frame rate. 

 
 

Screen 1
Screen 1

Screen 2

Screen 2 
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3.4.1.e Flexible Window Image 

 

Click the Flexible window icon , or select Menu bar Screen ⇒ Flexible Window Image. 

 

 
 
 

Items Explanation 

Display method When you change the screen to Flexible Window Image from the Standard 

Live Image； 
Screen1：The present signal on the main screen (Standard Live Image) is displayed 
Screen2：Display a previous signal. 
＊Default：SEI-SEI 

Screen selection frame Displays the active screen with the blue frame.  
The operation of the image adjustment (contrast, brightness, etc.) can be performed 
only on the active screen. 
By clicking the screen having no frame, the clicked screen becomes active. 

Changing a frame rate By dragging and dropping the edge of the blue frame, you can change the frame rate. 
Moving a frame position The frame can move anywhere in the main screen by dragging. 

＊ The motorized stage cannot be moved within the frame ( screen2 ) by dragging. 

 

Screen 1

Screen 2 
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3.4.1.f Signal Mixing Image 

 

Click the Mix icon , or select Menu bar Screen ⇒ Signal Mixing Image. 

 
 
 
 

 
 
 

Items Explanation 

Signal mixing screen Display size：640×480 pixels（one image） 
The observation image（Live or Freeze image）is dispayed 

Signal 1 screen Display size：320×240 pixels 
The observation image（Live image）is dispayed 

Signal 2 screen Display size：320×240 pixels 
The observation image（Live image）is dispayed 

Screen selection frame The active screen is displayed with the blue frame.  
The operation of the image adjustment (contrast, brightness, etc.) can be performed 
only on the active screen. 
By clicking the screen having no frame, the clicked screen becomes active. 

Signal1 Changing the signal to display is possible. 
Signal2 Changing the signal to display is possible. 
Scroll bar Changing the mixture rate is possible using the scroll bar. 

Memorizes the previous mixture rate.  

 
 

Signal 2 screen 

Signal 2 screen （blue frame：selection screen） 

Operation panel 

Mix display screen 
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3.4.2 Image adjustment button 

 
Adjusts the image quality and focus, etc. 

 

 
 
 

Items Icon Explanation 

Contrast 

 

Adjusts the image contrast manually. 

Rough (Fine) adjustment is possible by dragging the right (left) 
mouse button on the image. 

Brightness 

 

Adjusts the image brightness manually. 

Rough (Fine) adjustment is possible by dragging the mouse right 
(left) button on the image. 

Focus 

 

Adjusts the image focusing manually. 

Rough (Fine) adjustment is possible by dragging the right (left) 
mouse button on the image. 

StigmaX, StigmaY 

 

Adjusts the image stigmatism manually. 

Rough (Fine) adjustment is possible by dragging the right (left) 
mouse button on the image. 

Mag － 

 

When the left mouse button is clicked once, the magnification 
decreases by one step.  

When keep pressing it, the magnification increases until the lowest 
magnification. 

Mag ＋ 

 

When the left mouse button is clicked once, the magnification 
increases by one step.  

When keep pressing it, the magnification increases until the highest 
magnification. 

Preset 
Magnification 

 

The present magnification switches to the "Preset magnification" by 
clicking the button. 

The "Preset magnification" can be changed by using the Setting in 
the Operation menu tab. 

 
 



3. Explanation of GUI 

____________________________________________________________________  3-21

3.4.3 Image data display 

 
The image data can be displayed on the bottom of the main screen shown to the below. The ON/OFF of 
the image data and the background of the image data can perform by the Setup of the operation 
navigation area. 

 

 
 

 
Items Explanation 

SEI The detected signal is displayed, and it changes by changing the signal. 
 

Signal  Data display 

SEI SEI（Secondary electron image） 
BEC（Backscattered electron – composition image） 
BET（Backscattered electron – Topographic image） 

BEIW 

BES（Backscattered electron – shadow image） 
LVSE LVSE（Low vacuum secondary electron image） 
EMF EMF（Electromotive force image） 
CLD CLI（Cathodeluminescence image） 
CLDIR CLI 
AUX AUX 
REF REF（Refrected electron mage） 
Dual DLI（Dual image） 
Split SPI（Split image） 
Flexible FXI（Flexible window image） 
Signal mixture MIX（The mixture image of two kind of signals）  

30kV The accelerating voltage is displayed. (It changes depending on the selected accelerating 
voltage) 

WD8mm The WD (working distance) is displayed by converting the Objective lens current.  
( It changes depending on the focusing value) 

SS30 The Spot size is displayed. (It changes by increasing or decreasing the spot size value.) 
30Pa The specimen chamber pressure is displayed. (It changes by setting the pressure.) 

＊ The specimen chamber pressure is displayed only when the vacuum mode was set to Low 
Vacuum mode. 

×10,000 The magnification is displayed. (It changes by enlarging or reducing the magnification.) 
Micron value and micron marker 

 

The bar and the distance value corresponding to a present magnification are displayed.  
(It changes by increasing or decreasing the magnification.)  
＊ Micron bar: It can be displayed on the screen by dragging it with the left mouse button 
click, and it will turn out if you release the button. 

Sample The label entered by Setup in the Operation menu tab is displayed.   
0000 The number of counter entered by Setup in the Operation menu tab is displayed. 
16 Jan 2009  The current day/month/year are displayed. 

 

30Pa
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3.4.4 Right-click menu 

3.4.4.a Main screen 

 
 

When you click the right mouse button  in the main screen, the pop-up menu appears. 

 
 

 
 
 

Items Explnation 

Spot Analysis The spot analysis on the position where the right mouse is clicked on the image can be performed.  
 (For A/LA model) 

Line Analysis The line analysis analysis on the position where the right mouse is clicked on the image can be 
performed.  (For A/LA model) 

Reserve a spot analysis The reservation on the positions where the right mouse is clicked on the image can be performed.  
 (For A/LA model) 

Image Shift Reset The image can be returned to the original position after being moved. 
Center Zoom ON/OFF Switchs the function to Click center or Click center zoom. 
Frame Shift ON/OFF Switches the function to Frame shift or Image shift. 

Frame Step 
The image can be moved by a specified fraction of the filed (10 to 100, 200 percents). 
If 50% is specified as the frame moving amount, the field of view will move half way, and if 100% is 
specified, it will move all way to the adjacent field. 
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3.4.4.b Sub-screen 

 

If you click the right mouse button  in the sub-screen at the “Standard Live Image” , the pop-up 

menu will appear.  
 

 
 
 

Items Explnation 

Snap shot 
The image of the main screen is displayed on the sub-screen as a snap shot image. 
The motorized stage can control using the frozen image.  

Open Image File Displays the “File Open window”. 
Save Image File Displays the “Save as window”. 
Clear Marker The specified marker on the snap shot screen is cleared. 
Clear All An all image on the snap shot screen is deleted. 

 
 
 

SnapShot screen 
 
 

 
 
 

Items Explanation 

Right-click,  
Snapshot button 

If you select the Snap Shot in the pop-up menu or click the “Snapshot” button, the sub 
screen image will display the image on the main screen as a snap shot image. 
＊ Snap shot function cannot be used with the Scan1 

 
 

Snap1 Snap2 

Snap 3 Snap4 

Snapshot button
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3.4.5 Right-dragging menu 

 
 

If you drag in the main screen with the right mouse button, the rectangle frame will be drawn and a 

pop-up menu will appear.  (It is effective when an EDS is installed) 
 
 
 

 

 

Items Explanation 

Area analysis The area analysis of the rectangle area drawn by dragging the right mouse button can be performed. 
Reserve an area analysis. The reservation of the rectangle area drawn by dragging the right mouse button can be performed. 
Zoom The image in the rectangle area is moved to the center of the image display area, and it can be displayed 

with full size 
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3.5 Operation navigation 

3.5.1 Vacuum menu 

 
The vacuum control menu is always displayed.  

 

 
 
 

Items Explanation 

Draw Out Click the Draw Out button to switch the evacuation control at the draw out. 
Airlock Click the Airlock button to switch the evacuation control at the airclok. 

＊ An optional ALC/ALS is necessary. 
Vacuum status display Displays the vacuum status in the specimen chamber. 
VENT Click the VENT button to start the venting the specimen chamber. 

During VENT：The button lights flashing.（button color：orange） 
After VENT is ended：The button lights.（button color：orange） 

EVAC Click the EVAC button to start the evacuating the specimen chamber  
After EVAC is ended： The button lights.（button color：green） 

 When you click the VENT／EVAC button, the message dialog is displayed.  
Click the OK button to start the vacuum operation.  
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Items Explanation 

High Vacuum When you click the High Vacuum button, the message dialog is displayed.  
Click the OK button to set the vacuum mode to High Vacuum.  

Low Vaccum When you click the Low Vacuum button, the message dialog is displayed. 
Click the OK button to set the vacuum mode to Low Vacuum.  

Vacuum Mode The following operation menus can be used by switching the vacuum mode to the low  
vacuum mode.（It is effective with LV／LA model） 

Pressure adjustment 
 button： The pressure value decreases（specimen chamber pressure 

goes low） 

 button： The pressure value increases（specimen chamber pressure 

goes high） 
Combo box 10 - 270Pa（5Pa step：10 - 130Pa、10Pa step：130 - 270Pa） 

When you select a desired pressure in the combo box, the pressure adjustment is 
performed automatically. 
The pressure value to use well is displayed on the first. 
＊ Default value：30,50,70,100Pa 

Srart Select a desired pressure in the combo box, and click the Start button.  
The pressure adjustment is started. 

Stop Click the Stop button to stop the pressure adjustment. 
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3.5.2 User Login 

 
 
 
 

 
 

 
 

Items Operation/Explanation 

Log on/Log off 
Displays the operation menu of the “Logon/Logoff”. 
The operation menu of the “Logon” is displayed when starting the SEM program.  

Add User File Displays the operation menu of “Add User File”. 
Delete User file Displays the operation menu of “Delete User File”. 
Edit User File Displays the operation menu of the “Rename User File”. 
Backup User File Displays the operation menu of the “Backup User File”. 

Menu button 

Install User File Displays the operation menu of the “Install User File”. 
User list The registered user name is displayed. Log on 

Log on Select the user name from the user list and click the Log On button 
User logged on Displays the “User logged on” Log off 

Log off Check the user name and click the Log Off button.  
A message of “ Do you really want to log off ? ” is displayed, and click the OK button. 

User Name Enter the user name. Add User File 

Add A new user is registered by clicking the Add button, and the “User Login” operation 
navigation closes. 

Menu button
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Items Operation/Explanation 

User list The saved user list is displayed. 
Click the user name to delete from the combo box. 

Delete User File 

Delete The selected user is deleted by clicking the Delete button. 

User list The saved user is displayed.  
Click the user name to edit from the combo box.  

New User Name Enter a new user name. 

Edit User File 

Rename The user name is changed to a new name by clicking the Rename button. 

Refer The destination of the media and the directory is displayed by clicking Refer button. Backup User File 

Backup The user file is saved to the specified media by clicking the Backup button.  

Refer The destination of the media and the directory is displayed by clicking the Refer button. Install User File 

Install The user file is installed to the PC by clicking the Install button.  

 



3. Explanation of GUI 

____________________________________________________________________  3-29

3.5.3 Sample setting 

 

 
 
 
 

Items Operation/Explanation 

Removing the specimen The “ Removing the specimen ” procedure is displayed by clicking the Removing the 

specimen button. 
Setting The setting the specimen procedure is displayed by clicking the Setting button. 
Navigation The “Navigation Image Acquisition” procedure is displayed by clicking the Navigation 

button. The Stage Navigation System will start.  
＊ An optional motorized stage and SNS are necessary. 

Choose a recipe The “ Choose a recipe “ is is displayed by clicking the Choose a recipe bottun. 

Operation flow 
button 
(For draw out) 
 

Evacuating the chamber The “Evacuating the specimen chamber” procedure is displayed by clicking the 
Evacuating the specimen chamber button.  

Removing the specimen The “Removing the specimen” procedure is displayed by clicking the Removing the 

specimen button. 
Evacuating the chamber The “Evacuating the specoimen chamber” procedure is displayed by clicking the 

Evacuating the specimen chamber button. 

Operation flow 
button 
(For airlock) 

Choose a recipe The “ Choose a recipe “ is is displayed by clicking the Choose a recipe bottun. 
Standard Completely venting the specimen chamber. ＊ Bu／A model：gary-out Removing the 

specimen 
VENT 
Mode 

Slow Gradually venting the specimen chamber. Use a “Slow” for samples such as powders 
which are easily scattered.＊ Bu／A model：gary-out 

 VENT Click the VENT button to start the venting in the specimen chamber. 
During VENT：The button flasing lights.（button color：orange） 
After VENT is ended：The button lights.（button color：orange） 
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Items Operation/Explanation 

Holder selection The specmen hlder is selected by clicking the holder graphic display. 
The holder graphic display scrolls using the slide bar.  
 
Kind of holder： 
10mm dia. (10mm dia.×5mmh or 10mmh) 
32mm dia. (32mm dia.×5mmh or 10mmh) 
51mm dia. (51mm dia.×5mmh or 10mmh)、 
76mm dia. (76mm dia.×5mmh or 10mmh)、 
SEMpore32mm dia. 
SEMpore51mm dia. 
Wafer 102mm dia. 
127mm dia. 
152mm dia. 
SHX 
 
＊ When an optional motor drive stage is installed 

Setting 

Enter the protruding 
height 

When the specimen protrudes above the holder top, make sure to input the 
specimen protruding height. The stage moving range ( Z axis ) is calculated 
automatically base on this input. This can prevent the specimen from contacting the 
detector, or other components. 
 
Example)  

If you input 20mm as a protruding height, the Z axis moving range displays from 
WD5mm to WD28mm, and the actual Z axis can be moved between 25mm and 
48mm. 
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Items Operation/Explanation 

Capture The navigation image is displayed on the navigation screen by clicking the Capture 
button.  
Also, the navigation image is displayed at the stage of the operation navigation area 
in the Stage tub. 
If you click the Capture button while the navigation image is displayed, the previous 
image is replaced to the captured image. 

Capture position Stage type： 
2-axes (X, Y)：X=Automatic、Y= Automatic、Z=10mm、T=0° 、R=0° 
3-axes (X, Y, R)：X= Automatic、Y= Automatic、Z=10mm、T=0° 、R= Automatic 
3-axes (X, Y, Z)：X= Automatic、Y= Automatic、Z= Automatic 、T=0° 、R=0° 
5-axes (X, Y, R, T, Z)：X= Automatic、Y= Automatic、Z= Automatic 、T= Automatic、
R= Automatic 

Save The navigation image can be saved by clicking the Save button.  

Navigation 

Display The navigation image is displayed at color on the main screen.  
Choose a recipe  Refer to the “3.5.4 Recipe” 

Starts the evacuation in the specimen chamber by clicking the EVAC button. 
During EVAC：The button flashing lights.（color：green） 
After EVAC is ended：The button lights（color：green） 

EVAC 

□ The image appears automatically after complete evacuation 
Tick：The image appears automatically after complete evacuation 
Non-tick：After complete evacuation, HT keeps OFF and the image does not appear. 
High Vacuum Mode 
A message appears by selecting High Vacuum Mode. The vacuum mode is 
switched to “High vacuum” by clicking the OK button in the message. 
＊ BU／A model：gray-out 

Evacuating the chamber 

Vac Mode 

Low Vacuum Mode 
A message appears by selecting Low Vacuum Mode. The vacuum mode is 
switched to “Low vacuum” by clicking the OK button in the message. 
＊ BU／A model：gray-out 
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3.5.4 Recipe 

 
 

 

 
 
 

Items Operation/Explanation 

Standard Recipe The list of the standard recipe is displayed.  Recipe Selection 

Customize Recipe The list of the custom recipe is displayed. 
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3.5.4.a Standard 

 
When you observe a sample to observe for the first time, and the sample which do not understand the 
observation condition, the "Standard" can set automatically to the most suitable observation condition by 
only selecting the type of the sample. 

 

 

 

 

 
 

Items Operation/Explanation 

Thumbnail list 
 

The image is displayed according to the specimen classification. 
Metal/Mineral, Organic（Textile・Polymer）, Inorganic（Glass・semiconductor）, Biological Sample、
Universal, High magnification 
Is the specimen electrically conductive? 
 Yes：The specimen with coating is selected. See Table of Observation conditions next page. 
 No：Proceed to the next question. 

Is the specimen coated? 
Yes：” With coating” condition is selected. See Table of Observation next page. 
No：” Without coating “ condition is selected. 

Do you want to observe the specimen in the low vacuum mode? 
Yes：” Low –Vacuum Observation “ condition is selected. See Table of Observation next page. 
No：” Low-Voltage Observation “ condition is selected.    

Condition 

Do you want to perform EDS analysis? 
Yes：” EDS “ is selected. See Table of Observation next page. 
No：” Observation” is selected. 

OK By clicking the OK button, the observation condition is set according to the sample classification. 
Cancel The thurmbnail list (Image list) is displayed. 
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Table of Observation Conditions 
 

Without Coating 

With Coating Low-Voltage 

Observation 

Low-Vacuum  

Observation 

S.S S.S S.S 
Standard Sample Mag. 

AccV
Observation EDS

AccV
Observation

AccV
Observation EDS 

Specimen 

Chamber Press. 

Pa 

Metal・Mineral 20 50 60 1.5 50 15 50 50 30 

Organic 

(Textile・Polymer) 
10 50 60 1.0 50 10 60 65 40 

Inorganic 

(Glass・Semiconductor) 
15 50 60 1.0 50 15 60 65 40 

Plant ・ Biological

sample 
10 50 60 1.0 50 10 60 65 50 

Univarsal 15 50 60 1.0 50 15 60 65 30 

High magnification 

Minimum 

Magnification 

 

20 35 - - - - - - - 
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3.5.4.b Custom 

 

Add 

Click Recipe icon  or select Menu bar File⇒Add Recipe File. 

 

 

 
 

Items Operation/Explanation 

Image The image on the main screen is displayed 
Condition The present observation condition is displayed.  

Signal、Acc. Voltage、Spot size、Magnification、Pressure、Vacuum mode 
X（mm）、Y（mm）、Z（mm）、R（deg）、T（deg）、Date（yy.mm.dd） 

Add Click the Add button to save the image on the main screen in the custom recipe.  
Thumbnail list：the image is added sequentially on the left top. 

Cancel Click the Cancel button to return to thumbnail list. 
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Using 

Performs the call of the observation condition that a user set. Click the left mouse button on the thumbnail.  
 
 

 
 

 
 
 

 
 

Items Operation/Explanation 

Tumbnail 
 

The added recipes are displayed with the thumbnail list. 
If there are many-added recipes, the recipes (thumbnail) can be scrolled by the slide bar. 

Condition When you click the thumbnail image, the observation condition is displayed. 
Signal、Acc. Voltage、Spot size、Magnification、Pressure、Vacuum mode、X（mm）、Y（mm）、
Z（mm）、R（deg）、T（deg）、Date（yy.mm.dd） 

Move the stage to the saved 
image position 

Tick：The motorized stage is moved to the saved image position. 
Non-tick：The motor drive stage is not moved. 
(It is effective when the optinal motorized stage is installed.) 

OK Click the OK button to set the observation condition. 
Cancel Click the Cancel button to return to the thumbnail list 
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 When the right mouse button is clicked  on the thumbnail, the pop-up menu  

is displayed and the following operation can be performed.  

 

Rename Recipe 

Select Rename Recipe from the pop-up menu. 
 

 

 
Items Operation/Explanation 

Image The selected image is displayed. 
Recipe name input box Change the recipe name.  
Condition The observation condition is displayed. 

Signal、Acc. Voltage、Spot size、Magnification、Pressure、Vacuum mode 
X（mm）、Y（mm）、Z（mm）、R（deg）、T（deg）、Date（yy.mm.dd） 

OK Click the OK button to rename the recipe. 
Cancel Click the Cancel button to return to thumbnail list. 

 
 

Delete 

Select Delete from the pop-up menu.. 
 

 

 
Items Operation/Explanation 

Image The selected image and observation condition are displayed. 
Delete Click the Delete button to delete the selected recipe. 
Cancel Click the Cancel button to return to thumbnail list. 
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3.5.5 Stage 

 
This command is used to move the stage to search the field of view.  

 

 
 
 

Items Operation/Explanation 

Position File Click the Position File button to display the position file. (For details, refer to the 3.5.5.a) 

Previous Position If you click the Previous Position button, the graphic display and the coordinates are changed to the 
previous ones where the stage has moved by such as Position File, Enter Coordinates, Initial Position、
Previous Position or Moving by the ＋marker. And the message is displayed. 
Click the Yes button to move the stage to the previous position. 

Backlash When the Backlash button is clicked, the stage will move by -0.1mm from the present position and 
return to the previous position before Backlash starts. 

Initial Position If the Initial Position button is clicked, the message “ Confirm your move ? ” is displayed. 
When the Yes button is clicked, the stage is moved to the following positions. 

X=0.0mm、Y=0.0mm、T=0.0°､R=0.0° 
SNS Switch Click the SNS Switch button to chage the navigation image on the holder graphic display. 

＊ An optional stage navigation system is necessary. 
SNS Capture Click the SNS Capture button to capture the navigation image. 

＊ An optional stage navigation system is necessary. 
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Items Operation/Explanation 

Holder selection Click the Holder selection button to display the holder selection menu.  
(For details, refer to the 3.5.5.b) 

Protruding heigh If the specimen protrudes above the holder top, be sure to input the specimen height.  That is, when the 
specimen protrudes above the holder top, inputting the specimen height (H=0 to 43 mm) before moving 
the stage makes it possible to appropriately limit the specimen-movement range (Z direction).  This can 
prevent the specimen from contacting the detector, or other components. 
 
Example)  

A set height (input the protruding height) is protruding height above the holder top. If you input 20mm, it 
is a range that can be moved from WD5mm to WD28mm, and the height of the stage becomes a moving 
range from 25mm to 48mm. 

Z Axis Moving Limit Click the Z Move Limit button to display the Z axis moving limit menu. 
(For details, refer to the 3.5.5.c) 

Graphic display Left display：The specimen chamber as viewed from the top 
Right display：The specimen chamber as viewed from horizontal direction.  
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3.5.5.a Position File 

 
 

 
 
 

Items Operation/Explanation 

Position file list  The added position file is displayed. 

Add To add the current position in the Position File, click the Add button. 

Delete To delete the selected file in the Position File, select the file to delete and click the Delete button. 

Add Position File 

Number If you tick the counter, the counter is displayed below the file name. 
The seqentiall adding the files are possible with the same file name. 

Example）Sample001 
Coodinates 
display 

The stage coordinates are displayed. 

Move If you select the coordinate file in the list and click the Move button, then the stage moves to the 
selected coordidnates.  

Stage position 

Cancel Click the Cancel button to return to the stage menue. 
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3.5.5.b Holder Selection 

 

 
 

Items Operation/Explanation 

Holder list The holder list is displayed. 

OK Click the OK button to display the selected holder on the graphic display.  
The movement of the stage is limited corresponding to the selected holder. 

Cancel Click the Cancel button to return to the stage menu.  

 
 
 
 

3.5.5.c Z Axis Moving Limit 

 

 
 
 

Items Operation/Explanation 

Normal Mode Z axis of the motorized stage can not be moved to less than 8 mm to prevent collision. Please use at the 
normal observation mode. 

High Resolution Mode Z axis of the motorized stage is movable up to 5mm. Please use when you observe an image at high 
magnification. 
＊ Note that the specimen may damage the various detectors if the specimen 

protrudes above its holder. 
Close Click the Close button to set the Normal Mode or High Resolution Mode.  
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3.5.6 Image List 

 

 

 
Items Operation/Explanation 

Directory Open the saved image from the combo box. 

SMile View The SMile View button becomes active if an optional SMile View is 
installed. 

Thumbnail Image list The saved image files are displayed with the thumbnail list. 
If there are many saved image files, it can be scroledl with the slide bar. 

 
 
 
 
Duble-click the left mouse button on the thumbnail image to display the zoom view in another window (Default：640×480), and 
following buttons are displayed. 
 

Items Operation/Explanation 

Original size The image is displayed with the pixels of the image file.  (The button name changes to “Window size”.) 

Window size The image size is matched to the window. (The button name changes to “Original size”.) 
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 When the right mouse button is clicked  on the thumbnail, the pop-up menu is displayed and the 

following operation can be performed.  

Move the stage 

The stage is moved according to the stage information of the stored image.  
 

Rename File Name  

Seelct Rename File Name from the pop-up menu. 
 

 
 

 
Items Operation/Explanation 

Image The selected image is displayed. 
File name input box Change the file name. 
OK Click the OK button to change the file name. 
Cancel Click the Cancel button to return the thumbnail list. 

 
 
 

Delete 

Select Delete from the pop-up menu. 
 

 
 

Items OPeration/Explanation 

Image The selected image is displayed. 
Delete Click the Delete button to delete the selected image 
Cancel Click the Cancel button to return to thumbnail list. 
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3.5.7 Setup 

 

 

 
 

Items Operation/Explanation 

Icon Layout The “Icon layout” panel is displayed by clicking the Icon Layout button.  
(For details, refer to 3.5.7.a) 

Auto and Preset Mag. The “Auto and Preset Mag.” panel is displayed by clicking the Auto and Preset Mag. button. 
(For details, refer to 3.5.7.b) 

Scan and Auto Save The “Scan and Auto Save” panel is displayed by clicking the Scan and Auto Save button. 
(For details, refer to 3.5.7.c) 

SEM DataDisplay The “SEM data display” panel is displayed by clicking the SEM data display button.  
(For details, refer to 3.5.7.d) 

Eco Mode Setup The “Set Wait mode” panel is displayed by clicking the Eco Mode Setup button. 
(For details, refer to 3.5.7.e) 

Action Select The “Define the mouse operation” panel is displayed by clicking the Action Select button. 
(For details, refer to 3.5.7.f) 
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3.5.7.a Icon Layout 

 

 
 
 

Items Operation/Explanation 

Command All icon names of the standard and/or optional attachment are displayed. 

Dislay The selected icon from command list is displayed. Icon 
Explanation The explanation of function of the icon is displayed.  

Selection frame When you click the icon in the icon layout, a selection frame appears. 
＊ The selection frame is erased when the icon is swapped or deleted. 

Add Drag the selected icon with the left mouse button, and drop between the icons. The selected icon 
is added to the icon layout.  

Default The icon layout is returned to default.  
Delete When the selection frame is appeared, the Delete button will active. 

Click the Delete button to delete the selected icon in the icon layout from the layout. 
＊ The deleted icon area remains as a blank. 

OK Click the OK button to fix the icon layout, and it is reflected on GUI. 
Cancel Click the Cancel button to return the previous icon layout. 
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3.5.7.b Auto and Preset Mag. 

 

 
 

Items Operation/Explanation 

Auto contrast and brightness Contrast：Set the contrast level of ACB (Auto contrast and brightness). Range:±4. 
Brightness：Set the brightness level of ACB (Auto contrast and brightness) Range: ±4. 

Auto Focus＋ If you tick the ACB check box, AF+ ACB are activated when AF is started. 
Auto Stigma＋ If you tick the ACB check box, AS+ ACB are activated when AS is started. 

If you tick the AF check box, AS+ AFare activated when AS is started. 
If you tick the ACB and AF check box, AS+ ACB+ AF are activated when AS is started. 

Preset Mag. The "Preset Magnification" can be saved. 
Click any button, and set the magnification with the Mag＋/Mag－ buttons. 
Keeping the left mouse button held down can change the magnification continuously. 
If you click the Preset Mag button, the numerical value can be entered directly. 
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3.5.7.c Scan and Auto Save 

 

 
 

Items Operation/Explanation 

Scan speed, Numbers of pixels Setting the scan speed and an automatic image saving etc. are possible. 
Averaging coefficient The averaging coefficient at each scan speed is settable between 1and 255. 
EXP marker The exposure marker is displayed at the Scan1 mode if you tick the Exposure box. 

The exposure marker is not displayed if you don’t tick the box. 
Auto save If it is ticked, the image is saved automatically in the specified file after acquiring the 

image by Photo icon. 
Directory If the  button is clicked, the directory list is displayed and, it is possible to specify the 

directory. 
File name The auto save file name can be set. 

＊ Default：Image 
Number The serial number starting from 001 is added following the file name. 
Format The image format to save can be set.（BMP, JPEG, TIF） 
Text paste If you tick the check box, the SEM data is pasted in the image and the image is saved in 

the file. 
Ext scan ON：External scan is activated. 

OFF：External scan is off 
CH1,2,3：Switches the external scan channel 
＊ An optional ESIF is necessary.（A/LA model：initial option） 
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3.5.7.d SEM data display 

 

 
 

Items Operation/Explanation 

Photo data 
 Signal 
 Acc. Voltage 
 WD 
 Spoit size 
 Vacuum 
 Magnification 
 Micron bar 

Label 
 Number 
 

Date  

If you tick the box, the SEM data are displayed on the Freeze image. 
 Signal name 
 Accelerating voltage 
 Working distance 
 Spotsize 
 Vacuum（Low vacuum pressure display：10 - 270Pa） 
 Magnification 
 Micron bar and micron value 
 Label 
 Number（0000-9999）：If you tick the check box, the number is automatically counted up each 

time after saving the image. 
   DD/MM/YY 

Background Select the background for data display 
Black：SEM data is displayed in white on a black background. 
Image：SEM data is displayed in white superimposed on the image. 

Text Paste If you tick the check box, the SEM data (and entered texts on the image) is pasted in the image file 
and the image is saved. 
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3.5.7.e Eco mode Setup 

 

 
 

Items Operation/Explanation 

ON/OFF Switches the ON/OFF of the Eco mode (energy saving mode)  
Preset Time Set the time to start the Eco mode when either the mouse, keyboard or the operation keyboard is not used 

over the preset time. 
＊ Default：240 minutes 

Start Eco Mode By clicking the Start Eco Mode button, the energy saving mode is started.  (A message is displayed.) 
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3.5.7.f Action Select 

 

 

 
Items  Operation/Explanation 

 The direction of the mouse operation can be set in the image adjustment tool (Focus, 
Stigma, Contrast, Brightness, Spotsize).  
＊Default： Up / Down 

Up / Down Activates the mouse moving in the up or down direction on the screen.  
The pointer appears by the left center of the screen 

Select the mouse 
control 

Right / Left Activates the mouse moving in the right or left direction on the screen. The pointer 
appears by the top center of the screen 

 The stage moving direction can be set. (only in X axis/Y axis) 
It cannot be set if the motorized stage is not installed.  
The operation in the stage graphic is similarly set. 
＊Default：Outward direction 

Inward direction The motorized stage can be controlled to the inward direction by clicking the triangle 
icon. 

Selecting the stage 
moving direction 

Outward direction The motor drive stage can be controlled to the outward direction by clicking the 
triangle icon. 
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3.5.8 Maintenance 

 

 
 

Items Operation/Explanation 

Exchanging a filament The “Exchanging a filament” procedure is displayed by clicking the Filament Exchange button. 
(For details, refer to 3.5.8.c) 

Adjusting a filament The “Adjusting a filament” panel is displayed by clicking the Filament Adjustment button.  
(For details, refer to 3.5.8.a)  

Exchanging an OL aperture The “Exchanging a filament” procedure is displayed by clicking the OL aperture Exchange button.  
(For details, refer to 3.5.8.c)  

Adjusting an OL aperture The “Exchanging a filament” procedure is displayed by clicking the OL aperture Adjustment button 
(For details, refer to 3.5.8.c)  

Removing an orifice The “Removing an orifice” procedure is displayed by clicking the Removing Orifice button. 
(For details, refer to 3.5.8.c) 

Mounting an orifice The “Mounting an orifice” procedure is displayed by clicking the Mount Orifice button. 
(For details, refer to 3.5.8.c)  

Initialiging a stage The “Initializing a stage” panel is displayed by clicking the Initialize Stage button.  
(For details, refer to 3.5.8.b) 
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3.5.8.a Adjusting a filament 

 
By using this function, the filament heat and alignment-Tilt and Shift will be adjusted automatically.  
There are combinations as shown below. After the action is completed, the accelerating voltage is 
restored to the original value. 
When the present accelerating voltage is below 5kV, automatic adjustment is carried out at 5kV.  
And, after the action is completed, the accelerating voltage is restored to the original value. 

 

 
 

Combination of the automatic operation 

 Auto Filament＋Alignment Auto Alignment Auto Filament 

Full Auto The filament heating and filament 
alignment (Tilt and Shift) will be 
adjusted automatically after 
setting the accelerating voltage 
to 30kV.   

  

Semi Auto The filament heating and filament 
alignment (Tilt and Shift) will be 
adjusted automatically at the 
present accelerating voltage.  

The filament alignment (Tilt and 
Shift) will be adjusted 
automatically at the present 
accelerating voltage. 

The filament heating will be 
adjusted automatically at the 
present accelerating voltage. 

 
＊ The BEI signal shall not be used for the automatic operation. Please change to SEI signal when you perform the automatic 
operation. 
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Items Operation/Explanation 

L.C Displays the load current (unit; μA) Loard current 
Heat setting Adjusts the filament heating current.  

A button is usually set near the orange zone. If you set the button within the 
orange-colored zone, sometimes it may cause filament abnormal.  

Digital display of coarse 
adjustment value／Coarse 
adjustment button 

The coarse adjustment value of the filament heating current is displayed in decimal 
digits. (0 to 255)  
When the  button is clicked, the digital value is decremented by 1 step. When 
you keep pressing the button, the digital value goes down sequentially. When the 

 button is clicked, the digital value is incremented by 1 step.  When you keep 
pressing the button, the digital value goes up sequentially 

Digital display of fine 
adjustment value ／ Fine 
adjustent button 

The fine adjustment value of the filament heating current is displayed in decimal digits. 
(0 to 255) 

When the  button is clicked, the digital value is decremented by 1 step.  When 
you keep pressing the button, the digital value goes down sequentially. When the 

 button is clicked, the digital value is incremented by 1 step.  When you keep 
pressing the button, the digital value goes up sequentially 

Preset The bias adjustment value is restored to the previous value by clicking the Preset 
button. 

Set bias 

Store The bias adjustment value is stored by clicking the Store button. 

Spotsize value Displays the current spotsize value (ss) 

30, 40, 50 button Default value：ss 30(on), ss 40, ss 50 
Select the value to change the spotsize.  
Adjust the spotsize, and click the Set button. The numerical value is changed to the 
adjusted value.  

Preset The spotsize value is restored to the previous value by clicking the Preset button. 

Spot size 

Scroll bar Adjusts the spotsize value.  Range： 0 - 99 
Tilt X, Y The tilt of the electron beam can be adjusted with the scroll bar.  Alignment 
Shift X, Y The shift of the electron beam can be adjusted with the scroll bar.  
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3.5.8.b Initializing a Stage 

 
 

 

 
 
 

Items Operation/Explanation 

Vent the specimen chamber Click the Vent the specimen chamber button to vent the specimen chamber. 
X 
Y 
T 
Z 
R 
All axes 

When X is selected, the initialize of X-axis can be performed. 
When Y is selected, the initialize of Y-axis can be performed. 
When T is selected, the initialize of T-axis can be performed. 
When Z is selected, the initialize of Z-axis can be performed. 
When R is selected, the initialize of R-axis can be performed. 
When All axes s selected, the initialize of all-axes can be performed. 

Start Before initializing the stage, make sure to remove the specimen holder. 
Click the Start button to initialize the stage position. 
 

Note） If the Specimen Height has been entered, reset to 0mm 

and then, initialize the stage. 

 
Stop Stop the initializig operation 

Initializing a 
stage 

Evacuate the specimen 
chamber 

Click the Evac the specimen chamber button to evacuate the specimen chamber. 

Normal Mode Z (WD)-axis of the motor stage can be moved up to 8mm. 
＊ Default is “Normal Mode” 

Stage mode 

High Resolution Mode Z (WD)-axis of the motor stage can be moved up to 5mm. 
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3.5.8.c Exchanging a filament, Exchanging/Adjusting an OL aperture, 

Removing/Mounting an orifice 

 
Click the corresponding operation menu button (Filament Exchange, OL aperture Exchange, OL aperture 
Adjustment, RemoveOrifice, Mount Orifice) to display an animation and an operation procedure as shown below. 

 
 
 

 

 
 
 
 
 

Items Operation/Explanation 

The “Exchanging a filament” procedure is displayed by clicking the Filament 

Exchange button. 
Vent the electron gun chamber by clicking the Vent the electron gun chamber 
button 

Filament Exchange 

Evacuate the electron gun chamber by clicking the Evacuate the electron gun 

chamber button. 
The “Exchanging an OL aperture” procedure is displayed by clicking the OL Aperture 

Exchange  button. 
Vent the electron gun chamber by clicking the Vent the EOS button  

Menu buttons 
 

OL aperture Exchange 

Evacuate the electron gun chamber by clicking the Evacuate the EOS button. 

Animation Play button 

Play／Pause／Stop button 
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Items Operation/Explanation 

The “Adjusting an OL aperture” panel is displayed by clicking the OL Aperture 

Adjustment button.  
The magnification is switched to the lowest magnification by clicking the Wobbler ON 
button. 
The Wobbler function performs by clicking the Wobbler ON button.  

OL aperture adjustment 

The Wobbler function ends by clicking the Wobbler OFF button. 
The “Removing an orifice” procedure is displayed by clicking the Remove Orifice 
button. 

Remove orifice 

Vent the specimen chamber by clicking the Vent the specimen chamber button. 
The “Mounting an orifice” procedure is displayed by clicking the Mount Orifice button. 

 

Mount orifice 
Vent the specimen chamber by clicking the Vent the specimen chamber button. 

Switch button Click a box （ ）beside an explanation to play an animation. 
＊ It keeps playing until switching to the other buttons. 

Play（ ） 
The animation is played by clicking the side button (play button) of an explanation. 
The animation is played continuously until switching to the other buttons. 

Pause（ ） 
Pause：Animation is stopped temporarily. 

Movie 

Stop（ ） 
Stop：Animation is stopped 
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Operation 
 
 

Refer to the EDS instruction manual for the operation of EDS unit 
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4.1  Starting and Shutting Down the Instrument 
 

CAUTION！ 

Before starting the instrument, make sure that the room temperature is within the 

installation requirements (15 to 25℃).  

If the room temperature does not satisfy the installation requirements, set the temperature within the installation 
requirements using a cooling or a heating facility, and then start the instrument. 

 
 
 
 

4.1.1  Inspection Before Starting the Instrument 

 
CAUTION！ 

Make sure that the oil level is not below the lower limit. 
 

If you start the instrument in insufficient RP oil quantity, you might damage the pump. Make sure the oil level and 
contamination (coloring) at the oil level indicator on the RP (rotary pump) (about once a three months). 
If you use the instrument frequently, shorten the interval of the inspection period. 
If you need to replenish or replace the oil, please contact your local JEOL service office. 
 

 
 
 

Oil level indicator 

Upper limit 

Lower limit 

Oil mist trap 

Rubber hose
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4.1.2  Starting the Instrument 

 
 

1. Run cooling water through the system.（Flow rate; 2.0L／min） 

When an optional TMP is attached, cooling water is not used.  

2. Turn ON the power switch on the distribution board. 

3. Check that the MAIN BREAKER at the main console rear is set to ON. 

4. Set the MAIN POWER key switch on the main control panel to｜(ON). 
Insert the key, and when you turn it to START, release your hand from the key. The key returns to｜(ON) 
position. 

 

 
Main control panel (Main console front view） 

 
5. After about 10 seconds, turn on the peripheral devices (such as monitor and printer) of the computer. 

6. Turn on the computer. 

7. Click Start in the Windows desktop screen. 

8. Select All Programs ⇒ JEOL SEM ⇒ SEM Main Menu in the pull-up menu. 

The starting screen appears, and when the software starts running, the screen changes over to SEM-GUI. 

The system logon appears to GENERAL. 

9. When the HT icon become the OFF , you can observe the image. 
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4.1.3   Shutting down the Instrument 

 
Caution ! 

Before shutting down the instrument, save the data of such as images in files. 
Be careful that unless you do not save the data in files, they will be deleted. 

 
 
 

1. Select File ⇒ Exit JEOL Scanning Electron Microscope from the menu bar. 

 
 

2. Click OK button to exit JEOL Scanning Electron Microscope program. 

3. Click Start in the Windows desktop screen. 

4. Select Shutdown ⇒ Windows shutdown ⇒ Shutdown ⇒ Yes from the pull-up menu of Start. 

5. Turn ○ (OFF) the peripheral devices (such as monitor and printer) of the computer. 

6. Set the MAIN POWER key switch on the main control panel to ○ (OFF). 

 

 
 

7. Turn off the power switch on the distribution board. 

8. After waiting for about 15 minutes, turn off the cooling water. 

In case an optional TMP is installed, cooling water is not used. 
 



4. Operation 

___________________________________________________________________ 4-4

4.1.4  Treatment in an Emergency 

4.1.4.a Measures in an emergency 

 
1. Set the MAIN POWER key switch on the main control panel to ○ (OFF). 

 

 
 

2. Turn off the power switch on the distribution board. 

3. Close the main cock of cooling water. 

When an optional TMP is attached, the main cock of cooling water need not be shut. 
 
 
 
 
 

4.1.4.b Resuming operation after shutting down the instrument in an 

emergency 

 
 

To start the instrument after shutting down the instrument in an emergency, perform the procedure of Section 
4.1.2, “Starting the instrument.” 
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4.1.4.c Measures when a power failure occurs 

 
When a power failure occurs, the instrument stops in the safe state, but the main cock of cooling water 
remains open. 
If the power failure continues for a long time, be sure to close the main cock of cooling water. 
 
To start the instrument after recovering the power failure, perform the procedure of Section 4.1.2, “Starting the 
instrument.” 

 
 

！CAUTION  

When cooling water is left running without power supply under high humidity, it may 

damage the Diffusion Heater due to condensation. 

If the power failure continues for a long time, be sure to close the main cock of cooling water. 
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4.2  User Login 
 

 

1. Click the User Login of the operation menu tab. 

2. Click the Log on／Log off button. 

3. Select a user name from the user list, and click the Log On button. 

 

 
User Log on 

 
 
 
 

When you log off, click Log Off button after checking the log on user name. 
 

 
User Log off 
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When you want to add a new user, rename the user and delete the user, proceed as follows. 
 
 

Adding a New User file 
 

Select Add User File, enter a user name and click the OK button. 
 

 
 
 

Deleting a User file 
 

Select Delete User File, select the user name to delete and click the Delete button. 
 

 
 
 

Renaming a User file 
 

Select Rename User File, enter a new user name after selecting the previous user name and click the 
Change button. 
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4.3  Specimen Exchange 
 

CAUTION! 

• Be sure to set the specimen not to protrude above the specimen holder. 
If the specimen protrudes from the holder top and even the stage is moved within its movement limit 
range, the specimen might contact and damage the objective lens or the backscattered electron 
detector. 

• Ensure to select the specimen holder you are using in the specimen holder dialog 

box. 
If you do not select a correct specimen holder, the specimen stage might move beyond the stage 
movement limit range and thus the specimen stage contacts and damages the objective lens or the 
backscattered electron detector.（In case the motorized stage is installed） 

 
 
 

4.3.1  Preparing the Specimen setting 

 
Prepare a specimen. 
Set the specimen on the specimen support, and adjust the specimen support so that the top of the specimen 
surface becomes in a same level with holder top. 
Be sure to fasten the specimen so that the top of the specimen surface does not protrude above the holder top. 
For such specimen as not electrically conductive, use a conductive paint to prevent the specimen from charging. 
Avoid setting the specimen containing unnecessarily water or oil, because it will contaminate inside the column. 
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4.3.2  Changing the Specimen 

4.3.2.a Draw out 

 
1. Vent the specimen chamber. 

a. Click the HT icon to get HT OFF . 

b. Click the Sample Setting of the operation menu tab. 
c. Click the Removing the specimen button. 

 

 
 

d. Click the VENT button. 
Use slow venting for samples such as powders which are easily scattered. First select Slow and then click the 
VENT button. 

e. The pressure in the specimen chamber becomes atmospheric pressure in 50 seconds. After the light of the VENT 

button turns ON, the stage can be withdrawn to remove the specimen holder. 
 
 
 

2. Setting the specimen 

Click the Setting button. 
 

When the motor drive stage is not installed 

a. If the specimen protrudes above the holder, make sure to input the protruding sample height above the 
holder in the dialog box. 

b. Set the specimen holder onto the specimen stage. 
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When the motor drive stage is installed 

a. Select the specimen holder used, and click the Selection button. 
b. If the specimen protrudes above the holder, make sure to input the protruding height in the dialog box. 
c. Set the specimen holder onto the specimen stage. 

 

If the optional stage navigation system and motor drive stage are installed 
Click the Navigation button, and capture the navigation image according to the operational navigation. 
(Refer to 4.4) 

 
 
 

3. Choose a recipe 

a. Click the Choose a recipe button. 
b. From the displayed list of Standard recipe, select a recipe applicable to the sample. And click it. 

If you are not sure which recipe is applicable to the sample to be observed, select Universal. The standard 
observation conditions will be set. 

c. The operation navigation is changed to the setup observation condition menu. 
 

 

 

 
 

d. Set observation conditions according to the questions you will be asked. 
If the specimen is not electrically conductive, not coated and High Vacuum is being selected, Acc. voltage is 
automatically set at 1kV. Under this condition EDS analysis question becomes grayed out, because the amount of 
signals for EDS analysis is insufficient. 

c.  Click the OK button. The observation conditions will be set. 
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4. Evacuate the specimen chamber. 

a. Click the Evacuating the Chamber button. 
b. Close the specimen chamber and click the EVAC button. Evacuation in the specimen chamber will start. 
c. If the sample without coating or containing water is observed as it is, the vacuum mode must be set to the 

low-vacuum mode. 
d. After the mode is selected, a message will appear. Follow the instructions in the message to change the vacuum 

mode. 
e. If you want an image to be displayed automatically after evacuation, tick the following check box. The image will be 

displayed automatically after evacuation. 
 

If the Filament Adjustment in the Maintenance of the operation menu tab is not adjusted correctly, the 
image may not be displayed correctly. (refer to 4.23.1.b) 

 
 

CAUTION！  

When you push the stage back to the specimen chamber, be careful not to get 

caught your fingers between them. 

 
 

 

 
 

5. After the HT icon  turns OFF, you can start image observation. 
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4.3.2.b Airlock 

 
1. Remove the specimen with an airlock system. 

 

a. Click the HT icon to get HT OFF . 

b. Click the Airlock button on the evacuation control menu. 
c. Click the Removing the Specimen button. 
d. Move the stage to the Specimen Exchange Position. 

X = 40mm (15mm when motorized stage is installed) 
Y = 40mm (15mm when motorized stage is installed) 
Z = 20mm 
T = 0° 
R = 0° 

 
e. Mount the exchange rod on the airlock chamber and press the ALC-EVAC button. 

The button will change to ALC-VENT. 
 

Press the ALC-VENT button while the button is flashing or lighting. Evacuation in the airlock chamber 
will stop, and the pressure in the airlock chamber will change to atmospheric pressure. 

f. Open the airlock valve after the ALC-VENT button stops flashing. 
g. Fully insert the exchange rod and screw it into the screw hole of the holder. 
h. Fully withdraw the exchange rod until it stops, and close the airlock chamber. 
i. After the pressure in the airlock chamber becomes atmospheric pressure in a few seconds, remove the  

exchange rod. 
 

 
Withdraw the exchange rod 

Airlock valve 
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2. Setting the specimen 

If the specimen protrudes above the holder, make sure to input the protruding height in the dialog box. 
 

3. Evacuating the specimen chamber 

a. Mount the specimen holder on the exchange rod. 
b. Click the Evacuating the Chamber button. 
c. Make sure that the stage position is at the Specimen Exchange Position. 

X = 40mm (15mm when motorized stage is installed) 
Y = 40mm (15mm when motorized stage is installed) 
Z = 20mm 
T = 0° 
R = 0° 

 
d. Mount the exchange rod on the airlock chamber and press the ALC-EVAC button. 

The button will change to ALC-VENT. 
 

While the button is flashing, click the ALC-VENT button. Then, evacuation in the airlock chamber 
stops, and the pressure in the airlock chamber becomes atmospheric pressure. 

 
CAUTION！  

When mounting the exchange rod, be careful not to get caught your fingers between 

them.  
 
 

e. Open the airlock valve after the ALC-VENT button stops flashing. 
f. Insert the exchange rod, and set the specimen holder on the stage. 
g. Remove the exchange rod from the specimen holder, and fully withdraw the exchange rod. 
h. Close the airlock valve 
i. The specimen exchange rod can be fully removed after the airlock chamber is vented. 
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4. Choose a recipe. 

a. Click the Choose a recipe button. 
b. Select a recipe applicable to the sample from the Standard Recipe in the Recipe Selection, and click it. 

If you are not sure which recipe is applicable to the sample to observe, select Universal. The standard 
observation conditions will be set. 

c. The operation navigation is changed to the menu of the setup observation condition. 
 

 

 

 

 
 
 

d. Set observation conditions according to the questions you will be asked about the conditions. 
The condition of a high vacuum mode without coating is not suitable for analysis because the amount of signals 
for the EDS analysis is insufficient. If this condition is set, the EDS analysis item will be grayed out. 

e. To set observation conditions, click the OK button. 
 

 

5. After the HT icon  turns OFF, you can start image observation. 
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4.4  Navigation Image Acquisition 
 

The device is to control a stage position by using images captured by the camera (color CCD) installed outside the 
specimen chamber. (The optional motor drive stage and stage navigation system are required.) 
 
Navigation images can be captured by the following procedures. For more details, refer to the SNS Instruction Manual. 

 
 

1. Click the Sample Setting (or Stage) in the operation menu tab. 

2. Click the Navigation button. 

3. Vent the specimen chamber to atmospheric pressure, and draw out the stage fully where the Navigation image 
can be captured. 

4. Move the specimen stage position as follows 

Z＝10mm、R=0°、T=0° 

5. Click the Capture (or SNS Capture) button to capture the image 

 
 
 
 

Navigation screen 

When you click in the navigation screen with the right mouse button , the pop-up menu appears. 

 
 
Details of pop-up menu 

 
Items Explanation 

Delete Click the Delete button to delete the captured image. 
Open Image File Click “Open Image File” to display the “Open Image File window”.  

Save Image File Click “Save Image File” to display the “Save Image File window”. 
Capture image The most recently captured image is displayed. 

Previous Display Image The previously displayed image is displayed. 

All Clear The image on the navigation screen is deleted by clicking “All Clear”.. 
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4.5  Observing a specimen 
 

Proceed following procedures to observe the image, provided that the sample setting is complete（refer to 4.3）. 
 
 

1. Click the HT icon  to get HT ON . 

2. Click the 、the  and the  icons to observe the image. 

3. Move view of interest to the center of main screen with “Click center”. 

Click center 
Double-click the left mouse button at any position in main screen. The double-clicked position moves to the 
center of the screen. 

 

 
 

4. Find view of interest. 

5. Get view of interest by increasing magnification gradually. 

6. Move view of interest to the center of the main screen, and set it at necessary magnification. 

7. Adjust the image quality by using the Contrast 、Brightness 、

Focus  and Stig（X、Y）  buttons. 

 
 
 

For observing at high magnification it is recommended to focus at low magnification first and then increase 

magnification gradually. Or, when you want to observe more high resolutions, refer to the “4.6.Observation condition”.  
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4.6  Observation conditions 
 
For the observation conditions of a specimen, you must select optimum values from various factors, such 
as accelerating voltage, probe current, movable aperture, and working distance. You should also take 
into consideration such as the sampling method (specimen preparation) and the specimen tilt. Moreover, 
in order to obtain a more optimum image quality, the brightness adjustment, astigmatism correction 
adjustment and focus adjustment become of importance. 

 
 
 

4.6.1   Difference of image quality depending on the value of the 

accelerating voltage 

 
In the theoretical point of view if you consider only the probe diameter, as you increase the accelerating voltage, the 
probe diameter becomes finer. However, you cannot ignore some disadvantages that appear when you use a high 
accelerating voltage. Those disadvantages are as follows. 

 
• The fine structure on the specimen is susceptible to vanish. 
• Edge effect becomes prominent. 
• Charging up is likely to occur. 
• Specimen damage is likely to occur. 

 
Generally, the more fine structure of the specimen surface appears when using a low accelerating voltage than using a 
high accelerating voltage. When you use a high accelerating voltage, the diffusion region of the incident electrons into 
the specimen becomes large; as a result, unnecessary signals (for example, backscattered electron, …) generated from 
the inside of the specimen decreases the contrast, hiding the fine structure on the specimen surface. Therefore, for the 
observation of a low-density material, in particular, a low accelerating voltage is desirable. 
 

 

Effect of the accelerating voltage

High resolution is obtainable 

Surface structure is clear. 

Damage is low. 

Charge up decreases. 

Edge effect decreases. 

Surface structure is unclear.

Edge effect is large. 

Prone to charge up 

Damage is large. 

Resolution decreases.

High 

Low 

Accel. voltage 

Low accel. 
voltage 

HIgh accel. 
voltage 

Low atomic number High atomic number

Incident electrons

Diffusion of incident electrons (by Duncumb and Shieds) 
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4.6.2   Effect of the probe current 

 
You can obtain the higher magnification and the higher resolution for the SEM image, the smaller the probe diameter 
(spot size) to irradiate the specimen. However, the smoothness of the image, that is to say, the S/N (signal/noise) ratio 
depends on the probe current to irradiate the specimen. If you want to decrease the probe diameter, the probe current 
decreases. Therefore, you must select a probe current according to the magnification and the observation condition 
(such as the accelerating voltage and specimen tilt). 

 

 

 
 
 

4.6.3   Effect of the working distance (WD) on the image 

 
When you change the working distance (WD), in the short WD, although the depth of field becomes shallow, you can 
obtain high resolution; on the contrary, in the long WD, although the resolution decreases, the depth of field becomes 
deep. Moreover, in order to obtain a more optimum image quality, the brightness adjustment, astigmatism correction 
adjustment and focus adjustment become of importance.  

 

Effect of the probe current 

Guideline for setting a spot size 
Large

Small

Probe current 

Resolution decreases. 

Damage is big. 

High resolution is obtainable. 

Damage is low. 

Spot size value [0] 

Resolution  High 

Probe diameter Small

Probe current Small

Condenser lens current Large

Specimen damage Small

Image quality             Rough

[99] 

Low 

Large 

Large 

Small 

Large 

Smooth 
Image is rough. 

Image is smooth. 

Effect of the working distance

Short

Long

Working distance

High resolution is obtainable. 

Resolution decreases 

Depth of field is shallow. 

Depth of field is deep. 
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4.6.4   Effect of the aperture diameter on the image 

 
The objective lens aperture (movable aperture) provided in this instrument consists of three steps of size: 20, 30 and 100 
µm diameter. To obtain high resolution, you must select an optimum aperture diameter. 
However, because the image in this instrument requires not only the fineness of the electron beam, but also a sufficient 
amount of signals to form an image, you cannot reduce the aperture diameter more than is necessary. Select 20 µm 
diameter at the high-resolution observation, 30 µm diameter at the normal observation and the EDS analysis, and 100 
µm diameter at the case when a large current is required such as the analysis using the WDS. 

 

 

Effect of the objective aperture

Large

Small

Aperture diam.

High resolution is obtainable. 

Depth of field is deep. 

Resolution decreases. 

Depth of field is shallow.

Large current is obtainable. 

(for BEIW, X-ray analysis, etc.)

Image becomes rough. 
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4.6.5   Relationship between the specimen tilt and the emitted 

electrons 

 
When you irradiate the electron beam on the specimen, secondary electrons are emitted from a relatively shallow 
position of the specimen. The reason why this phenomenon occurs is that even the electrons having a low energy 
generated at a deep position cannot reach up to the surface of the specimen. 
However, for a tilted part of the specimen, because the primary electrons enter a broad region at a shallow angle, the 
secondary electrons generated inside the specimen can easily reach the specimen surface, increasing the emission 
amount of the secondary electrons. Owing to this phenomenon, sometimes, only the tilted part of the specimen you are 
observing appears white (halation). In this case, by aligning the tilted surface to the opposite direction (downside of the 
observation screen) from the secondary electron detector, you can decrease the halation. Moreover, even doing that is 
not enough, the function of Neutralizer is effective. It can limit the amount of signals to decrease the halation more 
effectively.  
 

To use the function of Neutralizer, select the menu bar Tools ⇒ Neutralizer, or click the Neutral icon .  

The function of Neutralizer is only effective for the secondary electron detector. You cannot select this function while you 
use other detectors. 

 
 
 

4.6.6   Observation of the nonconductive specimen and charge up 

 
When you irradiate a large current (high accelerating voltage and large spot size) electron beam on a nonconductive 
specimen, sometimes, electrons accumulate, in other words, charge up on the specimen. 
In this case, it might change the trajectory of the primary electron beam or limit the generation of secondary electrons, 
causing the image shift and the brightness change for the obtained image−such an effect is considerable. 
For such a specimen, you can reduce the charge-up to observe the specimen by using a low accelerating voltage or the 
low vacuum (LV) mode. Also, you can increase the emitted electrons by tilting the specimen, resulting in reducing the 
charge-up. 

 
 

 
 
 

入射電子 

試料傾斜と二次電子放出量の関係 

＜ 
二次電子放出量 試料 

二次電子検出器 

試料の観察画面と検出器の位置関係 

試料の傾斜方向 

観察画面 

Relationship between specimen tilt and the amount of
emitted secondary electrons 

Amount of emitted 
secondary electrons 

Incident electrons 
Secondary electron detector

Observation screen 

Direction of specimen tilt 

Specime

Positional relationship between the specimen observation 
screen and the detector 
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4.7  Operating the image 

4.7.1   Setting the Signal 

 

1. Click the signal  in the image data display. 

The signal setting window is displayed 

2. Double-click  on the desired signal in the list.  

When you tick the SS Link, the spot size will remain the same when you switch detectors and the image shift will not 
occur. 

 

 

 

The selectable signals in the Signal combo box are as follows. (The selectable signals are different by an optionally 
installed detector.) 

Signal Data display 

SEI SEI（Secondary electron image） 
BEC（Backscattered electron – composition image） 

BET（Backscattered electron – Topographic image） 

BEIW 

BES（Backscattered electron – shadow image） 
BEIC BEI 

BEIR BEI 

EMF EMF（Electromotive force image） 
CLD CLI（Cathodeluminescence image） 
CLDIR CLI 

AUX AUX 
REF REF（Refrected electron mage） 

 

BEIC：Centaurus backscattered electron detector 
BEIR：Robinson backscattered electron detector 
EMF：Electromotive force amplifier 
CLD：Cathodeluminescence detector 
CLDIR：Infrared cathodeluminescence detector 
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4.7.2   Setting the Accelerating Voltage 

 
 

1. Click the Accelerating voltage  in the image data display. 

An accelerating voltage is displayed. 

2. Double-click  on the desired accelerating voltage in the list. 

If the ACB check box is checked, the image contrast and the image brightness are automatically adjusted when the 
accelerating voltage is changed. 
If the AF check box is checked, the image focus is automatically adjusted when the accelerating voltage is changed. 
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4.7.3  Setting the Spot Size 

 
Set the spot size according to the purpose of use. 

 
• When you observe a normal image, set the spot size SS about 30. 
• When you perform a high-resolution observation, set the spot size SS smaller than 30. 
• When you perform an analysis and other operations, set the spot size SS larger than 30. 

 
 
 

1. Click the Spotsize (SS)  on the image data display.  

The spotsize setting window is displayed.  

2. Click the one of the preset button SS30, SS40 or SS50. Or select the desired spotsize with the slide button.  

When you slide the bar of the spot size adjustment in the dialog box to the right, the value of the spot size increases (in 
the direction to 99), and when you slide to the left, the value of the spot size decreases (in the direction to 0). 
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4.7.4  Recipe 

 
Generally, when you observe a specimen using a SEM, you must set a suitable observation condition for the specimen. 

In this instrument, typical observation conditions are registered as standard recipes, so by only selecting a suitable 
observation condition for the specimen, you can set a proper observation condition for the SEM. 

However, be aware that evacuation mode, pressure and stage position are only for display, and they are not actually 
reflected on the instrument. In addition, in order to respond to the observation condition of any specimen, you can create 
a custom recipe for each user and save it. Moreover, you can reproduce the created recipe at any time. 

 
 
 
 

4.7.4.a  Adding a new observation condition 

 

1. Display a live image that you want to register the observation condition. 

2. Click the Recipe icon , or select Menu bar File ⇒ Add Recipe File. 

The Add Recipe window is displayed. 
 

 
 

3. Enter the recipe name and click the Add button. 

When you want to register in the different observation condition, change the condition, focus the image once again and 
click the Add button.  

4. A new recipe is added to the Image list. 
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4.7.4.b Renaming a recipe file 

 
Change the added recipe name. 

 
 

1. Click the Recipe in the Operation menu tab. 

2. Select Custom. 

 

 
 

3. Click the right mouse button on the thumbnail and select Rename Recipe from the poop-up menu 

. 

4. Enter a new recipe name. 

 
 

5. Click the OK button.  
The recipe file name is changed and returns to list of custom recipes. 
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4.7.4.c Deleting a recipe file 

 
Delete the recipe file 

 
 

1. Click the Recipe in the Operation menu tab. 

2. Select Custom. 

 
 

3. Click the right mouse button on the thumbnail and select Delete from the poop-up menu 

. 

4. Click the Delete button.  
The selected recipe file is deleted and returns to list of custom recipes. 
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4.7.4.d Using the recipe function 

 
To register the Recipe, refer to the 4.7.4.a. 

 
 

1. Click the Recipe of the Operation menu tab. 

2. Select Custom. 

 
 

3. Select the recipe you want to use and click  it. 

The registered image and observation condition are displayed. 

4. Select the check box you want to set the observation condition, and click the OK button. 

When the “Move the stage to the stored image position” is selected, the reproduction of the stage position can be 
performed. (If the motorized stage is installed)  

5. The observation condition is set. 
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4.7.5   Adjusting the Image Brightness 

 
 

Place a mouse pointer on the  button, and operate as follows. 

 
Coarse adjustment 

While holding down the right button,  move the mouse up (right) and down (left). 
 
Fine adjustment 

While holding down the left button,  move the mouse up (right) and down (left). 
 
 
When you move the mouse up (right), the brightness increases, and when you move it down (left), the 
brightness decreases. 
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4.7.6   Adjusting the Focus 

 
 

Place a mouse pointer on the  button, and operate as follows 

 
Coarse adjustment 

While holding down the right button,  move the mouse up (right) and down (left). 
 
Fine adjustment 

While holding down the left button,  move the mouse up (right) and down (left). 
 

 
When you move the mouse up (right), the image becomes over focus, and when you move it down (left), the 
image becomes under focus. 

 
 
 

For observing at high magnification it is recommended first to focus at low magnification and then increase 

magnification gradually. Or, when you want to observe more high resolutions, refer to the “4.6 Observation condition”. 
 

When you adjust the focus of an image at high magnification, occasionally, the image appears 

sharp in one direction. 

When focusing the image at a high magnification (×10,000 or more), carefully observe the image before and after the 
just focus. If the image appears sharp in one direction, the astigmatism correction is necessary. Proceed to Section 4.23, 
“Daily Maintenance.” 
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4.7.7  Selecting the Scan Rate 

 
 
 
 

Item Icon Explanation Note 

Scan 1 

 

This is suitable for searching field of view 
and adjusting image quality. 
 

You can select the averaging coefficient and scan 
rate. 
A exposure marker can be displayed. Refer to 
“4.19.3 Scan Speed Setting” for more information. 

Scan 2 

 

This is suited to observe the image. You can select the averaging coefficient and scan 
rate. 

Scan 3 

 

This is suited to observe the image detail. You can select the averaging coefficient and scan 
rate. 

Scan 4 

 

This is used to observe the more detail than 
the one at Scan 3 and acquire the image. 

You can select the scan rate. 

Photo 

 

This is used to acquire the image and save 
the image automatically. 

You can select the scan rate. 

Freeze 

 

An observation image becomes the frozen 
image.  

When you want to cancel Freeze, click one of any 
scan icons. 
When you want to return to the previous scan rate 
before Freeze, click the Freeze icon again. 

 
 

 If you click one of any scan icons while pressing the right mouse button , a pop-up menu is displayed 

and you can change the scan speed.（except ） 
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Details of the scan rate 

 
 Horizontal (ms) Vertical (s) Number of pixels 

0.284 0.075 

1.137 0.258 
SCAN1 

 
2.048 0.512 

320×240 

0.284 0.150 

1.137 0.576 
SCAN2 

 
2.048 1.024 

640×480 

20(16.67) 10(8.33) 640×480 

20(16.67) 20(16.77) 
SCAN3 

 
40(33.33) 40(33.33) 

1280×960 

80(66.67) 80(66.67) 

160(133.3) 160(133.3) 
1280×960 SCAN4 

 
80(66.67) 160(133.3) 2560×1920 

The value in parentheses ( ) shows the values used at 60 Hz power frequency . 

 
 
 

Relation between the lowest magnification and WD (Working Distance) 

 

Lowest 

magnification 
WD range (mm) 

Lowest magnification
WD range (mm) 

×40 4.4  -  5.4 ×19 20.5  -  21.4 

×37 5.5  -  6.4 ×18 21.5  -  24.4 

×35 6.5  -  7.4 ×17 24.5  -  26.4 

×33 7.5  -  8.4 ×16 26.5  -  28.4 

×30 8.5  -  11.4 ×15 28.5  -  31.4 

×27 11.5  -  13.4 ×14 31.5  -  34.4 

×25 13.5  -  15.4 ×13 34.5  -  37.4 

×23 15.5  -  16.4 ×12 37.5  -  40.4 

×22 16.5  -  18.4 ×10 40.5  -  45.4 

×20 18.5  -  20.4 ×8(×5) From 45.5 

The value in parentheses ( ) shows the values when the accelerating voltage is used at less than 10 kV. 
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4.8   Moving the Field View 

4.8.1   Manual Stage 

4.8.1.a Moving the stage in the horizontal direction（X and Y） 

 
 

 
 

X-axis 

Y-axis 

80mm direction 

40mm direction 
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Moving to the center of the screen （Click center） 

 
1. Double-click the left mouse button at any position in the main screen. 

2. The double-clicked position moves to the center of the screen. 
 
＊If the magnification is less than ×4500, the motor stage moves (If the motorized stage is installed). 

 

 
 

 
 
 

After moving to the center of the main screen, make zoom up （Click center 

zoom）. 
 

1. When observing the live image, click the right mouse button on the main screen. 

2. Tick Center Zoom ON／OFF. 

 

 
 

3. Double-click the left mouse button at any position in the main screen. 

4. The double-clicked position moves to the center of the screen, and the magnification is enlarged at 15 steps 
larger than the current magnification.  
 
＊ When the magnification is less than ×4500, the motorized stage moves (If the motorized stage is installed). 

 

✔
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Drag moving 

Drag the image window with the left mouse button. 
＊ When the magnification is less than ×4500, the motorized stage moves (If the motorized stage is installed). 

 
 

After moving the image, you can return the image to the original position (Image 

shift reset) 
 

1. When observing the live image, right-click the mouse button on the main screen. 

2. Tick Image Shift Reset. 

 

 
 
 

 By performing Image Shift Reset, you can bring the image to the center of the electrical shift. 
 

 

✔
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4.8.1.b Moving the stage in the vertical (Z) and tilt (T) directions 

 
 
 

 
 
 
 

Z-axis 

5mm direction 

T-axis 

90° direction 
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4.8.1.c Rotating the stage （R）  

 
 
 

 
 

360°endless 
 
 

R-axis 
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4.8.2  Motorized stage 

4.8.2.a Moving the stage in the horizontal directions （Ｘ and Ｙ） 

 

Move the stage continuously 

 
Main screen 
 

1. Move the mouse pointer to the edge of the main screen. 

The mouse pointer will change to an arrow pointer (△).  

2. If you keep pressing the left mouse button  in the specified region (edge) of the image frame, the 

stage keeps moving. 

3. To stop the stage movement, release the left mouse button. 

 

 

 
Pointer shape Explanation of the operation 

､ ､ ､  X and Y axes move simultaneously. 
  Y-axis moves in the positive direction (image moves upward). 
 Y-axis moves in the negative direction (image moves downward). 
 X-axis moves in the positive direction (image moves rightward). 
 X-axis moves in the negative direction (image moves leftward). 

 
 
 

  The Click center function is another way to move the X and Y axes in the main screen. 
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The stage moving buttons in the Graphic Display 
 
 

1. Click the Stage in the Operation menu tab. 

2. Keep pressing the right or left button on the X/Y button in the graphic display shown below. 

High speed：Right mouse button  

Low speed：Left mouse button  

 
3. To stop the stage movement, release the mouse button. 

 
 

 
 
 

No. Explanation of the operation 

1, 2, 3, 4 X and Y axes move simultaneously. 
5 Y axis moves in the positive direction (image moves upward). 
6 Y axis moves in the negative direction (image moves downward). 
7 X axis moves in the positive direction (image moves rightward). 
8 X axis moves in the negative direction (image moves leftward). 

 
 

1 2

3 4

5

6

78 
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Operation Navigation area ----the specified observation point  
 
 

1. Click the Stage in the Operation menu tab. 

2. Click the left-mouse button  in the Graphic Display.  

The shape of the mouse pointer changes to a cross (＋). 
 

 
Specifying the point 

 
3. Click the YES button in the 「Confirm your move？」message dialog. 

4. When the stage movement is completed, the position you specified at Step 2 will be the beam center. 
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Feeding the frame 

 
1. Display a Live image, and right-click the mouse on the main screen. 

2. Tick Frame Shift ON/OFF. 

3. Specify % values for Frame Step. 

 

 
 

4. Move the mouse pointer to the edge of the main screen. 

5. Click the Frame Feed icon . 

The image moves in the direction of the icon at the specified % values. 
For example, when you specify the frame feed amount to 50%, the image moves by a half frame, when you specify it 
to 100%, the image moves one frame (one image). 
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Move the object to the center of the screen (Click center) 

 
1. Double-click the left mouse button at any position in the main screen. 

2. The double-clicked position moves to the center of the image. 
 
＊ When the magnification is less than ×4500, the motorized stage moves (If the motorized stage is installed). 

 

 
 

 
 
 

After moving the object to the center of the image, make zoom up （Click center 

zoom） 
 

1. Display a Live image, and right-click the mouse on the main screen. 

2. Tick Center Zoom ON／OFF  

 

 
 

3. Double-click the left mouse button at any position in the main screen. 

4. The double-clicked position moves to the center of the screen, and the magnification is enlarged at 15 steps 
larger than the current magnification. 
 
＊ When the magnification is less than ×4500, the motorized stage moves (If the motorized stage is installed). 

 

 

✔
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Dragging  

Drag the image window with the left mouse button. 
＊ When the magnification is less than ×4500, the motorized stage moves (If the motorized stage is installed). 

 
 

After moving the image, you can return the image to the original position (Image 

shift reset) 
 

1. Display a Live image, and right-click the mouse on the main screen. 

2. Tick Image Shift Reset.  

 

 
 
 

 By performing Image Shift Reset, you can bring the image to the center of the electrical shift. 
 

 

✔
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4.8.2.b Moving the stage in the vertical (Z) and tilt (T) directions 

 

Move the stage continuously 

 
1. Click the Stage in the Operation menu tab. 

2. Keep pressing the right or left button on the Z/T button in the graphic display shown below. 

High speed：Right mouse button  

Low speed：Left mouse button  

 
3. To stop the stage movement, release the mouse button. 

 

 
 
 
 

No. Explanation of the operation 

1 Z and T axes move in the positive directions (image moves upward). 
2 Z and T axes move in the negative directions (image moves downward). 

 

1

2 1

2
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4.8.2.c Z Axis Moving Limit 

 
 

1. Click the Stage in the Operation menu tab. 

2. Click the Z Move Limit button. 

3. Select Normal Mode or High Resolution Mode.  

4. Click the Close button.  

 
 

 
 
 
 
 

Normal mode  Z axis can not be moved to less than 8mm to prevent collision. 
Please use at the normal observation mode. 

High Resolution mode  Z axis is movable up to 5 mm. Please use when you observe an image at high magnification. 
Make sure that the specimen does not hit the various detectors when the top of the specimen 
protrudes from its holder. 

 
Z Axis Moving Limit  
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4.8.2.d Rotating the stage (R)  

 

Moving the stage continuously 

 
Main screen 
 

1. Move the mouse pointer to the edge of the main screen. 

The shape of the mouse pointer changes to an arrow (△), 

2. Keep pressing the left mouse button  in the specified region (edge) of the image frame. 

3. To stop the stage movement, release the left mouse button. 

 

 
 

Pointer shape Explanation of the operation 

 R axis moves in the negative direction (image rotates counterclockwise, low speed). 
 R axis moves in the negative direction (image rotates counterclockwise, high speed). 

 R axis moves in the positive direction (image rotates clockwise, low speed). 
 R axis moves in the positive direction (image rotates clockwise, high speed). 
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The stage moving buttons in the Graphic Display 
 

 
1. Click the Stage in the Operation menu tab. 

2. To rotate the stage, keep pressing the right or left button on the R button in the graphic display shown below 

High speed：Right mouse button  

Low speed：Left mouse button  

 
3. To stop the stage rotation, release the mouse button. 

 

 

 
 

No. Explanation of the operation 

1 R axis moves in the negative direction (image rotates counterclockwise). 
2 R axis moves in the positive direction (image rotates clockwise). 

 

 
 
 

1 2
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4.8.2.e Moving the stage by specifying the coordinates 

 

Relative movement and Absolute movement 

 

1. Click  the one of the positions (X, Y, R, T, Z) in the coordinates display. 

 
 
 

2. The Enter Coordinates menu is displayed. 

3. Select the specifying Absolute or Relative mode. 

Absolute：The stage is moved to the specified coordinates, wherever the present coordinates are. 

Relative：The stage is relatively moved by the specified values, where it refers the present coordinates as zero. 
 

4. Click the Coordinates display box of the axes to specify, and enter numerical values using the ten keys.  

5. Click the Move button. 

6. Ensure the entered coordinates and click the YES button in the「Confirm your move?」dialog box. 

7. When the stage is reached to the specified position, it stops movement.
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Initial position 

 
1. Click the Stage in the Operation menu tab. 

2. Click the Initial Position button.  

 
 

3. After the message of「Are you sure to move the stage?」is displayed, click the YES button. 

4. The stage stops its movement when it reaches the initializing coordinates. 

＊ If the axis is not motorized, only the Graphic Display is displayed and the axis is not driven.  
     

Axis Coordinate display

X 0.000mm 
Y 0.000mm 
R 0.000deg. 
T 0.000deg. 

 
Initial position 

Are you sure to move the stage? 
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Previous Position 

 
The Previous Position is the one that you have previously moved position by using such function as the Position File, 
Coordinates specify, Initial Position, Previous Position and + Marker.  

 
 

1. Move the stage by using such as the Position File, Coordinates specify, Initial Position, Previous Coordinates 
and + Marker.  

2. Click the Previous Position button.  

 
 

3. The coordinates in the Coordinates Display area displays the previous coordinates. 

4. Click the YES button after the message of the「Are you sure to move the stage?」is displayed.  

5. The stage stops moving after it reaches to the previous position.

Are you sure to move the stage? 
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4.8.2.f Stage Position file 

 
This function saves the image and the stage coordinates, and displays it in the Stage Position File. By selecting 
the file, the stage moves to the saved stage coordinates.  
The reproducibility of the coordinates depends on the precision of the stage. When magnification after moving 
the stage is high, sometimes, the object moves out of the image display. In this case, search the vicinity of the 
object at lower magnification. 
 

 

 
The Stage Position file menu 
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Add Position File 

 
1. Click the Stage in the Operation menu tab. 

2. Click the Position File button.  

3. The Position File menu is displayed. 

 
Position File menu 

 
4. Enter the file name in the Add Position File box, and click the Add button.  

If the “Number” box is ticked, the count is displayed under the file name. And, the Position File can be added with the 
same file name. 

 
 

Delete 

 
Open the Position File menu, select the saved file to delete, and click the Delete button. 
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4.8.2.g Snap Shot 

 
We recommend that you use Snapshot as a navigation of moving the stage. 
If you paste a low magnification image on the Snapshot display, and move the stage using the function 
described below, you can display the objective image at the center of the “Main screen.” However, be aware that 
you cannot move the stage using the image loaded from a file. 
 
 

 If you change the observation conditions in the main screen such as observation position and 
magnification, such changes are also reflected in the Snapshot display as well. 

 
 

Click center function 

 
1. Display a Live image (except Scan1 mode) or a Freeze image in the main screen. 

2. Right-click the mouse on the objective image（example：Standard Live Image・left bottom） 

3. Click  Snap Shot in the pop-up menu. 

The image is pasted in the snap shot screen. 
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 The image can be similarly pasted by the Snap Shot (1/2/3/4) button. 

 

 
 
 

4. Double-click the mouse button (cross cursor appears) on the Snapshot screen. 

To delete the cross cursor position, right-click the mouse on the objective image and click in Clear Marker in the 
pop-up menu. 
 

 
 

5. The system controls the motorized stage to move it to the double-clicked position, and displays the image at 
the center of the main screen. 

 
 

Snap shot button 
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Click center zoom function 

 
1. Display a Live image (except Scan1 mode) or a Freeze image in the main screen. 

2. Right-click the mouse on the objective image（example：Standard Live Image・left bottom） 

3. Click  Snap Shot in the pop-up menu. 

The image is pasted in the snap shot screen. 
 

 
 

  The image can be similarly pasted by the Snap Shot button (1/2/3/4). 

 

 
 

Snap shot button 



4. Operation 

___________________________________________________________________  4-55

 
4. Drag (the frame is drawn) in the snap shot screen with the left mouse button. 

The frame size is changed according to the drag.  
To delete the frame position, right-click the mouse on the objective image and click in Clear Marker in the pop-up 
menu. 
 

 
 

5. Double-click in the frame with the left mouse button. 

The stage (if the motorized stage is installed) is moved to the position where you double-clicked, and the image is 
displayed to the center on the main screen with the magnification near the frame. 
After movement, the frame is corrected according to the display magnification. 
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4.9  Changing the Magnification 
 

To change the magnification, you can choose from the following operation. 

• Using the Magnification window  
• Using the Magnification button 
• Using the mouse wheel 
• Using the Preset Mag. button 

 
 
 

4.9.1   Using the Magnification window 

 
1. To display the magnification window, click on the magnification box in the SEM data display. 

2. Click  on the Magnification data display. 

3. Double-click the desired magnification from the list.  
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4.9.2   Using the Magnification button 

 
 

You may use both the Mag.－button  (to reduce ) and Mag.＋ button 
 (to increase) in the Image Adjustment button.  

 
Left-clicking the mouse can change the magnification by one step, and keeping the left mouse button held down 
can change the magnification continuously. 

 
 

The magnification down or up by one step  

Click  the  or  button. 

  
The magnification continuously down or up 
Keep the left mouse button held down on the  or  button. 
 

 
 
 
 
 

4.9.3   Using the mouse wheel 

 
If there are mouse cursor in the main screen or dual screen live image (right or left), and using the wheel mouse, you can 
enlarge or reduce the magnification by scrolling the mouse. 

 
 
 

Enlarging operation：Scroll the mouse wheel backward (pull side). 
Reducing operation：Scroll the mouse wheel forward (push side). 

 
 
 

Wheel mouse 
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4.9.4   Using the Preset magnification 

 
If you use Preset button from the Image Adjustment button, you can instantly switch the magnification. You 
can change the Preset magnification as you choose, so we recommend that you save the frequent use 
magnification. 

 
 

 
 

    Preset magnification 

 
 
 

 Saving the magnification used more frequently 

 
1. Click the Setup in the Operation menu tab. 

2. Click the Auto and Preset Mag. button. 

The Operation Guide screen is changed to the Auto function Preset Mag. Screen.  
 

 
 
 

3. Click the one of the Preset Mag. box. 

 （The box gets highlighted in green frame） 

4. Click the  or  button to set the desired 
magnification. 

5. If you keep the mouse button held down, the magnification changes continuously. 
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4.10  Observing the Backscattered Electron Image 

4.10.1 Principle of image formation 

 
Formations of a composition image and a topographic image 

The following figure is a block diagram showing the basic signal routes of forming images. When the incident 
electron beam is scanned on the specimen surface, backscattered electrons carrying topographic, physical and 
chemical properties of the specimen are emitted from the specimen. 
The instrument detects the backscattered electrons carrying the information from the specimen by a pair of two 
divided semiconductor elements allocated symmetrically to the optical axis from the different directions, converts 
the variation of its amount into the electric signals, amplifies each signal with the preamplifiers, and supplies it to 
the operational amplifier unit. 
The operational amplifier unit further amplifies the signals and performs arithmetic computation of the signals. 
That is to say, on one hand, it extracts the added signal for the signals of detection elements A and B, on the 
other hand, it extracts the subtracted signal between the signals of detection elements A and B. The sum of the 
input signals becomes the signal for forming a composition image, and the difference between the input signals 
becomes the signal for forming a topographic image (refer to the figure in the next page). And the instrument 
display those signals on the monitor. 

 
 

Formation of a stereoscopic image 

When the signal of the semiconductor detection element C for stereographic image is added further to the 
composition image signal in which signals of a pair of two divided semiconductor detection elements A and B are 
added, a stereoscopic (shadow) image, which is mixed with the compositional information and topographical 
information on the specimen surface and gives three-dimensional appearance of the specimen surface, is 
obtained. 

 
 

 
 

 

Incident electron beam

Backscattered electron 

Preamplifier

Specimen 

Display section 

Operational amplifier unit
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4.10.2 Observing a backscattered electron image 

 
You can detect backscattered electrons having information from the specimen surface, and observe the topography and 
the composition distribution of the specimen surface. When you display the secondary electron image at first, you can 
smoothly display the backscattered electron image. 

 
Features of backscattered electron images･･･ 

• The brightness of the composition image becomes darker as the composition becomes lighter elements, 
and brighter as the composition becomes heavier elements. 

• The topographic image looks like as if a light is illuminated from the right side of the specimen. 
• For the convex part, the right side becomes bright and the left side becomes dark. For the concave part, 

the right and left sides become vice versa. 
 

 

Specimen 

Composition image signal

Topographic image signal

Stereoscopic image signal 
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1. Vent the specimen chamber, and then set a specimen. 

2. Display a secondary electron image (SEI). 

3. Click the signal  in the image data display.  

4. Double-click the BEIW in the Signal setting window. 

When you tick the SS Link, the spot size will remain the same when you switch detectors and the image shift will not 
occur. 

 
 

5. Click one of Compo , Topo  or Shadow  button in the BEI. 

At , the shadow level can set with the combo box (1 – 10, EX：ultra 3 - D view). 

If the number goes high, you can get more enhanced stereoscopic 3-D view. 
And, you can set the Gain to Auto (adjusted automatically depending on the “Spotsize” and “Acc. Voltage”) or Manual 
(High, Medium, Low, Analysis).  

6. Adjust the image quality of the backscattered electron image optimal by using  and 

. 

When you switch the signal type（Example：Compo ⇒ Topo）, the image brightness may change. It that case, adjust 

the image brightness by means of ACB icon  or  and . 

 

   
Composition image         Topographic image  Stereoscopic image 

 

Shadow level 
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Guideline of the observation condition 

 Criterion Tendency Caution 

WD 10 - 20mm Image is brighter at shorter WD Make sure not to damage the mechanical hitting with the 
detector and the sample. 

Accelerating voltage 15 - 20kV Image is brighter at higher accelerating voltage Some sample are damaged by electron beam 

Spotsize 30 - 50 Image is brighter at larger Spotsize Same as above 

Movable aperture 1 or 2 Image is brighter at 2.  

 
 
 
 

CAUTION ! 

Just after starting the instrument, or when you largely change the accelerating voltage or the WD, sometimes, 
the brightness of the image changes slowly. The brightness change will stop after a while, however take note 
that when you use the slow scans (such as Scan4 or Photo) for the brightness change. 
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4.11  Low Vacuum Mode Observation 
 

In the observation under low vacuum mode, sometimes, the charge-up phenomenon occurs. When the 
charge-up phenomenon is observed, you must take measures such as to set the pressure to relatively high 
pressure. 

 
 

4.11.1 Dry specimen 

 
 

1. Set a specimen (a dried specimen such as paper, cloth and resin) (refer to Section 4.3). 

2. Click the Low Vacuum button in the Vacuum menu. 

The vacuum mode is switched from high vacuum to low vacuum, and starts evacuating the specimen chamber. 
 

 
Vacuum control panel 

 

3. Click the HT icon  to get HT ON . 

4. Set the accelerating voltage to 15 kV. 
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5. Set the pressure of the specimen chamber to 30 Pa. 

Select the value from the pressure values combo box, and click the Start button.  
The Start button switches to Stop, and it starts flashing. When the pressure reaches to selected value, flashing 
stops. (it takes a few minutes until the pressure setting completes). 
If the pressure does not reach for more than 5 minutes, or the valve is locked, an error message appears. Close the 
error message, and perform the pressure setting again. 

 
6. Set the Spotsize to 30 - 60. 

7. Switch the Signal to BEIW, and click the Shadow button .  

8. Set the shadow level to “1”. 

 
Signal setting window 

 

9. Click the Scan1 icon  

10. Set the specimen stage to the specimen center (0 mm for both X and Y axes). 

 If the motorized stage is installed, use the Holder Graphic Display or Stage Navigation System (option) to set 

the stage to the position where you want to observe.  
 

Shadow level 



4. Operation 

___________________________________________________________________  4-65

 
 

11. Click the 、the  and the  icons to observe the image 

12. Adjust the image quality by using the Contrast 、Brightness 、

Focus  and Stig（X、Y）  buttons. 

13. Increase the magnification by four steps, and check to see the image whether the charge up occurs or not on 
the specimen. 

If the charge-up occurs on the specimen, increase the pressure of the specimen chamber or adjust the Spotsize so 
that the charge-up disappears. 

 
Low ← Pressure → High 

Much ← Charge up → Few 
Bright ← Brightness → Dark 

Relationship between pressure, charge-up and brightness 
 

What is the charge-up? 
This is the electrical charging on the specimen where the electrons cannot flow through to the ground due to the 
electrically non-conductive specimen. When it occurs, sometimes, abnormal brightness appears in the observing 
region, or the field of view shifts during the scan at slow scan. 
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4.11.2 Water-containing specimen 

 
1. Vent the specimen chamber to atmospheric pressure. 

2. Set the specimen such as not containing water as a metal or a specimen holder, and set up the observation 
condition by getting the image. (Refer to Section 4.5) 

3. Click the Low Vacuum button in the Vacuum menu. 

The vacuum mode switches from high vacuum to low vacuum, and starts evacuating the specimen chamber. 
 

 
Vacuum control panel 

 
4. Set the pressure of the specimen chamber to 50 - 70 Pa. 

Select the value from the pressure values combo box, and click the Start button.  
The Start button switches to Stop, and it starts flashing. When the pressure reaches to selected value, flashing 
stops. (it takes a few minutes until the pressure setting completes). 
If the pressure does not reach for more than 5 minutes, or the valve is locked, an error message appears. Close the 
error message, and perform the pressure setting again. 

 
5. Mount a specimen (an aqueous specimen such as plant and biology), and evacuate the specimen chamber. 

6. Click the HT icon  to get HT ON .  
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7. Adjust the image quality by using the Contrast 、Brightness 、

Focus  and Stig（X、Y）  buttons. 

8. Increase the magnification by four steps, and check to see the image whether the charge-up occurs or not on 
the specimen. 

If the charge-up occurs on the specimen, increase the pressure of the specimen chamber or adjust the spot size so 
that the charge-up disappears. 

 
Low ← Pressure → High 

Much ← Charge up → Few 
Bright ← Brightness → Dark 

Relationship between pressure, charge up and brightness 
 
 
What is the charge-up? 
This is the electrical charging on the specimen where the electrons cannot flow through to the ground due to the 
electrically non-conductive specimen. When it occurs, sometimes, abnormal brightness appears in the observing 
region, or the field of view shifts during the scan at slow scan. 
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4.12  Observing a Tilted Specimen 

4.12.1 Tilt correction (Dynamic Focus) 

 
If the focus is not adjusted at both edges of the field of view for a tilted specimen, adjust the focus using 
the slide bar. 

 
 

1. Adjust the focus at the center of the Live image. 

2. Click the Tilt icon , or select Menu bar Tools ⇒ Tilt Correction. 

The Tilting correction menu is displayed. 
 

 
 
 

3. Select the ON/OFF radio button in the Dynamic Focus to ON. 

4. Click the Scan 3 icon  or the Scan 4 icon . 

5. Correct the focusing with the slide bar. 

Once the correction is performed, the amount of correction remains stored in the memory, even if you set the ON/OFF 
button to OFF. 
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4.12.2 Tilt correction (MAG correction) 

 
For the tilted specimen, you can correct the frontward and backward magnifications relative to the magnification 
at the center. 

 
 

1. Adjust the focus at the center of the Live image. 

2. Click the Tilt icon , or select Menu bar Tools ⇒ Tilt Correction. 

The Tilting correction menu is displayed. 
 

 
 
 

3. Select the ON/OFF radio button in the Mag. correction to ON. 

4. Click the Scan 3 icon  or the Scan 4 icon . 

5. Adjust the tilting angle with the slide bar. 

Once correction is performed, the amount of correction remains stored in the memory, even if you set the ON/OFF 
button to OFF. 
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4.13  Observing the image by the Scan Rotation 
 

This function rotates the image by rotating the scan direction.  
(The SCAN ROTATION is necessary) 

 
 

1. Click the SRT icon , or select Menu bar Tools ⇒ Scan Rotation. 

The Scan Rotation menu opens.  
 

2. Select ON of the ON/OFF radio button in the Scan Rotation window. 

3. Set the rotation angle using the slide bar and arrow button. 

The image rotates to the set angle. 

4. If you select OFF of the ON/OFF radio button, the rotated image returns to the previous one.  
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4.14  Capturing a Stereo Image 
 

You can save multiple images in the same field of view at a different angle. 
For creating and analyzing three-dimensional images, please refer to the user manual of THREE-DIMENSION IMAGE 
SOFTWARE. 

 

 

1. Click the Stereo icon  or select the menu bar Tools ⇒ Stereo Pair. 

The stereo pair menu opens. 

2. Select the scan mode (Scan2, 3 or 4) for saving the reference image. 

Set the scan speed of each scan mode using the Scan and Auto Save in the Setup of the Operation menu tab. 

3. Move the object to the cursor center by moving the specimen stage. 

4. Click the Save button to save the reference image. 

Save the image in any given folder. When saving is completed, the screen displays as follows: 
 

 

Capturing a reference image (Left screen: Reference image) 
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5. Slant the T-axis. 

The manual stage 
Slant the T-axis（input range±15°、generally, 5 to 7°）, and input a tilt angle. 

The motorized stage 
When the T axis is tilted, the tilt angle value is input automatically. 

 
6. While enlarging or reducing the comparison image using the Enlarged／Reduce buttons, adjust the image 

position using the X and Y axes of the stage to bring the image in the same field of view as that of the 
reference sample image. 

7. Click the Save button to save the tilted image  

Save the image in any given folder. When saving is completed, the screen displays as follows: 
 

 

Capturing a tilted image (Left screen：reference image、Right screen：tilted image) 

 

 

8. Click either Yes or No button on the message. 

When you click the Yes button, the 3D analysis software starts up. For details, refer to the operation manual of 
THREE-DIMENSION IMAGE SOFTWARE 

When you click the No button, the Stereo pair function is finish. 
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4.15  Measurement 

4.15.1 Parallel measurement  

 

1. Click the Scaler icon , or select menu bar Tools ⇒ Scaler. 

2. Click the Parallel icon . 

X=0.000μm 
Y=0.000μm 
D=0.000μm 

対角 平行 X 平行 Y 

色 

ﾌｫﾝﾄ 

ｻｲｽﾞ 

MS ｺﾞｼｯｸ 

10 

編集 
平行間 

記録 ｷｬﾝｾﾙ 2 点間  
 

3. Select the direction of distance measurement 

Select Parallel X  when you want to measure the distance in the horizontal direction. (Two cursors are 

displayed in the vertical direction.)   

Select Parallel Y  when you want to measure the distance in the vertical direction. (Two cursors are 

displayed in the horizontal direction.)   

Select Diagonal  when you want to measure the distance in the diagonal direction. (Two cursors are 

displayed respectively in the horizontal and vertical directions.) 
 

4. Drag the displayed cursor and set a measurement point.   

The measured value is displayed in real time in the window. When you set a measurement point, drag each cursor (in 
the case of Parallel X and Y), or drag the cursor to the intersection points (in the case of Diagonal). 
 

5. Click the Record button. You can create a freeze image in which the cursor and measured value are drawn. 

If you click Cancel button, an original image re-appears. 
 

 You can change the color of measurement point and measured value, or change the text style. Click the target 
object, and change the color and text style. (Based on Windows)  

Parallel X 

Parallel Y Diagonal 
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4.15.2 Distance measurement between two points 

 

1. Click the Scaler icon , or select menu bar Tools ⇒ Scaler. 

2. Click the Distance icon  

The image area changes as shown below.  
 

T

直線 自由 垂線 

直径 中心間 

多角形 円形 

面積 

円 2 点間 角度 

角度 

ｶｳﾝﾄ ﾃｷｽﾄ 選択 

計数 

色 

ﾌｫﾝﾄ 

ｻｲｽﾞ 

MS ｺﾞｼｯｸ 

10 

編集 

ｶｳﾝﾄ数＝999 

1

2

3

0.3μm 

0.14μm 0.22μm 

0.25μm 

3.2μm2 
3.2μm2 

45° 

有孔虫 

記録 ｷｬﾝｾﾙ 削除 平行間  
 
 
 

Measuring the straight line 
 

1. Click the Line icon . 

2. Drag the left mouse button from the start point to the end of the target object.   

 

  
 

3. The straight line which connects the start point and the end point is displayed, and the measured value is 
displayed.   

4. Click the Record button. You can create a freeze image in which the straight line and measured value are 
drawn. 
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Measuring the linear distance successively 

 

1. Click the Free icon . 

2. Click the start point of the target object, and click again on the arbitrary position. Repeat this operation 
successively. 

3. Double click the end point of the target object. 

4. The polygon which connects the start point and the end point is displayed, and the measured value is 
displayed. 

 

 
 
 

5. Click the Record button. You can create a freeze image in which the polygon and measured value are drawn. 

 
 
 
 

Start point

End point

Double click！ 
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Measuring the perpendicular line for arbitrary straight line 

 

1. Click the Perpendicular icon . 

2. Drag the left mouse button on the target object to draw the base line. 

3. For a drawn base line, a perpendicular line is displayed. 

4. Drag and drop the perpendicular line. 

5. The perpendicular line is set, and measured value is displayed.  

 

 
 

6. Click the Record button. You can create a freeze image in which the perpendicular line and measured value 
are drawn. 
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4.15.3 Angle measurement 

 

1. Click the Scaler icon , or select menu bar Tools ⇒ Scaler. 

2. Click the Distance icon  

The image area changes as shown below. 
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3. Click the Angle icon . 

4. Click the left mouse button on the vertex for which you want to measure the angle. 

5. Move the mouse, and draw one of the two sides which sandwich the angle to measure, and then, click the left 
mouse button on the end point. 
If you move the mouse from the end point, one more side will be drawn and the measured value will be 
displayed 

 

  
 

6. When you want to finish the angle measurement, click the left mouse button. 

7. If you freeze an image and click the Record button, you can create a freeze image under the angle 
management.   
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4.15.4 Circle measurement 

 

1. Click the Scaler icon , or select menu bar Tools ⇒ Scaler. 

2. Click the Distance icon  

The image area changes as shown to the below picture. 
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Measuring the diameter of circle 
 

1. Click the Diameter icon . 

2. Drag the left mouse button on the target object. 

3. The circle that the circumference on the starting point is drawn. 

  
 

4. The circle is set, and the measured value (diameter of circle) is displayed. 

5. The circle size can be changed by dragging. 

6. Click the Record button. You can create a freeze image in which the circle and measured value are drawn.  
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Measuring the length between the center of two circles 

 

1. Click the Distance icon . 

2. Drag left mouse button on the target object.  

3. The first circle that centers on the starting point is drawn. 

  
 

4. The straight line for connecting the center between two circles is displayed.  

5. Specify (start point for dragging) the center of the second circle, the straight line is set and draw the second 
circle by dragging. 

 

  

 
 

6. The second circle is set, and the measured value between two centers is displayed. 

7. Click the Record button. You can create a freeze image in which the two circles and measured value are 
drawn. 
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4.15.5 Area measurement 

 

1. Click the Scaler icon , or select menu bar Tools ⇒ Scaler. 

2. Click the Distance icon  

The image area changes as shown to the below picture.  
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Measuring an area of polygon 
 

1. Click the Polygon icon . 

2. Click the start point of the target object, and click again on the arbitrary position. Repeat this operation 
successively. 

3. Double click the end point of the target object. 

4. The polygon which connects the start point and the end point is displayed, the area of polygon is displayed. 

 

 
 
 

5. Click the Record button. You can create a freeze image in which the polygon and measured value (area) are 
drawn.  

 

Start point

End point

Double click！ 
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Measuring an area of circle 

 

1. Click the circle icon . 

2. Drag left mouse button on the target object. 

3. The circle that assumed the start point circumference is drawn. 

  
 

4. The circle is set, and the measured value (area of circle) is displayed. 

5. The circle size can be changed by dragging. 

6. Click the Record button. You can create a freeze image in which the circle and measured value (area) are 
drawn. 
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4.15.6 Counts the number of measurements 

 
When you want to count the measured target object, perform the following procedures. 

 
 

1. Click the Scaler icon , or eelect menu bar Tools ⇒ Scaler. 

2. Click the Distance icon  

The image area changes as shown to the below picture. 
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3. Click the Count icon . 

4. Left-click a target object or any point you want. 

 

 
 

5. A plus “＋” symbol and numerical quantity appear, and the number you clicked will be counted.   

6. Click the Record button to create a freeze image drawn by counting. 

 
 

1 

2 

3 

4 

5 
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4.16  Edit 
 

By using the Text icon and Select icon, you can change the color of measured position and enter the text on the scree.  
 
 

1. Click the Scaler icon , or select menu bar Tools ⇒ Scaler. 

2. Click the Distance icon  

The image area changes as shown below picture.  
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Changing the color of measured position 

 
 

1. Click the Select icon , and drag it so that a target can be included. 

2. Select the specified color . 

3. Click Save button, you can create a freeze image in which the target was changed to desired color.  
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Entering text 

 
 

1. Click the Text icon. . 

2. By dragging with left mouse button on the main screen, draw the text box. 

3. Move a text box. 

a. Click the Select icon, and drag it so that the box can be included. 
b. Set the mouse cursor on box, and move the box while pressing the left mouse button. Then, release the 

mouse button with the desired position. 
 

4. Change the text box size. 

a. Click the Select icon, and drag it so that the box can be included. 
b. Set the mouse cursor on box, and move the box while pressing the left mouse button. Then, release the 

mouse button with the desired size. 
 

5. Enter text in the text box 

If necessary, change the color, style and size of a font. 
 

Item Explanation 

Color Sets font colors. 
Font Sets font types. 
Size Sets font sizes. 

＊ In accordance with Windows 
 

6. Click the Save button to create a freeze image with text in it. 
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4.17  Various image displays 

4.17.1 Digital Zoom 

 
                  If you are interested to observe the enlarged image at a certain area with the magnification of 2 or 4 times. 
                  The Digital Zoom function is convenient for such purpose. 
 
 

1. Click the Freeze icon  

2. Click the Zoom icon  or select the menu bar Image ⇒ Digital Zoom.  

The Live image on the main screen becomes the freeze image. 

3. Select the zoom magnification×2 or ×4.  

 
 

 

Digital Zoom window 
 
 

4. Move the Zoom frame, and click the Zoom In button. 

Set the mouse cursor on the Zoom frame, and drag the left button to move the Zoom frame. Release the mouse 
button at the zoom position where you want to enlarge. The image in the Zoom frame is enlarged (×2 or×4), and 
displayed on the whole main screen. 

5. Click the OK button. 

A freeze image is displayed under the condition of step 3.  

 

Zoom frame

Zoom magnification 
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4.17.2 Dual Mag 

 
This is the function display to simultaneously the two images on the screen with the different magnification. The 
original image is displayed on the left half screen and the enlarged image specified with frame in the original 
image is displayed on the right half screen. 

 
 

1. Click the Freeze icon  

2. Click the D-Mag icon , or select the menu bar Image ⇒ Dual Magnification.  

The Live image on the main screen becomes freeze image. The original image is displayed on the left-side, and the 
image in the zoom frame is displayed on the right-side. 

3. Select the zoom magnification×2 or ×4. 

 
 

 
Dual Magnification window 

 
 

4. Move the Zoom frame, and specify the enlarging position. 

Set the mouse cursor on the frame, and drag the left mouse button to move the frame. Release the mouse button at 
the Zoom position where you want to enlarge. 

 

Zoom frame

Original image

Image in the frame 
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When you want to change the Zooming position 

a. Click the Positioning button, and move the Positioning frame to the position you want to enlarge. 
b. Repeat Step 3 and Step 4. 

 
 

 

 

5. Click the OK button. 

A freeze image is displayed. 

 

Positioning frame 



4. Operation 

___________________________________________________________________ 4-88

4.17.3 Full Screen Display 

 
A full screen display can be displayed. 

 

1. Click the Zoom icon , or select the menu bar Screen ⇒ Full screen Live Image. 

An image in the size of 640×480 (1 screen) will be displayed on the full screen. 
To cancel the Zoom display, select another display from the screen icon (such as Std, Dual) or menu bar Screen (such 
as Standard Live Image, Dual Screen Live Image). 

 

 
Full screen live image 

Area Zoom (can be possible depending on models and options of your device) 

When you drag the main screen with the right mouse button, the rectangle frame and the pop-up menu appears. Click 
the Area Zoom. The image in the frame is moved to the center of the screen, and it is displayed with the full size 
To cancel the Area Zoom, select another display from the screen icons（such as Std, Dual）or menu bar Screen (such 
as Standard Live Image, Dual Screen Live Image） 

 

 
When dragging with the right mouse button  
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4.17.4 Dual Live image 

 
The live images in the same view field can be displayed side by side with different signals. 

 
 

1. Display a Live image. 

2. Click the Dual icon  (UD) or  (LR), or select the menu bar Screen ⇒ Dual Live Image 

⇒ UD or LR. 

 

  
 

3. Change the frame, if necessary. 

To change the active frame, click the left mouse button  on the display to make it active. 

4. Click the signal  in the Image Data Display. 

5. Change a signal in the selected frame using the Signal window. 

If you tick the SS Link, the Spotsize will remain the same when you switch detectors and the image shift will not 
occur. 

6. Adjust the image quality of selected screen using the Contrast 、Brightness 、

Focus  and Stig（X、Y）  buttons. 

 
 

The Click center can be performed only on the current frame. 
The SEI and REF images can be displayed side by side, if only the secondary electron detector is installed. 
If the MIX display mode is activated while the system is in low vacuum and the BEIW is the only low vacuum detector, 
then three display windows will display the BEIW signals. 
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4.17.5 Split Live image 

 
One view field can be split, and both live images can be displayed with different signals. 

 
CAUTION！  

The SnapShot function cannot be used. 
 

1. Display a Live image. 

2. Click the Split icon （UD）or （LR）, or select the menu bar Screen ⇒ Split Live Image 

⇒ UD or LR. 

  
 

3. Change the frame, if necessary. 

To change the active frame, click the left mouse button  on the display to make it active. 

A frame ratio of the main screen can be changed by dragging the frame. 
Double-click the left mouse button on the border (when a pointer is an arrow) to return to its default. 

4. Click the Signal  of the Image Data Display. 

5. Change a signal in the selected frame using the Signal window. 
If you tick the SS Link, the Spotsize will remain the same when you switch detectors and the image shift will 
not occur. 

6. Adjust the image quality of selected screen using the Contrast 、Brightness 、

Focus  and Stig（X、Y）  buttons. 

 

The Click center can be performed only on the current frame. 
The SEI and REF images can be displayed side by side, if only the secondary electron detector is installed. 
If the MIX display mode is activated while the system is in low vacuum and the BEIW is the only low vacuum detector, 
then three display windows will display the BEIW signals. 
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4.17.6 Flexible Window image 

 
If you make any square area in the observation screen, the inside of this area can be displayed with a different 
signal. 

 
 

1. Display a Live image 

2. Click the Window icon , or select the menu bar Screen ⇒ Flexible Window Image. 

3. The square frame will be displayed on the main screen. 

 

 
 
 

4. Change the frame size or move the frame, if necessary. 

If you want to change the frame size, drag the left mouse button on the corner of the frame. Release the mouse button 
at the desired position. 
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To move the frame (the rectangle area), drag the frame. 
 

 

 
5. Click the Signal  of the image data display. 

6. Change a signal in the selected frame by using the Signal window. 

If you tick the SS Link, the spotsize will remain the same when you switch detectors and the image shift will not occur. 

7. Adjust the image quality of selected screen using the Contrast 、Brightness 、

Focus  and Stig（X、Y）  buttons. 

 
 

If the outside of a rectangular screen is left-clicked , the current screen moves to outside. 

 
 
 

The Click center can be performed only on the current frame. 
The SEI and REF images can be displayed side by side, if only the secondary electron detector is installed. 
If the MIX display mode is activated while the system is in low vacuum and the BEIW is the only low vacuum detector, 
then three display windows will display the BEIW signals. 
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4.17.7 Mixed image 

 
You can display an image by mixing any signals. Perform the following procedure. 

 
 

1. Display a Live image. 

2. Click the Mix icon , or select the menu bar Screen ⇒ Signal Mix Image. 

 
 
 
 

 
 
 

3. Switch the signal with Signal 1／2 combo box. 

4. Adjust the image quality in the current screen using the Contrast 、Brightness 、

Focus  and Stig（X、Y）  buttons. 

5. To change the active frame, click the left mouse button  on the screen to make it active. 

6. Adjust the mixing ratio of Signal 1 and Signal 2 using the slide bar. 

7. The (MIX) Live image mixed with Signal 1 and Signal 2 is displayed to with the adjusted mixing ratio. 

 

 

 

 If the MIX display mode is activated while the system is in low vacuum and the BEIW is the only low vacuum detector, 
then three display windows will display the BEIW signals. 

 

Mixed image display screen 
Signal 2 screen （blue frame：current screen） 

Signal 2 screen 
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4.17.8 Dual／Quad Split Screen Display 

 
It can be convenient for comparison and observation of two or four different images because it can simultaneously 
display two or four image files on one display. 

 
 

1. Click the Freeze icon . 

2. Click the Dual icon  or Quad icon , or select the menu bar Image ⇒ Dual Screen／Quad 

Screen. 

The Live image on the main screen becomes freeze image 

3. Select Image file from the dialog, and click the Open button. 

4. Only the number of split screens performs the above operation. 

If you want to change the current image to a different image, double click on the image. Then, perform item 3 once 
again. 

 

   
Dual screen       Quad screen 

 
 

5. Click the OK button. 

A freeze image is obtained. 

6. Click the Save button. 

The Save window opens, and the freeze image can be stored. 
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4.17.9 Adjusting the image brightness 

 
1. Display the freeze image. 

2. Click the LUT icon , select the menu bar Image ⇒ Look-up Table/ Pseudocolor. 

3. Click the brightness correction button and adjust the correction level by using the scroll bar. 

4. Click the OK button. 

You can create a freeze image in which the brightness is corrected, and operation panel closes. 
 

H

V：

ﾚﾍﾞﾙ設定 

256 

256 

擬似ｶﾗｰ 

反転 

ﾘﾆｱ 増強 軽減 

ｺﾝﾄﾗｽﾄ 画像補正 

ｶﾞﾝﾏ 多値化 強調 

OK ｷｬﾝｾﾙ 

画像反転 ﾋｽﾄｸﾞﾗﾑ 

 
 

 
Item   Details  Explanation   

Linear   

 

Without correction  

Brightness reversal  

 

The brightness is reversed, and displayed. 

Contrast 
enhancement   

The contrast between the L-H levels is enhanced. 
Setting range: L level (0-254), H level (1-255) 

Contrast reduction 

 

The contrast between the L-H levels is reduced. 
Setting range: L level (0-254), H level (1-255) 

Gamma correction 

 

The brightness is corrected by the gamma curve and the corrected 
brightness is displayed.   
Setting range: 1-1.0, 1.1, 1.25, 1.5, 1.7, 2.0, 2.5, 3.0, 5.0, 10.0 

Multi-valued 
processing  

The brightness is displayed by the multi-valued processing. 
Setting range: 4, 8, 16, 32, 64, 128 

Partial enhancement 

 

Part of the image is enhanced by green and displayed.   
Green is allocated to the L-H levels, whereas monochrome is allocated to other 
regions.  
Setting range: L level (0-254), H level (1-255) 
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4.17.10 Displaying the image with color 

 

By displaying the image with color, it is possible to more strongly show the structure which you want to 
emphasize. 

 

 
1. Display the freeze image (click the Freeze icon.). 

2. Click the LUT icon , or select the menu bar Image ⇒ Look-up Table/Pseudocolor. 

3. Click the Pseudocolor button  

 

ｶﾗｰ設定 

標準ｶﾗｰ 

ｶｽﾀﾑｶﾗｰ 

OK ｷｬﾝｾﾙ 擬似ｶﾗｰ 

色調整 

 
 

4. Select the Standard or the Custom with the radio buttons. 

You cannot change the standard color.   
In the Custom, you can create the colors of each color level by using the scroll bar to set the numerical value (1-255) 
of RGB. 

5. Click the OK button. 

You can create a freeze image with the pseudo color, and the operation panel is closed. 
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＊ Color level: The colors, which are set as Levels 1-16, are allocated according to their brightness that is divided 
into 16 equal parts. The standard colors for each individual brightness range are shown in the table below. 

 

Level   Brightness Standard color 

Level 1 1 - 15 Black 
Level 2 16 - 31 Blue 

Level 3 32 - 47 Green 
Level 4 48 - 63 Cyan 

Level 5 64 - 79 Red 

Level 6 80 - 95 Magenta 
Level 7 96 - 111 Yellow 

Level 8 112 - 127 White 

Level 9 128 - 143 Gray 
Level 10 144 - 159 Bright blue 

Level 11 160 - 175 Bright green 

Level 12 176 - 191 Bright cyan 
Level 13 192 - 207 Bright red 

Level 14 208 - 223 Bright magenta 

Level 15 224 - 239 Bright yellow 
Level 16 240 - 255 Bright white 
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4.18  Recording Images 

4.18.1 Automatic saving 

 

Cautions !  

For the file that already exists in the saving location, do not change the extension of 

its filename when saving this file again with the same filename.  

If you do this, the information on the instrument (*.TXT) is replaced and the previous information is erased. (At 
this time, the confirmation message, “Do you save a file by replacing the existing file?” does not appear. So, you 
have to be careful.)   
To avoid this, specify a different saving location, or change the filename when saving the file.  

 
 

 

1. Click the Setup in the Operation menu tab. 

2. Click the Scan and Auto Save button. 

3. Perform the following preparation. 

 
• Selection of the scanning rate   
• Tick the Auto Save check box   
• Specify the saving location and others (selection of pasting data at the bottom of the image, setting a 

count start value, format)   
 

 
Setting－Scan and Auto Save 

 

4. Click the Photo icon . The selected image is saved automatically. 

 

About file name 

    Images at each screen and Dual Freeze images are simultaneously saved. 
      File name: “ Ambient name” _ ”Signal name” _ ”Count” _Extension 
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4.18.2 Manual saving 

 

 

1. Display a freeze image on the main screen. 

2. Click the Save icon , or select the Menu bar File ⇒ Save Image File. 

3. Specify the saving location and enter the filename. 

 

 
Save window 

 
4. Click the Save button 

 

 

 

 About the filename 
The name of the image file is created as follows.   
Filename: “Specified (entered) filename” _ “signal name”_ ”count” _Extension 
 
Therefore, if you perform Save while SEM signals are multi-displayed, the system automatically saves all of the 
SEM images by distinguishing between signal names. 
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4.18.3 Open image file 

 

 

1. Click the Open icon , or select the Menu bar File ⇒ Open Image File. 

 

 
Open Image File window 

 
 

2. Select an image file to open and click the Open button. 

3. The selected image file appears in the main screen and the window closes 
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4.18.4 Recording a live image 

 

Perform the following procedure to record and replay the image.  Observation through the saved movie and 
the dynamic behavior of the specimen can be possible. However, please note the followings. 

• The recording image size is only  640×480 (Pixel). 
• Can not change the screen display while recording the image 
• Can not adjust the image quality while replaying or pausing  

 

 

1. Display a live image. 

2. Click the Movie icon , or select the menu bar File ⇒ Movie. 

3. Set the frame rate and specify the saving folder (Directory). 

 

録画中... 

再生ﾌｧｲﾙ： 

ﾌﾚｰﾑ率： 

保存場所： 

録画設定 

再生設定 

00:00:00 

 
 
 

Items Explanation 

Rec. A live image（640×480 dots, single screen）displayed on the main screen is recorded.  
＊ A message (Recording…) and a time of recording (00:00:00) are displayed. 

Play Select a live image file, and replay  
＊ A message (Playing…) and a time of playing (00:00:00) are displayed. 

Pause Stop replay at one time 
＊ A message (Pause…) and a time of stopping (00:00:00) are displayed. 

Stop Stop live image recording, and save it to the specified folder. 

Frame Set the number of the frames per one second.  
＊ 30, 15（default）, 10  frame/second 

Record Settings 

Directory Specify the directory for saving a live image. 
Play Settings File Specify the file you want to play.  
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4. Click the Record button . 

The recording time is not restricted (depending on a recording media), and a message and recording time are 
displayed during recording. 

 

About saving of a file 

• Whenever you start recording, a folder is created as follows, and a file is saved there.   
Example: 
When you start recording at 10:00:00 on mm dd, yyyy, a folder “yyyy.mm.dd_100000” is created.  

• A filename is Mov00000.avi (AVI file). (*00000 are the count value and the counting goes up every one step: 
00000-99999)   

• Since the file size of the movie is restricted at 2GB, if the storage capacity reaches 2 GB, the movie is saved 
automatically in the file. Further if the storage capacity reaches 2 GB at the number of times to count filenames 
99999, recording finishes automatically. 

• The recording file name is automatically specified with the count-up new file. 
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4.18.5 Playing a recorded live image 

 

 

1. Click the Movie icon , or select the menu bar File ⇒ Movie. 

2. Select a play file from the Play setting (File). 

3. Click the Play button . 

 

録画中... 

再生ﾌｧｲﾙ： 

ﾌﾚｰﾑ率： 

保存場所： 

録画設定 

再生設定 

00:00:00 

 
 

4. When you want to stop a play, click the Stop button , whereas when you want to pause a 

play, click the Pause button . 

5. To replay again after clicking the Pause button, click the Pause button again. 
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4.19  User Settings 

4.19.1 Icon Layout 

4.19.1.a Changing the icon layout 

 
1. Click the Setup in the Operation menu tab. 

2. Click  the Icon Layout button. 

 

 
 

3. Select an icon, and drag and drop it between icons in the Icon Layout. 

 

 
 

4. Repeat the above operation. After the desired layout is achieved, click the OK button. 

 
 

 

Icon layout 
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4.19.1.b Replacing icons 

 
1. Click the Setup in the Operation menu tab. 

2. Click  the Icon Layout button. 

 

 
 

3. Click the icon you want to replace. (The selecting frame is highlighted). 

 

 
 

4. Drag the selected icon and drop it between icons. 
The icon layout will be changed. 

 

 
 

5. After the desired layout is achieved, click the OK button. 
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4.19.1.c Deleting the arranged icon position 

 
 

1. Click the Setup in the Operation menu tab. 

2. Click  the Icon Layout button. 

 

 
 

3. Click the icon you want to delete. (The selecting frame is highlighted) 

 

 
 

4. Click the Delete button. 
Then, the icon you selected will be deleted from the layout. 

 

 
 

5. After the desired layout is achieved, click the OK button. 
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4.19.1.d Default icon 

 
 

1. Click the Setup in the Operation menu tab. 

2. Click  the Icon Layout button. 

 

 
 

3. Click the Default button to get the default icon layout. 
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4.19.2 Auto and Preset Mag. Setting 

 
Auto-correction levels can be changed.  To set the Preset Mag., refer to 4.9.4_ Using the Preset magnification 

 
 

1. Click the Setup in the Operation menu tab. 

2. Click  the Auto and Preset Mag. button. 

 
3. Adjust the correction level of the Auto contrast and brightness. 

Adjust the correction level (±4) in the combo box. 
 

 
 
 

4. A link of auto-functions can be set. 
Perform the setting of a link of auto-functions by referring the table below. 

ACB：Automatic contrast-brightness control 
AF：Automatic focusing 
AS：Automatic astigmatism correction 

 

 
 
 

 Check items Operation description 

Auto focus + ACB Can be performed with AF+ ACB when AF is started. 
ACB Can be performed with AS + ACB when AS is started. 

AF Can be performed with AS + AF when AS is started. 

Auto stigma + 

ACB and AF Can be performed with AS + ACB + AF when AS is started. 
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4.19.3 Scan Speed Setting 

 
The averaging coefficient and scan rate / number of pixel can be set for each scan. 
(“Ext Scan” is effective when an optional ESIF is installed.) 

 
 

1. Click the Setup of the operation menu tab. 

2. Click the Scan and Auto Save button. 

3. Set the scan rate and averaging coefficient in the combo box of each scan. 

 

 
 

Scan 1 – Exposure marker 

You can select the averaging coefficient and scan rate. 
When you check the EXP marker, an exposure marker appears, and the cursor position moves according to the contrast 
(CNT) and brightness (BRT).  When the cursor is almost at the center of the screen, the image contrast and brightness 
become optimum. The relation differs a little depending on the sample. 

 

 
Exposure marker 

 
Photo－ Auto save 

Tick the Auto Save check box to save the current live image automatically when the Photo button  is 

clicked. 
 

The image gets slightly darker until the averaging coefficient (setting range: 1 - 255) reaches to the set values,  
and this phenomena is not a malfunction. Furthermore, in Scan 2 and Scan 3, this phenomenon appears remarkable  
as the scan takes longer. Please note this.  
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4.19.4 Turning ON/OFF of SEM Data Display 

 
SEM data display can be turned ON／OFF, and the data background can be changed. 

 
 
 

1. Click the Setup of the operation menu tab. 

2. Click  the SEM Data Display button. 

3. Data display 

Check the item of which data will be displayed.  To turn OFF the data display, uncheck the item. 
 

 
Number：0000 - 9999、Tick the Number check box to increase the count number by one step when saving the 
image automatically. 

 
 

4. Background 

If Black is selected, the data background will be black. If Image is selected, the data background will be an image. 
 

 
Text paste： When you tick the Text paste check box, the SEM data and the text which you write on the image 
can be displayed.  
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4.19.5 Eco Mode Setting 

 
If the operation such as computer operation is interrupted for a certain period of time, the operation mode can be 
changed automatically to the Eco (energy saving) Mode. 

 
 
 

1. Click the Setup in the Operation menu tab. 

2. Click  the Eco Mode Setup button. 

 

 
 

3. Select ON of the eco Mode. 

4. Enter the Preset Time (default：240 minutes), and click the Start Eco Mode button. 

Eco mode starts automatically if neither the mouse nor the keyboard or operation keyboard are operated during the 
preset time. 

 
 

 To cancel the Eco mode, click the Cancel button or start to operate such as the keyboard etc. 
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4.19.6 Selecting the mouse control 

 
The direction of the mouse operation can be set in the image adjustment button (Focus, Stigma, Contrast, Brightness, 
Spot Size) 

 
 

1. Click the Setup in the Operation menu tab. 

2. Click  the Action Select button. 

3. Select either Up/Down or Right/Left. 

 

 
 
 
 
 

4.19.7 Selecting the stage moving direction 

 
The direction of the motorized stage movement can be set  (only in X axis/ Y axis). 

 
 

1. Click the Setup of the operation menu tab. 

2. Click  the Action Select button. 

3. Select either Inward direction or Outward direction. 
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4.20  Image List 
 

The Image List can display the stored image with a thumbnail, and renaming and deleting the file are possible. Also, 
by starting the SmileView (option), the report can easily create by drag &. drop. 

 

 

4.20.1 Open Image File 

 
1. Click the Image list in the Operation menu tab. 

 

削除 

一覧 

ﾌｧｲﾙ名の変更 

ﾐﾂﾊﾞﾁ 画像ﾌｧｲﾙ 

画像ﾌｧｲﾙ 画像ﾌｧｲﾙ 

画像ﾌｧｲﾙ 

画像ﾌｧｲﾙ 画像ﾌｧｲﾙ 画像ﾌｧｲﾙ 画像ﾌｧｲﾙ 

画像ﾌｧｲﾙ 画像ﾌｧｲﾙ 画像ﾌｧｲﾙ ｽﾏｲﾙﾋﾞｭｰ 

画像一覧  

 
 

2. Select a folder which includes the target file from the directory combo box. 

3. Double-click the left mouse button on the thumbnail. 

4. Double-click the image to display the zoom view in another window. 

When you dragged in another window with the left mouse button, the window size can be changed. 
The switch button is displayed in another window as follows. 

Original size button： The image is displayed with the pixels of image file.  
It is possible to change the display position.  

Window size button： The image size is matched to the window. 
 

Directory combo box 
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4.20.2 Past an image on the main screen or snap shot screen 

 
 

1. Click the Image list of the Operation menu tab. 

 

 
 

2. Select a folder that includes the target file from the directory combo box. 

3. Drag and drop a thumbnail to the main screen or snap shot screen. 

4. A thumbnail is pasted onto the main screen or snap shot screen.  
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4.20.3 Move the stage to the stored image position 

 
The motorized stage is necessary. 

 
 

1. Click the Image list in the Operation menu tab.  

 

 
2. Select a folder that includes the target file from the directory combo box. 

3. Click the right mouse button on the image (thumbnail) which you want to reproduce the stage position, and 
select Move the Stage from the pop-up menu. 

4. The stage is moved and the position is reproduced. 
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4.20.4 Rename a file 

 
 

1. Click the Image list of the operation menu tab. 

2. Select a folder that includes the target file from the directory combo box. 

3. Click the right mouse button on the image (thumbnail) that you want to rename, select Rename File Name 
from the pop-up menu.   

4. The operation navigation screen is changed as shown below. 

 
 

5. Enter a new file name. 

6. Click OK button. 

The image file name is changed and returns to the Image list window.  
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4.20.5 Deleting an image file 

 
 

1. Click the Image list in the Operation menu tab. 

2. Select a folder that includes the target file from the directory combo box. 

3. Click the right mouse button on the image (thumbnail) that you want to delete, select Delete from the pop-up 
menu. 

4. The operation navigation screen is changed as shown below. 

 
 

5. Click the Delete button. 

The image file is deleted and returns to the Image list window.  
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4.21  Report Creation 

4.21.1 Report Creation by using the DTP software 

 
1. Display the freeze image on the main screen. 

2. Click the Report icon, or select the menu bar File ⇒ Report.  

The DTP program starts and the DTP window is displayed 
 

3. Select a format 

Click one of  , or select the menu bar File ⇒ New ⇒ Format 1／2／3／4／5. 

 

Format Explanation 

1 One image is printed within a sheet of A4 size/letter.  
SEM information included.  A title and comment can be entered, and a logo (.bmp image) can be pasted. 
The image size is 128.0mm×96.0mm 
The printing direction is vertical 

2 Two images are printed within a sheet of A4 size/letter paper. 
SEM information included.  A title and comment can be entered, and a logo (.bmp image) can be pasted. 
The image size is 128.0mm×96.0mm 
The printing direction is vertical 

3 One image is printed within a sheet of A4 size/letter paper. 
SEM information included.  A title and comment can be entered, and a logo (.bmp image) can be pasted. 
The image size is 208.0mm×156mm 
The printing direction is horizontal 

4 One image is printed within a sheet of A4 size/letter paper. 
The image size is 208.0mm×156.0mm 
The printing direction is horizontal 

5 Four images are printed within a sheet of A4 size/letter paper. 
The image size is120.0mm×90.0mm 
The printing direction is horizontal 

 
Details of format  
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4. Paste a image on the format. 

a. Click one of , or select the menu bar File ⇒ Open Image File. 

b. Select the target file from the folder, and click the Open button.  
c. An image is pasted and the observation conditions are written beside the image. 
d. Repeat operation a. and b. by the selected format. 

 
 

5. Enter the title or the comment to the format.  

Enter the title or the comment directly into the format.  
If the SEM data check box is ticked, the SEM data can be printed. 
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 If a new report is prepared using each time the same title, comment, name and logo, proceed as follows 

because they can be recorded. 
 

Save title, date, name  
a. Select the menu bar Setup ⇒ Standard Style in the DTP window. 
b. The Standard Style window opens. 
c. Click Title, Date and Name, and then enter them.  
d. Click OK button. 

 
Save logo 

a. Create a logo.  (For details, refer to the manual of logo creation.) 
b. Enter the file name directly in to Logo file, and click the OK button.  

Other method：Click  button and select a file. 

Select menu bar File ⇒ Logo File Open and Select a file.  
Then click the OK button.  
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Save comment  

a. Select the menu bar Setup ⇒ Text Memory in the DTP window. 
b. The Text Memory window opens. 
c. Click an area and click the OK button after entering a comment. 
d. The comment is recorded. 

 

 
 
 

6. Set the print margin 

a. Setup the printer to print. (Refer to the printer manual for more information) 
b. Set the print margin 
c. Select menu bar File ⇒ Print Margin in the DTP window. 
d. Select a Paper Size (A4 Letter or A4). 
e. Enter the margin value (0～60) and click the OK button.  
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7. Print the format. 

a. Check the printing range on the print preview.  
b. Selct File ⇒ Print Preview in the DTP window, and the preview screen opens.  
c. Click the Print button in the preview screen.  
d. Or, click the OK button after selecting the menu bar File ⇒ Print in the DTP window 

 
CAUTION 

• When a Mitsubishi digital color printer (CP770D or other) is used, set the print margins at both left and top 
to 0 mm and the paper expansion factor in the property of the print window to 50% or less.  Otherwise, 
the format will be printed off the paper. 

• The printing range varies with the type of printer.   
• If the printer is changed, set it so that the print margin fits the printer. 
• Printout may differ from that checked on the screen and the actual one may not fit within the paper size. 
 

 
 

8. Save the format. 

Click the save icon  , or select menu bar File ⇒ Save As 

Select a driver and folders, enter a file name, then click the Save button. The format is saved as a DTP file. 
 

9. Open the DTP file.  

Click the Report icon, or select menu bar File ⇒ Report. 

Click the open image file icon , or select menu bar File ⇒ Open. 

Select the DTP file and click the Open button. 
 

10. Exit DTP 

Select the menu bar File ⇒ Exit DTP. 
If there is any DTP file that is not saved, the message dialog will appear. 

 
Yes The file saving dialog appears. 
No DTP program ends and the DTP window closes. 
Cancel Close the message dialog. 
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4.21.2 SMile View (option) 

 
The report enables you to output the image saved beforehand by a fixed display format. You can easily paste the image 
in the image file to the layout sheet (fixed format) created beforehand, only by dragging the image to the layout sheet 
with the mouse. Moreover, you can also display the observation conditions (magnification etc.) of the pasted image. An 
optional Smile View is necessary. 

 
 

1. Click the Image list of the Operation menu tab. 

2. Click the SMile View button. 

Or, click the SMV icon or selecting menu bar File ⇒ SMile View. 

3. The layout sheet (fixed format) for the SMile ViewTM opens.   

 

 
 

4. Select Setup ⇒ User’s Layout from the menu bar on the layout sheet, and then select the layout to use. 
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5. Drag and drop an image to the layout sheet from an image file. 

 
 
 

6. An image is pasted and the observation conditions are written beside the image. 

7. Print or save a report. 

Printing 
Select File ⇒ Print from the menu bar on the layout sheet, and then click the Print button in the print 
window. A report (image + observation conditions) is printed. 
 
Saving 
You can select one of the following formats to save.   

Layout File (*.lay)   
Rewriting is possible again on a report.   

JPEG (90dpi for Web) File (*.jpg)   
This file saves the whole image in the JPEG format with the image quality equivalent to 90 dpi.   

BMP (90dpi) (*.bmp)   
This file saves the whole image in the bitmap format with the image quality equivalent to 90 dpi.   
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4.22  Backing up／Installing a user file 
 

This instrument is compatible with multi-users.  The SEM operating conditions for each user are managed using user 
files and are usually saved on the hard disk in the computer. 

The saved file contains the SEM conditions when the user logged out , the custom recipe files created by the user and 
stage files. 

These files can be backed up on a media (CD-ROM, etc.), in a batch, so that if the file on the hard disk is damaged or 
erased, the back-up disk can be used to install the file. 

 
 
 
 
 

4.22.1 Backing up a user file 

 
1. Click the User Login in the Operation menu tab. 

2. Click the Backup User File button. 

3. Insert the media in the computer. Select of the media of the place of the backup and a directory, then click the 
Backup button. 

 

 
Backup User File 
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4.22.2 Installing a user file 

 
 

1. Click the User Login in the Operation menu tab. 

2. Click the Install User File button. 

3. Insert the backup media in the computer. Select a directory, and click the Install button. 

 

 
Install User File 
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4.23  Daily Maintenance 

4.23.1 Gun Alignment 

 

CAUTION！  

In the following conditions, the vacuum in the electron gun chamber might deteriorate and become  
unstable. 

• When you have set the acceleration voltage to 15 kV or more. 
• When you have dragged the filament heating button to the right (increased the L.C value) 
• Just after maintenance (such as filament change and Wehnelt cleaning) 
• When the room temperature exceeds 25 ℃ or more. 

 
 
 

1. After mounting the specimen, evacuate the specimen chamber（refer to Section 4.3.2） 

2. Click the Maintenance in the Operation menu tab. 

3. Click the Filament Adjustment button. 

 

 
Maintenance－Adjusting a filament 
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4.23.1.a Auto Gun Alignment 

 
By using this function, the filament heat and the alignment-Tilt and Shift will be adjusted automatically.  
There are combinations as shown below. After the action is completed, the accelerating voltage is restored to 
the original value. 
When the present accelerating voltage is below 5kV, automatic adjustment is carried out at 5kV.  
And, after the action is completed, the accelerating voltage is restored to the original value. 
 
 
CAUTION！  

Cannot use the auto gun alignment function when you select LaB6 in the filament mode. (When an optional 
LAB6 UNIT is installed)  

 
 

 Auto Filament＋Alignment Auto Alignment Auto Filament 

Full Auto The filament heating and filament alignment 
(Tilt and Shift) will be adjusted automatically 
after setting the accelerating voltage to 30kV.   

  

Semi Auto The filament heating and filament alignment 
(Tilt and Shift) will be adjusted automatically at 
the current accelerating voltage.  

The filament alignment (Tilt and 
Shift) will be adjusted automatically 
at the current accelerating voltage. 

The filament heating will be 
adjusted automatically at the 
current accelerating voltage. 

 
 

1. Select Full Auto or Semi Auto. 

2. Click the Auto Filament＋Alignment, Auto Alignment, or Auto Filament button. 

 

 
 

3. When the auto gun alignment function is completed, the accelerating voltage is restored to an original value. 
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4.23.1.b Manual Gun Alignment 

 
When you want to change the spotsize to observe the image, perform the manual operation. Probably, manual 
operation will be required in following cases. 

• The Spotsize (SS) is increased for X-ray analyzing 
• The Spotsize (SS) is increased for observing the image in LV mode. 
• The Spotsize (SS) is decreased for obtaining the sharp image. 

 
 

1. Mount one of the samples below, and evacuate the specimen chamber. 

• The conductive sample which the damage by the electron beam is ignored. 
• Specimen holder 
• Specimen stab 

2. Click Maintenance in the operation menu tab. 

3. Click the Filament Adjustment button. 

4. Set the desired accelerating voltage, and click HT icon  to get HT ON . 

5. Set the filament slide bar to the front of the orange colored area. 

6. Set the Spotsize (SS) to 30, and adjust the alignment adjustment－Tilt / Shift X and Y slide bars so that the 
image becomes as bright as possible. 

7. Move the filament slide bar to the left edge once. 

8. When you slowly drag the slide bar to the right, the image becomes bright a moment in the vicinity of the slide 
bar center.（The first peak） 

9. Further drag the slide bar to the right to display an image, and the load current (L.C) gets stabilized. And the 
image brightness will not change any more from a certain position onward.  (The second peak: saturation 
point) 

10. Set the filament slide bar to just the left of the saturation point. 

 
 

CAUTION！  

If you set the slide bar to the right of the saturation point (into orange-colored area), an over-current will occur, 
causing the life of the filament to be reduced. 
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11. Adjust the L.C（Load Current）value. 

Adjust the L.C value depending on the accelerating voltage. 
 

Acc.V （kV） L.C（μA） 

30, 25, 20, 15 Approx. 85 
10 Approx. 90 
5 Approx. 140 
3.0 Approx. 120 
2.5 Approx. 110 
2.0 Approx. 100 
1.5 Approx. 80 
1.0 Approx. 70 

 

 
Bias Adjustment 

 
 

12. Find the target object on the image, and set the magnification to ×10,000. Then adjust the image focus. 

13. Click the Wobble icon , or select the menu bar Tools ⇒ OL Wobbler. 

14. Adjust the X and Y knobs of the movable aperture so that the image movement becomes minimum (does not 
move up and down, left and right). 

 
 
 
 

 When you want to change greatly the Spotsize (SS), continue to perform the adjustment after the Step 15. 
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15. Increase the Spotsize (SS) slowly from 30 and set it to90. 

While you Increase the spot size SS (for example,…near SS60), if the image disappears, adjust the slide bars of 

Alignment adjust − Shift X and Y so that the image becomes bright at any time. Also, use the Contrast  

and Brightness  buttons to adjust the image, if required. 

 
16. At the Spotsize (SS) 90, adjust slide bars of Alignment adjust-Shift X and Y so that the image becomes bright. 

17. Return the spot size SS to 30, and adjust the slide bars of Alignment adjust − Tilt X and Y so that the image 
becomes bright again. 

18. Click the Wobbler icon , and adjust the X and Y knobs of the movable aperture so that the image 

movement becomes minimum (does not move up and down, left and right). 

19. Repeat steps from 15 to 18. 
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4.23.2 OL Aperture Adjustment 

 
If the movable aperture diaphragm is shifted from the optical axis, even if the focus is adjusted, a sharp image may not 
be obtained, or an image may be limited by the field of view. In order to prevent this, check the movable aperture after 
having performed the following works, and adjust the movable aperture if needed. 

 
• When the OL aperture was changed over, or the aperture foil was replaced. 
• When you changed the accelerating voltage largely.  
• When you changed WD largely. 
• When you changed the spot size largely. 

 
 

1. Set the magnification to about ×10,000 and adjust the focus of an image. 

2. Click the Maintenance in the Operation menu tab. 

3. Click the OL aperture Adjustment button.  

 

 

 
 

4. Click the Wobbler ON button. 

5. At this time, if an image does not wobble vertically and horizontally, omit next step. If the image wobbles vertically and 
horizontally, proceed to step 6. 

6. Adjust the image using the X, Y direction fine-adjustment knobs for the movable aperture, so that the wobbling of the 
image becomes minimum. 

 
 

7. Click the Wobbler OFF button. 

8. Repeat steps 4 to 7. 

 

Y direction fine adjustment knob 

X direction fine adjustment knob 
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  You can look at an animation of the OL aperture adjustment work. 

When you click  the Play button shown below, an animation according to each explanation is played. 

 
 
 
 

 
 
 
 
 

Play／Pause／Stop button 

Play button 
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4.23.3 Astigmatism Correction Adjustment 

 
Astigmatism is not noticeable at low magnification (about ×1,000), however if you increase the magnification to 
a high value, the image appears to get sharp in a certain direction before and after the focal point, making it 
difficult to perform accurate focusing (image with astigmatism).  If there is no astigmatism, blurring occurs 
uniformly in all directions before and after the focal point due to, hence the image can be accurately focused 
(image without astigmatism).  Astigmatism can also occur after the work below was carried out, so correct it if 
necessary. 

 
 

• If the OL aperture was changed over, or the aperture foil was replaced. 
• If the accelerating voltage was greatly changed. 
• If the WD was greatly changed. 
• If a magnetic sample is being observed 
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Image before astigmatism correction 

 

     

 
Image after astigmatism correction 

 
 

1. Set the magnification to a value slightly higher than the magnification used for the current observation. 

2. Adjust the focus of an image using the Focus  button 

3. If the image appears (Ref.; Image after astigmatism correction) before and after the focal point (blurring occurs), 
there is no astigmatism, so omit the following steps. 

4. Adjust the StigmX and SatigmY buttons  so that the image becomes most sharp. 

5. Click LENS Reset icon , or select the menu bar Tools ⇒ Lens Reset, 

6. Repeat steps 2 to 5. 
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4.23.4 Stage calibration（if the motorized stage is installed） 

 
It depends on the frequency of the instrument use, however it is recommended to perform the initialization of the stage 
once a week. In addition, please perform it when malfunction occurred by stage movement. 

 
 

CAUTION！ 

Before you initialize the stage, remove the specimen holder.   
 
 
 

1. Click the Maintenance in the Operation menu tub. 

2. Click  the Initialize Stage button 

3. Set the specimen tilt angle (T axis) to 0 degree. 

4. Click the Vent the chamber button, and remove the specimen holder. 

 

 
 

5. Select an axis to initialize and click the Start button. 

The specified axis starts moving, and an initialization completes when it stops moving. When you want to stop the 
initialization of the stage coordinates, click the Stop button. 

6. Set the specimen holder and click the Evacuate the chamber button to evacuate the specimen chamber. 

7. Select the Z Move Limit. 

Normal mode 
Z axis can not be moved to less than 8 mm to prevent collision. Please use at the normal observation mode. 
 
High Resolution mode 
Z axis is movable up to 5 mm. Please use when you observe an image at high magnification. Make sure that the 
specimen does not hit the various detectors when the top of the specimen protrudes from its holder. 
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4.24  X-ray analysis by EDS 
 

Refer to the EDS instruction manual for the operation of EDS unit 
 
 
 

Five kinds of analyses is possible with this instrument. 
 

Item Purpose of use 

Mapping Perform all the elements mapping in the whole area of the image display area. 

Spot analysis Perform the spectrum acquisition of the spot position set up on the image. 
Line analysis Perform the spectrum acquisition in line set up on the image. 

Area analysis Perform the spectrum acquisition of the area (rectangle area) inside set up on the image. 

Sequential analysis Perform sequentially the spectrum acquisition of the points reserved with Spot analysis or 
Area analysis. 

 
 
 

CAUTION！ 

In the below cases, spectrum data cannot be acquired, analysis position (spot, line and area) cannot be 
set, and sequential analysis cannot be reserved. 

• Scan1 
• The large／small image indication 
• The image file 
• Menu bar Image is being operated 

 
The spectrum acquisition is not started if the WD (height of sample surface) is not setup to 10mm.  
Make sure to set the WD to 10mm. 
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4.24.1 Mapping 

 
Perform all the elements mapping in the whole area of the image display area. 
In the motorized stage is not attached to the instrument; Acquire the image by using the Menu bar Analysis ⇒ 

Send Image to Analysis Station or  icon when you wish to analyze the new field of view.  

 (Recommended) 
 
 
 

1. Displays a live image or freeze image. (640×480 pixels) 

2. Select the menu bar Analysis ⇒ Acquire X-ray Mapping, or click the X-Map icon . 

3. Start the spectrum acquisition as soon as the freeze image is transferred to the Analysis Station. 

4. To stop it, click the monitoring dialog Cancel button. 

To start it again, select the menu bar Analysis ⇒ Acquire X-ray Mapping, or click the X-Map icon 

. 

5. When the spectrum acquisition is completed, the image returns to the previous one before the acquisition 
starts. 

The acquired spectrum data is saved together with the image and position data into the field if the field of 
Analysis Station is the same. If the field is different, the acquired spectrum data is saved together with the 
image and position data into the new field. 

If the motorized stage is not attached, the acquired spectrum data is saved together with the image and position data  
into the current field  
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4.24.2 Spot／Line Analysis 

 
Perform the spectrum acquisition of the spot／line position where it was set up on the image. 
If the motorized stage is not installed and you wish to analyze the new field, acquire the image by using the Menu bar 

Analysis ⇒ Send Image to Analysis Station or icon .  (Recommended) 

 
 

1. Displays a live image or freeze image. (640×480 pixels) 

If the precise position is required for the analysis, it is recommended to display the freeze image.  

2. Set the analysis spot／line. 

Set the mouse cursor on the point where you want to analyze on the image, and click  the right mouse 

button.  Click the pop-up menu Spot Analysis／Line Analysis.  
⇒ The yellow cross marker (For line analysis；horizontal marker) is displayed. 

 
3. The spectrum acquisition starts as soon as the freeze image is transferred to the Analysis Station. 

To stop it, click the monitoring dialog Cancel button. 
To start it again, click the pop-up menu Spot Analysis／Line Analysis. 

 
4. Change the analysis position as necessary.（only spot analysis） 

Perform Step 2 operation again during the spectrum acquisition. In this case, the previously acquired spectrum data 
and position information are not saved. 

 
5. When the spectrum acquisition is completed, it returns to the previous state before acquisition. 

The acquired spectrum data is saved together with the image and position data into the same field if Analysis 
Station filed is the same.  If different field, the acquired spectrum data is saved together with the image and 
position data into the new field. 

If the motorized stage is not installed, the acquired spectrum data is saved together with the image and position data 
into the current field. ⇒ The cross-marker／Horizontal marker changes to the light blue. 

 
6. Erases the cross-marker／Horizontal marker. 

Click the menu bar Analysis ⇒ Clear History. 
Other method； 

• Change the magnification 
• Move the stage position 
• Perform the movement of the field of view by Image Shift. 
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4.24.3 Area Analysis 

 
Perform the spectrum acquisition of the area (inside rectangle area) on the image. 
If the motorized stage is not installed and you wish to analyze the new field of view, acquire an image by using the Menu 

bar Analysis ⇒ Send Image to Analysis Station or icon. (Recommended) 

 
 

1. Displays a live image or freeze image. (640×480 pixels) 

If the precise position is required for the analysis, it is recommended to display the freeze image. 

2. Setup the analysis area. 

Set the mouse cursor on the point which you want to analyze on the image, and draw the rectangle area with dragging 
the right mouse button. ⇒ The green rectangle area is displayed. 

  
Drawing the rectangle area 

 

3. Click the right mouse button , and click the pop-up menu Area Analysis.  

⇒ The color of rectangle area changes to the yellow. 

4. The spectrum acquisition starts as soon as the freeze image is transferred to the Analysis Station. 
To stop it, click the monitoring dialog Cancel button. To start it again, click the pop-up menu Area 

Analysis. 

5. When the spectrum acquisition is completed, the previous image is displayed. 

The acquired spectrum data is saved together with the image and position data into the same field if Analysis Station 
filed is the same. If it is the different field, the acquired spectrum data is saved together with the image and position 
data into the new field. 
The acquired spectrum data is saved together with the image and position data into the current field if the motorized 
stage is not installed. ⇒ The color of rectangle area changes to the light blue. 

6. Erases the rectangle area. 
Click the menu bar Analysis ⇒ Clear History. 

Other method； 
• Change the magnification 
• Move the stage position 
• Perform the movement of the field of view by Image Shift. 
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4.24.4 Sequential analysis 

 
 

This program performs sequentially the spectrum acquisition of the points reserved with Spot analysis or Area 

analysis. 
If the motorized stage is not installed and you wish to analyze the new field of view, acquire the image by using the Menu 

bar Analysis ⇒ Send Image to Analysis Station or icon. (Recommended)   

 
1. Displays a live image or freeze image. (640×480 pixels) 

If the precise position is required for the analysis, It is recommended to display the freeze image. 

2. Reserves a spot or an area. 

Acquires the freeze image to the Analysis Station as soon as the first analysis point (spot or area) is reserved. 
 
Reserve a Spot 
Set the mouse cursor on the point where you want to analyze on the image, and click the right mouse button.  Click 
the pop-up menu Reserves a Spot. 
⇒ The red cross-marker (marker) is displayed, and the reservation of the position is finished. 
 
Reserve an Area 
Set the mouse cursor on the point where you want to analyze on the image, and draw the rectangle area (marker) by 
dragging the right mouse button (⇒ the green marker (marker) is displayed).  
Click the right mouse button, and click the pop-up menu Reserves an Area. (⇒ The color of the marker changes to 
red, and the reservation is completed) 
 

3. Select the menu bar Analysis ⇒ Sequential Analysis, or click the Series icon . 

The sequential analysis dialog appears. Refer to the instruction manual for EDS. 
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4. Click the Start button in the sequential analysis dialog. 

5. Starts the spectrum acquisition in the opposite order of reservation. 

To stop it, click the monitoring dialog Cancel button. 
The color of marker changes to right blue when the spectrum acquisition is finished or interrupted.   (The red marker 
is displayed until the spectrum acquisition is started.) 
To start it again, click the Start button in the sequential analysis dialog. 

6. When the spectrum acquisition is completed, the previous image before acquisition started is displayed. 

The acquired spectrum data is saved together with the image and position data into the same field if Analysis 
Station filed is the same. If it is the different field, the acquired spectrum data is saved together with the image 
and position data into the new field. 

The acquired spectrum data is saved together with the image and position data into the current field, if the 
motor drive stage is not attached. 

⇒The marker changes to light-blue. 
 

7. Erases the marker. 

Click the menu bar Analysis ⇒ Clear History. 
Other method； 

• Change the magnification 
• Move the stage position 
• Perform the movement of the field of view by Image Shift. 
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4.25  Trouble Shooting 

4.25.1 Evacuation System 

 
Symptoms Cause Countermeasures 

The power board switch is OFF Turn ON the power board switch 

100V AC is not being supplied Verify the 100V AC 

The safety device operated because of a water 
failure 
 

Close the message (COOLING WATER 
FAILURE), and turn off the main power. 
（Exit SEM program ⇒ turn OFF the 
computer ⇒ turn OFF the MAIN POWER 
keyswitch） 
Flow the cooling water for five minutes. 
Restart the instrument. （Refer to 4.1） 

The safety device operated because of a power  
failure 

Turn OFF the MAIN POWER keyswitch and wait 
until power is restored. 
Make sure that the water is being fed, and restart 
the instrument. （Refer to 4.1） 

Power is not supplied 

The Water Leak Sensor (WLS) operated 
because of a water leak  
(When an optional WLS is installed) 

Close the message (COOLING WATER 
LEAKAGE DETECTED). 
Turn off the main power and turn off the main cock 
of the cooling water.  
Then, contact your JEOL service office. 

The RP thermal protector operated because of 
the over-current 

Turn OFF the MAIN POWER keyswitch. 
Make sure that the room temperature is between 
15 and 25℃, and the water is being fed. 
Push the RP manual reset button to start the 
instrument. 

The RP (oil rotary pump) does not start 
when the instrument is started 
The VENT and EVAC switch lamp blink 

The RP fuse blown out because of the 
over-current  

Shut down the instrument, and contact your JEOL 
service office. 

When the RP has stopped while the 
instrument is running 
The VENT and EVAC switch lamp blink 
No-image is displayed 
Warning message is displayed 

The RP fuse blown out or the thermal protector 
operated because of the over-current 

Shut down the instrument, and contact your JEOL 
service office. 

 
 

WARNING！  

Do not touch the RP motor when the RP has stopped while instrument is running. 

You may get burn in the hand because the RP motor is very hot. 
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Symｐtoms Cause Countermeasures 

Loose parts Tighten up loose parts 

A sample containing a lot of gas or moisture is 
installed 

Remove moisture from a sample, or replace it 
（Refer to 4.3） 

Inferiority of O-ring or packing  

(Twist, wrong position, contaminated with dust, 
being torn) 

Check the twist and wrong positions.  Check 
whether a O-ring and packing are contaminated 
with dust. 

Adjust a twist.  

Return it in the right position.  

Remove dust. 

When the O-ring or packing is torn, call serivice 
center 
（Refer to Chapter 5） 

The wehnelt has just been cleaned Wait for a while 

Evacuation does not take place, or 
takes a long time to complete 

RP (rotary pump) or DP (diffusion pump) oil has 
deteriorated 

Shut down the instrument, and contact your JEOL 
service office. 
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4.25.2 Image observation 

 
Symｐtoms Cause Countermeasures 

The electron gun misaligned Re-align the electron gun （Refer to 4.23.1） 

The filament has a whisker Replace the filament （Refer to 5.4） 
The filament is mis-centered Re-center the filament （Refer to 5.4） 
The wehnelt is contaminated Clean the wehnelt （Refer to 5.4） 

L.C value (load current) is unstable 

The wehnelt has just been cleaned Wait for a while 

L.C value is abnormal, or too small/too 
large  

Bias adjustment is not perform Perform bias adjustment （Refer to 4.23.1） 

The HT icon is OFF or Wait  Click the HT icon to get ON 

An auto function does not operate Turn HT ON, make sure whether the filament is 
heated. And, try again automatic functions (ACB, AF, 
etc.). （Refer to 4.5） 

The signal is not SEI Set the signal to SEI （Refer to 4.6） 
The image has excess or insufficient contrast 
and/or brightness 

Adjust it with image adjustment tool Contrast and 
Brightness buttons （Refer to 4.6） 

The electron gun misaligned Re-align the electron gun （Refer to 4.23.1） 
The filament heating insufficient Align the electron gun, or adjust bias （Refer to 

4.23.1） 
The movable aperture misaligned Align the movable aperture （Refer to 4.23.2） 

An image does not appear 

The filament is burnt out Replace the filament （Refer to 5.4） 
An image does not appear in LV mode  Set the appropriate sample (specimen holder), and 

evacuate in HV mode. 
Set the Z-axis (WD) to 10mm. 
Click the HT icon to get ON. 
Select Semi Auto, and click the Auto Filament

＋Auto Alignment button. 
(Maintenance; Adjusting a filament) 
Click HT icon to get OFF. 
Try again with LV mode. 
（Refer to 4.11） 
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Symｐtoms Cause Countermeasures 

The image has astigmatism Correct it with Stigm X and Stigm Y buttons. 
（Refer to 4.23.3） 

The image has insufficient contrast and/or 
brightness 

Adjust it with Contrast and Brightness 
buttons. （Refer to 4.7.5） 

The spotsize is too large Reduce the spotsize （Refer to 4.7.3） 
The electron gun misaligned Re-align the electron gun（Refer to 4.23.1） 
The accelerating voltage is too low Increase the accelerating voltage （Refer to 4.7.2） 
The movable-aperture foil has deteriorated Replace the movable aperture foil （Refer to 5.6） 

An image has no sharpness 

The inside of electron optical column is 
contaminated 

Call service center 

The image does not focus in the 
vertical direction 

The sample is set to high tilt angle Eliminate the tilt of sample （Refer to 4.8） 
Correct with "Dynamic Focusing correction" （Refer 
to 4.13） 

The sample has acquired electric charge Re-evaporate a sample 
Decrease the accelerating voltage （Refer to 4.7.2） 
Decrese the spotsize （Refer to 4.7.3） 
Fine-adjust the pressure in the specimen chamber
（Refer to 4.11） 

The spotsize is too small Increase the spotsize （Refer to 4.7.3） 
The accelerating voltage is unsuitable Change the accelerating voltage （Refer to 4.7.2） 
The image has astigmatism Adjust it with Stigm X and Stigm Y buttons 

（Refer to 4.23.3） 
The image has excess or insufficient contrast 
and/or brightness 

Adjust it with Contrast and Brightness 
buttons （Refer to 4.7.5） 

The sample is not properly fixed Properly fix the sample 

Loose parts Tighten up loose parts 

External magnetic field Keep it away from the instrument 
The movable aperture foil has deteriorated Replace the movable aperture foil （Refer to 5.6） 

There are noise, roughness, and  

distortion on the image 

The inside of electron optical column is 
contaminated 

Contact your JEOL office 

The image appears with poor 
brightness compared with the 
previous time 
The image brightness changes in a 
cycle 

The scintillator tip has deteriorated Contact your JEOL office 
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Symtoms Cause Countermeasures 

An image be veiled in haze of white Halation is caused Select menu bar Tools ⇒ Neutralizer. 
※ It is effective only SEI 

A main screen becomes full-screen live 
display 

Cancel the full-screen live display A live image can be recorded 

A image size becomes without 640×480 
pixels 

Select scan mode to Scan3 or Scan4 (scan 
speed；10s) 
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4.25.3 What should be done in these cases？ 

4.25.3.a When the coordinates display of the motor drive stage differs from 

the actual position 

 

If the following phenomena occur while using this instrument, execute the stage initialization. 

• When the actual position of the specimen stage differs from the coordinate display of the stage control 
window and the graphic display position 

• Because of the shift of the specimen exchange position, you cannot change the specimen.  

 
 
 

1. Click the Maintenance of the operation menu bar. 

2. Click  the Initialize Stage button. 

3. Set the specimen tilt angle (T axis) to 0 degree. 

4. Click the Venting the chamber button, and remove the specimen holder. 

 

 
 

5. Select an axis you want to initialize, and click the Start button. 

Moving of the specified axis starts, and when it stops, initialization is completed. When you want to stop the 
initialization of the stage coordinate, click the Stop button. 

6. Mount the specimen holder on the specimen stage, and click the Evacuating the chamber button. 
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7. Set the Z axis Moving Limit. 

 
a. Click the Stage of the operation menu tab. 
b. Click the Z Move Limit button. 
c. Select Normal Mode or High Resolution Mode.  
d. Click the OK button.  

 
 
 

 
 
 
 

Normal mode  Z axis can not be moved to less than 8 mm to prevent collision. 
Please use at the normal observation mode. 

High Resolution mode  Z axis is movable up to the 5mm. Please use this when you observe an image at high 
magnification. Make sure that the specimen does not hit the various detectors when the top of 
the specimen protrudes from its holder. 

 
Z Axis Moving Limit  
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4.25.3.b When a message appears using an optional ALS 

 
When one of the following operations is made, a message appears. Proceed to do the steps according to the 
message. In addition, be sure to shut down the instrument before you contact the service office. 

 
 

• When you set the airlock valve to OPEN while evacuating the main unit. 
• When you set the airlock valve to OPEN while evacuating the airlock chamber. 
• When the pressure does not decrease to 30 Pa (low vacuum mode: 100 Pa) or less even if 3 

minutes or more has passed after starting the evacuation of the airlock chamber. 
• When you open the airlock chamber door while evacuating the airlock chamber. 
• When the malfunction of the airlock system occurs. 
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4.26  Running message list 
 

The running message is displayed on the top of the main screen. 
 
 

Operation Running message Remarks 

Click the  
Photographing  

 

Click the  
Freeze  

Auto Focus running  

Click the  Auto Focus＋ACB running  Setting ⇒ Auto and Preset Mag. 

Tick the ACB check box. 

Auto Stigma running  

Auto Stigma＋Auto Focus running Setting ⇒ Auto and Preset Mag. 

Tick the AF check box Click the  

Auto Stigma＋ACB running  Setting ⇒ Auto and Preset Mag. 

Tick the ACB check box 

Click the  
ACB running   

Click the  
Auto Gun Alignment running Maintenance ⇒ Filament Adjustment ⇒ Auto 

Filament＋Auto Alignment 

Click the  
Auto Filament Saturation running Maintenance ⇒ Filament Adjustment  ⇒ Auto 

Filament 

Click the  
Auto Gun Alignment running Maintenance ⇒ Filament Adjustment  ⇒ Auto 

Alignment 

Click the  
Beam Blank ON  

Select the Tools ⇒ OL Wobbler, or click 

the  

OL Wobbler ON  
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4.27  Warning Message list 
 

If the trouble occurs as follows, an error messages appears and beeps buzzer (Continuity／three times) sound. 
Please proceed according to the message. 

 
 
 

Contents of message Countermeasures 
COOLING WATER FAILURE 
Water stops 

Turn off the main power and supply cooling water for more 5 minutes before restarting the 
microscope（Refer to 4.1） 

DP TEMPERATURE LOW 
DP temperature is low 

Wait for a while 
When the DP temperature does not rise even if it waits for about 15 minutes, DP HEATER 
FAULT message appears. Shut down the instrument, then call service center 

COOLING WATER LEAKAGE DETECTED 
Water leaks 
An optional water leak system (WLS) is being used 

Shut down the instrument and turn off the cooling water, then contact your local JEOL service 
office. 

DP HEATER FAULE 
DP heater being burnt out 

Shut down the instrument and contact your local JEOL service office. 

EVACUATION FAILURE 
Vacuum error occur 

Vent the specimen chamber to atmospheric pressure, and check the O-ring and/or packing 
(twist, wrong position, etc)  
Remove twist, correct position and re-evacuate the specimen chamber 
When the O-ring or packing is torn, call service center 

RP STOPPED 
RP stopped 

Shut down the instrument and contact your local JEOL service office. 

FILAMENT BURN-OUT 
The filament electric current (L.C value) not flowed 
even if the filament heating becomes 80H or more 

Replace the filament (Refer to 5.4) 

HT is OFF or FILAMENT is not heated 
When the automatic function is operated with HT off 
or the filament heating scroll bar is set to 80H or 
less. 

Set HT to ON or adjust filament saturation 
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Contents of message Countermeasures 
FILAMENT FAILURE 
(When L.C value flowed more than 150μA) 

Check the filament 
Remove the filament from the wehnelt in the gun chamber. Check whether "Whisker" on the 
filament does not occur. 

 

Whisker 

If the whisker occurs, replace the filament because the instability of gun emission is caused. 
(Refer to 5.4) 

Insufficient filament heating Please adjust the filament heating properly or click the Auto Filament button 
VACUUM SYSTEM FAILURE 
Vacuum system stops 

Shut down the instrument and contact your local JEOL service office. 

VENT DISABLED 
Prohibition of vacuum control in the "VENT Lock 
signal" input 
An optional vacuum status interface （VSIF）is 
being used 

Please start after resetting the VENT-Lock signal. 
 

VALVE CONTROL FAILURE 
Valve control error occurs in the LV mode 

Please readjust the pressure mechanism. 

EXTERNAL CONTROL DISABLED 
When the connection was cut during the external 
control 
An optional external scan interface （ESIF）is being 
used 

Check connections or input an external control signal 

Stage contact with lens detected 
An optional motor drive stage is being used 

Wait for a while till the stage is moving to a safe position. 
Vent the specimen chamber, check the damage of the sample, OL and BEIW. 
There is damage…Contact your local JEOL service office. 
There is no damage…Ensure to see the movement of the sample, and try again. 

 When the specimen surface is protruding above the specimen holder, input the amount of 
correction. 
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Maintenance 
 

 
Refer to the EDS instruction manual for the maintenance of the EDS detector. 
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5.1 Parts the must be maintained 
 

A JEOL engineer performs the maintenance work of DP oil, RP oil in the table. Please, contact JEOL service 
office. 

 
 

Parts Cleaning interval 

Filament・Wehnelt L.C value (load current) is unstable 
L.C value not rise with filament heating 
Error message appears 
 

Anode・liner tube Once every 1 to 2 years 
Cleaning is it toward the aperture (cap shaped) in the tip of the liner tube.  Stop 
cleaning if trash and dirt don't seem to be conspicuous except for the liner tube. 
 

Movable aperture (MAP) When the astigmatism increases, preventing a bright image from being obtained 
 

Orifice  (6510LV, 6510LA) 
Sleeve  (6510, 6510A) 

When the astigmatism increases, preventing a bright image from being obtained 
 

O-ring・packing When evacuation cannot take place or requires a long period. 
 

DP oil Once every 3 to 5 years（Recommended） 
 

RP oil Once every 1 year（Recommended） 
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5.2 Cleaning materials 
 
 

Cleaning materials Purpose of use, and Note 

＊Cleaning liquid Use cleaning liquid that has high cleaning performance, is of high purity, nearly harmless 
to humans, non flammable, and volatile.  Follow the precautions indicated on the 
container of the cleaning liquid.  Ensure that the room is adequately ventilated, and do 
not place your fingers in the liquid.  (be sure to ware working gloves)  Use cleaning 
liquid to remove common dust and abrasive.  Normally, cleaning liquid is used by 
moistening a piece of gauze or a cotton stick with it.  Small parts that have been 
cleaned can be effectively finished off by immersing them in a beaker filled with cleaning 
liquid.  (you can obtain even better results by using ultrasound cleaner) 

Work gloves Use polyethylene film gloves.  This prevents parts from becoming soiled, and also 
protects the skin on your hands and fingers. 

Gauze Use gauze that is clean and does not generate impurities when immersed in cleaning 
liquid.  Use gauze for rubbing parts with an abrasive and also for wiping away dust and 
stains using cleaning liquid. 

Cotton stick Use cotton sticks that are clean and do not generate impurities when immersed in 
cleaning liquid.  Use cotton sticks for rubbing parts with an abrasive and also for wiping 
away dust and stains using cleaning liquid.  (fine parts, holes, etc.) 

Cotton wool, toothpick Use clean cotton wool after wrapping it around a toothpick.  Use it for rubbing parts with 
an abrasive, and also for wiping away dust and stains using cleaning liquid.  (fine parts, 
holes, etc.) 

＊ Metal abrasive Use a paste type abrasive that can be easily removed by cleaning liquid.  Use it when 
dust and stains cannot be removed with cleaning liquid.  Never use an abrasive on 
threaded parts or intricate parts.  Also, take care that abrasive does not get onto parts 
that are not normally cleaned. 

Beaker Use a stainless steel beaker.  Do not use a glass beaker because it is liable to break. 
Pour cleaning liquid into the beaker and use it for finishing off fine parts that have been 
cleaned. 

Hand blower You can also use a safe, clean container that enables inert grass to be blown out. 

Tools Use the tool included among the accessories or commercially available tools. Replace 
screwdrivers and other tools that are visibly damaged. 

 
 

＊ When a cleaning liquid and metal abrasive are need, please, contact your JEOL service office. 
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！Percaution in maintenance work 

 
• Do not adopt an unreasonable posture when working for maintenance. 

An unreasonable posture becomes the cause which a waist and so on hurts. 

• Do not use an organic liquid when wiping off the dust of exterior of the instrument. 
Wipe off it with dried cloth after removing the dust.  If it is very dirty, wipe it with wet cloth and 
then dry cloth. 

• Do not dismount, disassemble with bare hands. Be sure to use polyethylene film gloves or the like.  
The internal parts are precision-machined.  Use special care so as to prevent them from 
contamination. 

• Use tools in the proper way, and avoid using undue force to tighten screws. 

• When you handle tools, use special care not to drop them on the parts and damage them. 

• When parts is to be secured with two or more screws, screw all of them lightly in until they are 
blocked and them tighten one after another a little at a time. 

• Carefully remove and remount parts without exerting undue force. 
Forcing parts in or out could cause eccentricity which might make it impossible to remove and 
remount the parts. 

• Store removed and disassembled parts is readily identifiable groups. 
Put small parts such as screws in laboratory dishes.  For long-term storage, use a desiccator to 
prevent oxidation. 

• Place disassembled parts on a rugged workbench covered with aluminum foil. 

• For heavy parts, place additional material under the mat and make sure that no screws, etc. are 
left behind. 

• Place a cover or an exposed portion that does not require disassembly.  Cover such a portion 
with an aluminum foil to keep out dust. 
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5.3 Cleaning method 
 

！WARNING 

When handling cleaning liquid, be sure to use polyethylene film gloves. 
There is a risk of acquiring a skin disorder depending upon the particular kind of cleaning liquid used of 
the sensitivity of your skin, so be sure to read the precautions concerning liquid before using it. 

 
 
 
 

Cleaning A―Wiping off dust and stains with cleaning liquid 

Please apply Cleaning A in the part that are not very dusty satiny, or parts that cannot be rubbed 

• Wipe flat surfaces and outside surface of parts, and also threaded parts, with a piece of gauze, or the like, 
moistened with cleaning liquid.  Wipe dust and stains off the vicinity of holes and the inside surfaces of 
parts using a cotton stick (of a size that matches the area to be cleaned), or the like, moistened with 
cleaning liquid.  Never clean parts made of plastic or other material that is likely to be dissolved by the 
cleaning liquid. 

• Clean oil and grease off small parts and also clean intricate parts by pouring the cleaning liquid into a 
beaker then immersing the parts.  You can obtain even better results by using an ultrasound cleaner.  
Replace the cleaning liquid from time to time according to the extent to which it becomes contaminated.  
After cleaning the parts, remove them from the beaker and quickly remove any cleaning liquid adhering to 
them by using blower brush. 

 
 

Cleaning B－Rubbing with metal abrasive 

Please apply Cleaning B in the part that are very dusty and also parts that can be rubbed. 

• Coat flat surfaces and outside surface of parts with a small quantity of abrasive using gauze, or the like.  
Rub the vicinity of holes and the inside surfaces of parts using a cotton stick (of a size that matches the 
area to be cleaned) or the like, coated with a small amount of metal abrasive.  Do not use a lot of force 
when rubbing a parts in the vicinity of a hole.  Also, do not rub parts excessively.  Never rub threaded 
parts with metal abrasive.   

• If you have done Cleaning B, repeat Cleaning A couple of times to completely wipe all metal abrasive 
off. 

 
 



5. Maintenance 

___________________________________________________________________  5-5

5.4 Filament replacement and cleaning 
 

！WARNING 

Do not touch the wehnelt immediately after the filament breaks because it is 

not you may receive a burn. 

Before removing the wehnelt for about one hour, then remove it using a dedicated tool. 
 

 

！CAUTION 

• Do not open the electron gun except the maintenance work (filament replacement, etc.) 
It has possibility that dust and so on goes into the electron optical column when the electron gun is 
opened unreasonably and that a trouble is caused. 

• When installing the filament, take care not to touch the tip of the filament. 
• When closing the electron gun, take care not to slip the O-ring out of position. 
• When closing the electron gun, take care not to get your fingers crushed between the electron gun 

and electron optical column. 
 
 
 
 

You can look at an animation of the filament exchange work. 

When you click  the Play button, an animation according to each operation procedure is replayed. 

 
 
 

 
 
 

Play／Pause／Stop button

Play button 
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1. Click OK button to close the message dialog. 

2. Click the Maintenance in the Operation menu tab. 

3. Click  the Filament Exchange button. 

4. Click the Vent the electron gun button for venting the electron gun chamber to atmospheric pressure. 

 

！CAUTION 

Before removing the wehnelt, wait approximately one hour to get it cool. 
 
 

 

 
 

5. Lift the column top cover, and remove it 
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6. Open the electron gun, and remove the wehnelt. 

 
 

 
 
 

7. Set the wehnelt removal tool in such a way that the three screws of the wehnelt removal tool will align with the 
smooth faces on the sides of the wehnelt and tighten the screws 

 
 

 
 
 

8. Pull the wehnelt removal tool straight to remove the wehnelt from the electron gun and then loosen the screws 
to remove the wehnelt removal tool. 

Closes the electron gun after removing the wehnelt. At this time, take care not to slip the O-ring out of position. 

 

Wehnelt 

Wehnelt removal tool 

Electron gun 
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9. Disassemble the wehnelt, and remove the filament. 

Grasp the electrode of the filament when removing the filament. 
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Tip of the filament condition 

 
Tip of the filament 

condition 

State 

 

Un-use 

 

Ordinary broken 

When the filament is used well at a long time. 

 

Abnormal broken 

When the over load current is flowed to the filament. 

 

Whisker 

Since the load current becomes to instability, it is 
necessary to change the filament with a new one. 

 
 

10. Clean the cap, and other parts (by referring the 5.3 section), then install a new filament 

Re-install the filament in the opposite sequence to removal. 

11. Check the filament position (centering). 

Show the wehnelt from the side, if the tip of the filament is protruding, replace the spacer. 
 

Relation between the spacer and filament 

 
Number of scribed 

lines 
Thickness (mm) Brightness The life of filament

3 2.1 Medium Normal 

4 2.2 Low Long 
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12. Open the electron gun, Install the wehnelt. 

If there is dust and so on the wehnelt, remove it with hand blower. 
Align the guide groove on the wehnelt with the guide pin on the electron gun, then push in the wehnelt unit it 
clicks into position. 

 
 

 
 

Install the wehnelt 
 
 

13. Close the electron gun. 

 

 Please, check the O-ring condition before closing the electron gun.  

• If the O-ring is dusty, carry out cleaning A, then adequately dry the O-ring. Next, coat the O-ring 
with the minimum necessary amount of ＊vacuum grease. 

When the vacuum grease is need, please contact your JEOL service office. 

• If the O-ring is damaged or torn, you must replace it, so contact your local JEOL service office. 
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14. Click  the Evacuate the electron gun button for evacuating the EOS column. 

 
 
 

15. Install the column top cover. 

 

   
 

16. Click HT icon  to get HT ON . 

17. Perform the auto gun alignment.（Chapter 4 －4.22.1.a） 
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5.5 Cleaning the anode and liner tube 
 

！WARNING 

Do not touch the wehnelt immediately after the filament breaks because it is 

not you may receive a burn. 

Before removing the wehnelt for about one hour, then remove it using a dedicated tool. 

 

！CAUTION 

Turn OFF the MAIN POWER key switch after venting the electron optical column 

to atmospheric pressure.  

When closing the electron gun, take care not to slip the O-ring out of position, or get your fingers crushed 
between the electron gun and electron optical column. 
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1. Open the electron gun and remove the wehnelt. 

Stores the removed wehnelt in such a way that it is not exposed to dust. 

2. Turn OFF the MAIN POWER key switch, and remove the anode. 

Remove the setting screws. Screw the suitable screw into the screw hole for removing the anode, and pull it out 
vertically. 

 

 
 

 

3. Remove the liner tube 

Remove the setting screws (two). Screw the “liner tube extraction tool” and pull the tool vertically. 

 

    
Liner tube extraction tool 

 

As for important by operation step3, it is [pull the liner tube out slowly and vertically, and return it again].   

A “slow” reason is to prevent two O-ring being torn to keep the vacuum of the liner tube.  

 

Setting screws（four） 

Setting screws（two） 
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And, cleaning is it toward the aperture (cap-shaped) at the tip of the liner tube.   

Stop cleaning if you look through the liner tube and trash and dirt don't seem to be conspicuous. 

 

 

 
 

 

4. Clean the anode and liner tube by referring the 5.3 section. 

5. Re-assemble the anode and liner tube. 

Perform re-assembly work in the opposite sequence to that in which you disassembled or pulled out the anode 
and liner tube. 

6. Install the wehnelt, then evacuate the electron optical column. 

 

 

Aperture 

Turn it counter clockwise to remove the aperture. 

Liner tube 
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5.6 Cleaning the movable aperture 
 

！CAUTION 

• When removing or installing the movable aperture, take care that the tip of the movable aperture 
does not touch the electron optical column. 

• When pushing the aperture foil fixing plate, take care not to touch with bare hands. 

• When installing the aperture foil, take care not to deform or damage it. 

• It is necessary to change the aperture foil to a new one. When an new aperture foil is need, please, 
contact your JEOL service office. 

 
 
 
 
 

 You can look at an animation of the OL aperture foil exchange work.  

When you click  the Play button, an animation according to each operation procedure is replayed. 

 
 
 

 
 
 
 
 

Play／Pause／Stop button

Play button 
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1. Set the aperture scale to 0 using the aperture selection knob. 

 

 

 
2. Click the Maintenance in the operation menu tab.  

3. Click the OL aperture Exchange button. 

4. Click the Vent the EOS button for venting the EOS column to atmospheric pressure. 

 

 
 
 

5. Remove the movable aperture. 

Cover the mounting port of the movable aperture to prevent ingress of dust. 
 

 

 

Movable aperture setting screws（four） 

Aperture selection knob 
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6. Push the aperture foil fixing plate, and take out the aperture foil 

 

 

 

 
 

 

 

 

 
 

 

 

 

 

Tip of the movable aperture 

 

 

 

 

 

 

Notch 
Be sure set to top side 

Aperture foil fixing plate 

Setting screws (two) 
Fix the aperture foil fixing plate 

Aperture foil

Please, push here.
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7. Carry out the Cleaning A. 

When the tip of the MAP is very dusty, disassemble it and carry out Cleaning B.  Re-assemble the aperture 
in the opposite sequence to disassembly. 
About cleaning method of Cleaning A and Cleaning B, see Section 5-4. 

 
 
 
 

 
 
 
 

 
 
 
 
 

8. Push the aperture foil fixing plate, and install a new aperture foil. 

It is necessary to change the aperture foil to a new one. When an new aperture foil is need, please, contact 
your JEOL service office. 

9. Install the movable aperture, and click the Evacuate the EOS button. 

If there is dust and so on the tip of the aperture, remove it with hand blower. 
 
 
 

 Next, executes the Movable Aperture Adjustment（refer to Chapter 4_4.23.1.b） 
 
 
 
 

Holder 
Setting screws (two) 
Fix the holder 
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5.7 Cleaning the orifice and sleeve 
 

CAUTION！ 

• When moving the BE detector holder, take care not to touch the detection element. 
• When removing or installing the orifice (sleeve), take care not to touch any parts inside the 

specimen chamber. 
• When installing the aperture foil, take care not to deform or damage it. 
• It is necessary to change the aperture foil to a new one. When an new aperture foil is need, please, 

contact your JEOL service office. 
 
 
 
 
 

 You can look at an animation of the orifice exchange work.  

When you click  the Play button, an animation according to each operation procedure is replayed. 

 
 

 

 
 
 

 

Play／Pause／Stop button

Play button 
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1. Click the Maintenance in the operation menu tub. 

2. Click the Remove Orifice button of the Maintenance operation guidance.  

3. Click the Vent the specimen chamber button for venting the specimen chamber to atmospheric 
pressure. 

 

 
 
 

4. Slowly withdraw the specimen stage. 

When an optional backscattered electron detector (BEIC or BEIR) is attached, pull the backscattered electron 
detector until it stops to the front. 

 

 
 

Interior of the specimen chamber 

 
 

 

Backscattered electron detector―Detector holder 
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5. Slightly moves the detector holder. 

Slightly push down the detector holder, and Move the detector holder to the right-side not to touch the bottom 
of OL as much as possible 
When you move a detector holder, hold the part to show in a round mark of a figure, and move it.  
After finishing the movement of the detector holder, slowly release your hand. 

 
 

 
 
 

 
 

Whole of the detector holder 
 
 

！CAUTION 

The detector cover shown in a figure is made of the very thin material. Keep it mind that it will bend 
easily and will change if it touches by hand. 

 
 
 

Detector cover 

BE detector holder 



5.  Maintenance 

____________________________________________________________________ 5-22

 
 

6. Remove the orifice or sleeve using the orifice removal tool 

Viewing the tool from the underside, turn it counterclockwise and remove the orifice or sleeve.  
After removing it, evacuate the specimen chamber.  

 

 
 
 

7. Disassemble the orifice, then clean (by referring the Section 5.3) these parts as shown in the figure. 

Reassemble the orifice or sleeve.  Perform re-assembly work in opposite sequence to that in which you 
disassembled. 

 

 
＊ It is necessary to change the aperture foil to a new one. When an new aperture foil is need, please, contact 
your JEOL service office. 

Aluminum foil 

Cap 

Spacer 

Aperture foil 

Aperture holder （6510LV,6510LA） 

Sleeve （6510,6510A） 

If the cap is too tight to turn, turn it after putting

aluminum foil on the cap and holding the cap

with this position of tweeze. 

Orifice removal tool 
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8. Vent the specimen chamber to atmospheric pressure, and install the orifice or sleeve. 

Click the Mount Orifice button in the Maintenance in the operation menu tub, and click the Vent the 

specimen chamber button 
 

Mount the orifice or sleeve on the removal tool. Viewing the tool from the underside, turn it clockwise and 
install the orifice or sleeve. 

 

 

 
9. Attach the detector holder again. 

 
CAUTION！ 

When attaching the BE detector holder again, take care not to touch the collector of 

the secondary electron detector. 

It will bend easily and deform because the collector is made of the very thin material. If the collector will deform, a 
image quality may be deteriorated. 

 
 

 

 
 
 

Collector BE detector holder 

Secondary electron detector
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In case you attach the detector holder again after cleaning the orifice., check that the guide of detector holder 
has gone into the hole of bottom of OL correctly. (If it attaches correctly, the horizontal gap of between the 
detector holder and bottom of the objective lens will not be generated. 
However, an about 0.3mm space is generated between the bottom of objective lens and detector holder even 
if it attaches correctly. 

 

 

 
 
 

 
 
 
 

10. Evacuate the specimen chamber. 

 

Guide of detector

About 0.3mm 

Bottom of OL 
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5.8 Accessories and tools 
 
 

Name Details Pcs. 

Wehnelt cap removal tool  1 
Standard specimen ZnO; zinc oxide 1 
Jeweler’s screwdriver Hexagon 1 
Electron gun filament  6 
Liner-tube removal tool  1 
Fuse 37202000411(0.2A UL) 、0.2A 2 
Fuse 313 005MXP(313 005)、5A 3 
Fuse 326 008MXP(326 008)、8A 1 
Fuse  326 010MXP(326 010)、10A 4 
Fuse 326 020MXP(326 020)、20A 1 
Socket  1 
Spacer 2.2mm 1 
Clockwise wrench Precision 1 
   
LV（low vacuum）related parts   
Specimen stub for LV φ10＊10 5 
Specimen stub for LV φ10＊5 5 
Specimen stub for LV φ32＊10 1 
Specimen stub for LV φ32＊5 1 
Orifice removal tool  1 
Screwdriver For Pirani 1 

 
 
 



 



JEOL service office 
 If you need to consult with JEOL about the instrument maintenance, please contact your nearest subsidiary 
company.   

Or presume a JEOL homepage in such cases as the information about the product, the inquiry besides that if 
having an order in the center of the nearby service. 

 

 http://www.jeol.co.jp/  Japan 
 http://www.jeol.com/  USA 
 http://www.jeoleuro.com/  Europe 

 

 

 




